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Welcome

 

Thank you for purchasing the Canon S450 Series Color Bubble Jet™ Printer.

This 

 

User’s Manual

 

 provides complete explanations of the features and functions of the 
printer. To maximize the life of your printer, it’s a good idea to familiarize yourself fully with 
all of its functions.

This 

 

User’s Manual

 

 uses the following symbols to indicate important information. Always 
observe the instructions indicated by these symbols.

Indicates instructions that, if ignored, could result in personal injury or 
material damage caused by incorrect operation of the equipment. 
Instructions indicated by this symbol must be observed for safe operation.

Indicates useful reference information or supplementary instructions 
concerning operation of the equipment. Be sure to read these notes.

This manual uses the following symbols depending on the computer system you are using. 
Always observe the instructions indicated by these symbols.

Indicates information for Windows 98 and Windows 95 users.

Indicates information for Macintosh users (OS 8.1 or later).

Note

Caution

Windows

Macintosh
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Copyright

 

This manual is copyrighted by Canon Computer Systems, Inc. (CCSI) with 
all rights reserved. Under the copyright laws, this manual may not be 
reproduced in any form, in whole or part, without the prior written consent 
of CCSI.

© 2000 Canon Computer Systems, Inc.

 

Disclaimer

 

Canon Computer Systems, Inc. has reviewed this manual thoroughly 
in order that it will be an easy-to-use guide to your Canon S450 Color 
Bubble Jet Printer. All statements, technical information, and recommen-
dations in this manual and in any guides or related documents are believed 
reliable, but the accuracy and completeness thereof are not guaranteed or 
warranted, and they are not intended to be, nor should they be understood 
to be, representations or warranties concerning the products described.

Your printer and the software media included with your printer have been 
sold to you subject to the limited warranties set forth in the warranty card 
and license agreement enclosed with the respective product. All software is 
licensed AS IS, as described in the license agreement enclosed with the 
software media. Further, CCSI reserves the right to make changes in the 
specifications of the products described in this manual at any time without 
notice and without obligation to notify any person of such changes.
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Trademarks

 

Canon, BCI, BJ, and Bubble Jet are trademarks, and SelectExchange is a 
service mark of Canon Inc. Print Planet is a service mark of Canon 
Computer Systems, Inc.

Mac and the Mac logo are trademarks of Apple Computer, Inc., registered 
in the U.S. and other countries. 

All other product and brand names are trademarks or service marks of their 
respective owners.

E

 

NERGY

 

 S

 

TAR

 

®

 

 COMPLIANT

As an E

 

NERGY

 

 S

 

TAR

 

®

 

 Partner, Canon U.S.A., Inc. has determined that this 
product meets the E

 

NERGY

 

 S

 

TAR

 

®

 

 guidelines for energy efficiency.
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How to Use This Manual

 

To view this 

 

User’s Manual

 

, please use Adobe

 

®

 

 Acrobat

 

®

 

 Reader 4.0 or later, which is 
included on your CD.

Use this button when you wish to 
enlarge the screen you are viewing. 
Select this button in the tool bar, and 
then click within the screen of the 
User’s Manual. Use this button to display the 

next page of the User’s 
Manual.

Use this button to 
return to the page 
you were viewing 
previously. This 
button moves you 
back from another 
page.

Use this button to display the 
previous page of the User’s 
Manual.

This arrow and blue text 
indicate a jump to another 
location in the User’s 
Manual where the topic 
shaded in blue is 
discussed.
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How to Use This Manual

 

This column displays a table of contents for the 

 

User’s Manual

 

. 
Click the desired item to jump to the topic.
Click the + (or   ) symbol when you wish to see detailed headings for each chapter.
Click the – (or 

 

�

 

) symbol when you wish to return to the original (condensed) display.

Use this button 
when you wish to 
search for a word.

 

�

 

03-Introduction.fm  Page 10  Thursday, June 1, 2000  4:03 AM



 

11Introduction

 

Safety Precautions

 

Please read the safety warnings provided in this manual to ensure that you use the printer 
safely. Do not attempt to use the printer in any way not described in this manual as this 
could result in unforeseen printer faults or cause a fire or electric shock.

 

Turning off the printer

Choosing a location

Power supply

Working around the printer

Cleaning the printer

BJ

 

®

 

 cartridges and ink tanks

Using the printer near appliances such as fluorescent lamps
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Safety Precautions

 

�  

 

Turning off the printer

 

To avoid printer malfunctions, always use the POWER button to turn the printer on and off. 
Do not remove the power cord from the power outlet until the printer has been turned off by 
pressing the POWER button. Be sure to unplug the power cord from the power outlet after 
the POWER light goes off.

 

�  

 

Choosing a location

 

Do not install the printer in a location that is unstable or subject to excessive vibration.

The printer could tip over or fall and cause injury.

Do not install the printer in locations that are very humid or dusty, in direct sunlight, or close 
to a heating appliance or fireplace.

To avoid the risk of fires or electric shocks, install the printer 
in a location with an ambient temperature range of 41 to 95°F 
(5 to 35°C) and humidity of 10 to 90% (no condensation).
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Safety Precautions

 

Do not place the printer on a thick rug or carpet.

Fibers or dust entering the printer could cause a fire.

Keep the power outlet for the printer free of all obstacles so you can unplug the power cord 
at any time.

Any obstacles could prevent you from unplugging the printer when 
a printer fault occurs and thereby cause a fire or electric shock.

When you are carrying the printer, always use both hands and hold the printer by both 
ends.

When you are moving the printer to another location, keep it stable 
so that you do not drop it and cause injury.
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Safety Precautions

 

Do not place the printer close to flammable solvents such as alcohol or thinner.

If flammable solvents come in contact with electrical components 
inside the printer, such substances could cause a fire or electric 
shock.

 

�  

 

Power supply

 

The socket-outlet shall be installed near the equipment and shall be easily accessible.

Always grasp the plug when you unplug the power cord.

Unplugging the power cord by pulling on the cord itself can 
damage the cord and cause a fire or electric shock.

Do not use an extension cord.

This could cause a fire or electric shock.
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Safety Precautions

 

Do not use a power supply voltage other than that supplied in the country of purchase.

Using the incorrect voltage could cause a fire or electric shock. The 
correct power supply voltage and frequency is:
     USA/Canada:  AC 120V, 60Hz

Do not attempt to plug the power cord into the power outlet or unplug the power cord when 
your hands are wet.

This could cause an electric shock.

Always push the plug all the way into the power outlet.

A loose or poorly inserted plug could cause a fire or electric shock.



 

16Introduction

Safety Precautions

 

Do not damage, modify, stretch or excessively bend or twist the power cord. Do not place 
heavy objects on the power cord.

Power leaking from a damaged power cord could cause a fire or 
electric shock.

Do not use the printer while the power cord is bundled or knotted.

This could cause a fire or electric shock.

If you detect smoke, unusual odors or strange noises around the printer, immediately press 
the POWER button to turn off the printer and always unplug the power cord.

Continuing to use the printer in these circumstances could cause a 
fire or electric shock. Call the Canon Customer Care Center.

 

 Getting Help From Canon
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Safety Precautions

 

�  

 

Working around the printer

 

Do not use flammable sprays near the printer.

Gases in the spray could cause a fire or electric shock if they come 
in contact with electrical components inside the printer.

Do not put your hands or fingers in the printer while it is printing.

The printer contains moving parts that could cause injury.

Do not place metal objects (paper clips, staples, etc.) or containers of flammable solvents 
(alcohol, thinners, etc.) on the top of the printer.

Such objects could fall or spill into the printer and cause a fire or 
electric shock.
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Safety Precautions

 

If any foreign objects (metal or liquid) enter the printer, turn off the printer, unplug the power 
cord, and call the Canon Customer Care Center.

 

 Getting Help From Canon

 

Continued use of the printer when a foreign object has fallen into 
the printer could cause a fire or electric shock.

 

�  

 

Cleaning the printer

 

Use a damp cloth to clean the printer. Never use flammable solvents such as alcohol, 
benzene, or thinner.

If flammable solvents come in contact with electrical components 
inside the printer, such substances could cause a fire or electric 
shock.
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Safety Precautions

 

Always unplug the printer from the power outlet when you are cleaning the printer.

If you mistakenly turn on the printer while cleaning it, you could 
touch moving internal printer components and suffer injury.

Do not attempt to disassemble or modify the printer.

The printer contains high-voltage components that could cause a 
fire or electric shock.

 

�  

 

BJ

 

®

 

 cartridges and ink tanks

 

For safety reasons, store BJ cartridges and ink tanks out of the reach of small children.

If a child inadvertently licks a BJ cartridge or ink tank or ingests 
any ink, consult a physician immediately.
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Safety Precautions

 

Do not subject BJ cartridges or ink tanks to shocks or excessive vibration.

This could cause the ink to leak out and stain your clothing or the 
surroundings.

Do not touch the metal contacts on a BJ cartridge after printing.

The metal parts may be very hot and could cause burns.

 

�  

 

Using the printer near appliances such as fluorescent lamps

 

Allow at least 6 inches (approximately 15 cm) clearance between the printer and an 
appliance such as a fluorescent lamp. Electrical noise generated by a fluorescent lamp 
placed too close to the printer may cause printer malfunctions.
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Parts and Functions of the Printer 

 

Front View

Rear View

Inside the Printer

Operation Panel
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Front View

 

Paper Guide

 

Ensures that sheets from the paper stack in the 
auto sheet feeder feed straight into the printer. 
Always align this guide with the left edge of the 
paper loaded in the auto sheet feeder.

 

Paper Rest

 

Raise to support the 
paper, especially a 
larger paper size.

 

Auto Sheet Feeder

 

Holds multiple sheets 
of paper or other 
media, which are 
automatically fed into 
the printer one sheet 
at a time.

 

Operation Panel

 

 Operation Panel

 

Front Cover

 

Open to install/replace/
switch BJ cartridges or 
to remove a paper jam.

 

Paper Thickness Lever

 

Adjusts the gap between the 
print heads and the surface of 
the paper you are printing on.

 

Paper Output Tray 

 

Holds printed sheets 
after they are ejected 
from the printer. 
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Rear View

 

Printer Cable Connector 
(Parallel Interface)

 

Provides a connection point 
for connecting a parallel 
interface cable to the printer.

 

Power Connector

 

Provides a connection point 
for connecting the power cord 
to the AC power outlet. 

 

Printer Cable Connector 
(USB Interface)

 

Provides a connection point 
for connecting a USB interface 
cable to the printer.
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Inside the Printer

 

Cartridge Holder

 

Contains two slots:
• The left slot holds the BC-30e Black BJ Cartridge (provided), 

BC-32e Photo BJ Cartridge (optional), or the IS-32 Color 
Image Scanner Cartridge (optional).

• The right slot holds the BC-31e Color BJ Cartridge (provided).

 

Cartridge Lock Levers

 

Lock the BJ cartridges 
onto the cartridge holder.
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Operation Panel

 

POWER button

 

Press to turn the printer 
on and off.

 

RESUME button

 

After you have removed the cause of 
a printer error, press the RESUME 
button to resume printing.

 

POWER light

 

Lights to indicate the status of the printer:
Off Printer power off.
On (green) Ready for operation.
Flashing (green) Standby status or print job in progress.
Flashing (orange) Printer error. Remove the cause of the error, 

then press RESUME to continue printing.
Flashing (orange and green) Service error. Contact the Canon Customer 

Care Center.

 

 Getting Help From Canon
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Operation Panel

 

Hold down the RESUME button until the POWER light starts to flash.Then, 
release the button.The following operations are performed, depending on 
how many times the light flashes.

• If you release the button after the light flashes 

 

once

 

:

Print head cleaning is performed.

 

 Cleaning the Print Heads

 

• If you release the button after the light flashes 

 

twice

 

:

A Nozzle Check Pattern is printed out.

 

 Printing a Nozzle Check Pattern

 

• You can also perform these tasks from the printer driver. 

 

 Using Maintenance Functions

 Printer Maintenance

Note

Windows

Macintosh
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Paper Handling

 

Paper and Other Print Media

Setting the Paper Thickness Lever

Printing Area

Notes on Handling Print Media

Printing on Special Media Types

Printing Photographs
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Paper and Other Print Media

 

Plain paper and Canon Specialty Papers are recommended for use with the printer. Refer to 
any instructions provided with special media for details about handling and printing.

 

�  

 

Ordinary Paper

 

• Plain Paper
Provides standard print quality.
You can use standard photocopier paper if its weight is within the range of 17 to 
28 lb (64 to 105 g/m

 

2

 

). (You can also use Canon Bubble Jet Paper.)

 

 

 

• Envelopes
You can use the standard US Commercial #10 and European DL sizes. 

| | | | | | | | | | |
@ E | | | | | | | | |

@ @ | | | | | | |
@ E | | | | | | | |

@ @ | | |@ E | | | | | | |
@ @    | | | | | | | |

@ @    | | | | | | | |

| | | |
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Paper and Other Print Media

 

�  

 

Canon Specialty Papers

 

Canon offers a range of special paper and films for the reproduction of superb images in 
vibrant colors. 

• Artist Canvas
Use this textured cotton canvas to add an artistic touch to your images and 
artwork. It is ideal for printing photos, illustrations, and artwork.

• Back Print Film 
This white translucent film is ideal for displays that use backlighting to show a 
printed image in the same way as slides and stained glass. The original image is 
reversed (mirrored) when printed.

 

 

 

• Banner Paper
This banner paper allows you to print on up to six connected sheets of letter size 
paper to create party or advertising banners. It is printable on both sides.

 

 

 

• Brilliant White Paper
Canon’s unique paper formulation gives you a bright white printing surface that 
produces incredibly brilliant colors and dark, crisp black text. This paper works 
great for everyday use, as well as proposals, color presentations, color charts 
and graphs, flyers, and newsletters. You can print on both sides of the sheet. 
(In the printer driver, select Plain Paper for the Media Type when you load this 
paper.)
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Paper and Other Print Media

 

• Bubble Jet Paper (water resistant)
The Canon Bubble Jet Paper has been developed for high quality printing with 
minimal or no smearing or running when in contact with water or damp surfaces, 
making it a good choice for damp or rainy environments. The paper is specially 
coated and printable on both sides. (In the printer driver, select Plain Paper for 
the Media Type when you load this paper.)

• Glossy Photo Cards
This is a special 4.75 

 

×

 

 8.5 inch sheet made of the same stock as Glossy Photo 
Paper. You can print borderless photos by printing the image so that it extends 
beyond the perforations and then trim off the unwanted white margins.

 

 

 

Use this 
card when you want to print a full 4 

 

×

 

 6 inch photo.

• Glossy Photo Paper
This high quality glossy-coated, heavy-weight paper produces vibrant, life-like 
color images. With this paper, you can print photographic quality images.

 

 

 

• Greeting Cards
Get the most out of your card-making software with Canon Greeting Cards. 
These cards give your unique, personalized cards the look and feel of 
professional cards. You can create cards, invitations, announcements, and more. 
These cards come in quarter-fold size and half-fold size. 
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Paper and Other Print Media

 

• High Gloss Photo Film
This is a film sheet with a higher gloss than Glossy Photo Paper. To obtain the 
highest quality reproduction of photographs, use this media with the BC-31e 
Color BJ Cartridge. (You cannot use this media type with the optional BC-32e 
Photo BJ Cartridge.)

 

 

 

• High Resolution Paper
This medium is extra smooth for sharp text, brilliant graphics, and professional 
quality images. It is ideal for printing photographs or business documents that 
include color charts and graphs. 

 

 

 

• Magnet Sheets 
This medium provides a durable, bright-white, glossy surface. Printable magnets 
can be cut to any desired shape or size. They are ideal for picture frames, 
calendars, and business cards.

 

 

 

• Transparencies 
Use transparencies to prepare materials for use with an overhead projector. To 
avoid paper jams and other problems, use transparencies specifically designed 
for use with the Canon Bubble Jet printer. Do not use transparencies designed 
for laser printers or photocopiers.
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Paper and Other Print Media

 

�  

 

Media Types You Cannot Use With the Printer

 

To avoid poor print quality and possible damage to the printer, do not use the media types 
listed below.

• Folded paper
• Curled paper
• Creased or crumpled paper
• Damp or wet paper
• Excessively thin media (weight less than 17 lb — 64 g/m

 

2

 

)
• Excessively thick or extremely heavy paper (exceeding 28 lb — 105 g/m

 

2

 

)
• Continuous feed paper (tractor feed)
• Punched paper (loose-leaf folder inserts, etc.)
• Reply-paid postcards (such as double postcards)
• Postcards with a photograph printed on the reverse side
• Postcards with a photograph or sticker pasted on
• Envelopes with overlapping flaps
• Envelopes with pressure seals
• Envelopes with embossed or treated surfaces
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Paper and Other Print Media

 

�  

 

Media Sizes You Can Use With the Printer

 

The following table lists the standard paper sizes that you can use with the printer.

You can also use custom paper sizes within the following ranges.

Width 3.94 in. to 9.50 in. (100.0 mm to 241.3 mm)
Height 3.94 in. to 23.0 in. (100.0 mm to 584.2 mm)

You can load media of the following weight for printing.

17 lb to 28 lb (64 g/m

 

2

 

 to 105 g/m2)

Paper Width × Height

Letter 8.5 in. × 11.0 in. 

Legal 8.5 in. × 14.0 in.

A4 210 mm × 297 mm

A5 148 mm × 210 mm

B5 182.0 mm × 257.0 mm

Envelope (US Com. #10) 9.5 in. × 4.12 in.

Envelope (European DL) 220 mm × 110 mm

Canon 4" × 6" 4 in. × 6 in.

Custom Size 8.5 in. × 11.0 in.
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Paper and Other Print Media

�  Landscape and Portrait
There are two methods of orientation you can use to load the printer, depending on the type 
of media you intend to load.

• When the short edge of the paper is fed into the auto sheet feeder, this is called 
Portrait orientation.

• When the long edge of the paper is fed into the auto sheet feeder, this is called 
Landscape orientation.

Paper
Portrait

(vertical)
Landscape 
(horizontal)

Letter Yes No

Legal Yes No

A5 Yes Yes

B5 Yes No

A4 Yes No

Envelope (US Com. #10) No Yes

Envelope (European DL) No Yes

Glossy Photo Cards Yes No
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Paper and Other Print Media

�  Print Side
The following media must be printed on its correct side.

• Artist Canvas Must be printed on coated side of the canvas.

• Back Print Film Must be printed on the matte side.

• Glossy Photo Cards Must be printed on the whiter (glossy) side.

• Glossy Photo Paper Must be printed on the whiter (glossy) side.

• Greeting Cards (1/4-fold) Must be loaded with the words “Canon Greeting 
Cards” face down.

• Greeting Cards (1/2-fold) Can be printed on either side.

• High Gloss Photo Film Must be loaded and printed with the glossy side 
facing up and the cut corner at top right against the 
right side of the auto sheet feeder.

• High Resolution Paper Must be printed on the whiter side.

• Magnet Sheets Must be printed on the glossy side.

• Envelope Must be printed on the address side.
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Paper and Other Print Media

�  Number of sheets that can be loaded at a time
The number of sheets that can be loaded varies according to the type of media. Make sure 
that the paper stack is not higher than the load limit mark (   | ) on the auto sheet feeder.

Media type Maximum capacity of sheet feeder

Plain Paper Approximately 100 sheets (20 lb — 75 g/m2)

Artist Canvas 1 sheet

Back Print Film Approximately 10 sheets

Banner Paper 1 sheet (2 to 6 sheets in length)

Glossy Photo Cards 1 sheet

Glossy Photo Paper Approximately 10 sheets

Greeting Cards 1 sheet

High Gloss Photo Film 1 sheet

High Resolution Paper Approximately 80 sheets

Magnet Sheets 1 sheet

Transparency Approximately 30 sheets

Envelopes Approximately 10 pieces (US Com. #10 or European DL)

�
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Setting the Paper Thickness Lever

Before you print, be sure to set the paper thickness lever as listed below.

Paper Thickness Lever
Adjusts the gap between 
the print head and the 
surface of the paper you 
are printing on.

Media type Position

Plain Paper Up

Artist Canvas Down

Back Print Film Up

Banner Paper Down

Glossy Photo Cards Up

Glossy Photo Paper Up

Greeting Cards Down

High Gloss Photo Film Up

High Resolution Paper Up

Magnet Sheets Down

Transparency Up

Envelope Down
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Printing Area

To ensure the best print quality, the printer requires a margin along each edge of the media. 
The printing area, which varies according to the media size, is the paper size minus the 
margins.

There is both a printing area (recommended) and a printable area (possible).

Printing area (dark gold) Canon recommends that you print within this area 
for optimum print quality. (       )

Printable area (light gold) The area where it is possible to print. However, 
printing in this area can adversely affect the print 
quality or the paper feed precision. (       )

 Letter, Legal

 A4, A5, B5

 Glossy Photo Cards

 US Com. #10 Envelope

 European DL Envelope

 Banner Paper



39Paper Handling

Printing Area

�  Letter, Legal

Media Type Printable Area (width × height)

Letter 8.0 in. × 10.69 in.

Legal 8.0 in. × 13.69 in.

* Printing in this area can adversely affect the print quality or the paper 
feed precision.

1.26"

0.91"

0.25" 0.25"

0.20"

0.12"

Recommended printing area
Printable area where it is possible to print.*

Note
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Printing Area

�  A4, A5, B5

Media Type Printable Area (width × height)

A4 203.2 mm × 289.0 mm

A5 141.2 mm × 202.0 mm

B5 175.2 mm × 249.0 mm

* Printing in this area can adversely affect the print quality or the paper
feed precision.

32.0 mm

23.0 mm

3.4 mm 3.4 mm

5.0 mm

3.0 mm

Recommended printing area
Printable area where it is possible to print.*

Note
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Printing Area

�  Glossy Photo Cards

Media Type Printable Area (width × height)

Glossy Photo Cards 4.31 in. × 6.30 in.

0.20" 0.16"

1.10"

1.10"

Recommended printing area
(The printable area is identical to the printing area.)
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Printing Area

�  US Com. #10 Envelope

Media Type Printable Area (width × height)

US Com. #10 8.0 in. × 3.81 in.

0.25" 1.25"

0.20"

0.12"

Recommended printing area
(The printable area is identical to the printing area.)
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Printing Area

�  European DL Envelope

Media Type Printable Area (width × height)

European DL 203.2 mm × 102.0 mm

6.4 mm 10.4 mm

7.0 mm

3.0 mm

Recommended printing area
(The printable area is identical to the printing area.)
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Printing Area

�  Banner Paper

Media Type Printable Area (width × height)

Banner Paper 8.0 in. × 65.88 in. (Letter)
203.2 mm × 1779.0 mm (A4)

*  Printing in this area can adversely affect the print quality or the paper
 feed precision.

3.4 mm
A4

0.12" (3.0 mm)
0.73" (18.5 mm)

Recommended printing area

Max. 6 sheets
Min. 2 sheets

Printable area where it is possible to print.*

(    )(    )

3.4 mm
A4(    )0.13"

Letter

0.37"
Letter

(    )

Note
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Notes on Handling Print Media

• Whenever possible, hold the paper by the edges and avoid touching the print 
side. Any scratching or soiling on the print side will adversely affect the print 
quality.

• When storing your media, put the media back in its original packaging and avoid 
locations that are exposed to direct sunlight or that are subject to high 
temperatures or humidity. To avoid bending or wrinkling the paper, store it in a 
level place.

• After printing, do not touch the print side until the ink is dry. If water gets on the 
printed media, do not touch the print side until the media dries.

• The following are guidelines on how long ink takes to dry on individual print 
media.

Artist Canvas About 15 minutes
Back Print Film About 15 minutes
Glossy Photo Cards About 2 minutes
Glossy Photo Paper About 2 minutes
High Gloss Photo Film About 2 minutes
Magnet Sheets About 30 minutes
Transparency About 15 minutes
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Printing on Special Media Types

Artist Canvas

Back Print Film

Banner Paper

Glossy Photo Cards

Glossy Photo Paper

Greeting Cards

High Gloss Photo Film

High Resolution Paper

Magnet Sheets

Transparencies

Envelopes
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Printing on Special Media Types

�  Artist Canvas

Make sure that the printer is turned on and the paper thickness lever is set 
to the Down position. Raise the paper rest.

Paper thickness lever

Paper rest

1
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Printing on Special Media Types

Load the Artist Canvas.

• With the print side (coated side) facing up, load one sheet of Artist 
Canvas with the edge aligned against the right side of the auto sheet 
feeder. 

• Adjust the paper guide to the left side of the sheet.

You can load one sheet of Artist Canvas in the auto sheet feeder.

Open the Printer Properties dialog box, then select the most appropriate 
icon in the Choose Print Mode box under the Main tab. Select High 
Resolution Paper in the Media Type box. Also make sure that the 
BJ Cartridge setting matches the BJ cartridge installed in the printer. 
For Page Size, select Custom and set it to 9.5" × 14".

 Using the Windows 98/95 Printer Driver

2

Print side
(coated side) up

Note

3 Windows
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Printing on Special Media Types

Select the most appropriate icon that indicates the print mode in the Printer 
Properties dialog box. Specify the media type (High Resolution Paper), and 
the BJ cartridge installed in the printer.

 Using the Macintosh Printer Driver

Start the print job.

Remove each printed sheet as it is ejected from the printer.

Do not touch the printed side until the ink is completely dry. About 
15 minutes are required for drying.

Return unused sheets to the original package. Store the sheets in a flat, 
dry, cool location away from direct sunlight, high temperature, and high 
humidity.

Macintosh

4

5

Note



50Paper Handling

Printing on Special Media Types

�  Back Print Film

Make sure the printer is turned on and the paper thickness lever is set to 
the Up position. Raise the paper rest.

1

Paper rest

Paper thickness lever



51Paper Handling

Printing on Special Media Types

Fan the Back Print Film to remove static cling and tap the edges against a 
flat surface to align them neatly. 

If the film is curled, bend it slightly in the opposite direction of the curl to 
straighten it. 

• The matte side of the film is the print side which should be loaded 
face up.

• To avoid touching the print surface, always handle the sheets by the 
edges. Unclean or scratched print surfaces can adversely affect print 
quality.

2

Note
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Printing on Special Media Types

Load the Back Print Film:

• With the print (matte) side facing up, place one sheet of plain paper 
under the stack. Load the stack with the edges aligned against the 
right side of the sheet feeder.

• Adjust the paper guide to the left side of the stack.

You can load up to ten sheets of film in the auto sheet feeder.

Open the Printer Properties dialog box, then select the most appropriate 
icon in the Choose Print Mode box under the Main tab. Select Back Print 
Film in the Media Type box. Also make sure that the BJ Cartridge setting 
matches the BJ cartridge installed in the printer. 

Change the settings if necessary.

 Using the Windows 98/95 Printer Driver

3

Print (matte) side up
Plain paper

Note

4 Windows



53Paper Handling

Printing on Special Media Types

Select the most appropriate icon that indicates the print mode in the Printer 
Properties dialog box. Specify the media type (Back Print Film), and the 
BJ cartridge installed in the printer.

 Using the Macintosh Printer Driver

Start the print job.

Remove each printed sheet of Back Print Film as it is ejected from the 
printer.

Do not touch the printed side until the ink is completely dry. About 15 
minutes are required for drying.

 
• An image is reversed when printed on Back Print Film in order to display 

correctly when lit with a backlight.

• After drying, cover each sheet of Back Print Film with one sheet of plain
paper (uncoated) to prevent sticking and abrasion. Also, cover each
sheet of Back Print Film if you are storing them in plastic pockets to
prevent the film from sticking to the plastic.

• Store unused film in the original package in a dry, cool location away
from direct sunlight, high temperature, and high humidity.

Macintosh

5

6

Note
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Printing on Special Media Types

�  Banner Paper

Make sure the printer is turned on and the paper thickness lever is set to 
the Down position. Lower the paper rest.

1

Paper thickness lever

Paper rest
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Printing on Special Media Types

Before you tear off the sheets, make sure that you take one more sheet 
than you need for printing. (When you wish to print three sheets, tear off a 
length of four sheets—one more than you need for printing.)

You can print on up to six sheets. If you want to print a banner of maximum 
length (six sheets), tear off a length of seven sheets—one more than you 
need for printing.

2

Note



56Paper Handling

Printing on Special Media Types

Load the Banner Paper:

• Align the right side of the first sheet with the right side of the sheet 
feeder and insert it into the sheet feeder until it stops.

• Adjust the paper guide to the left side of the sheet.

• You can print on either side of Banner Paper.

• Neatly fold the unprinted paper behind the printer and do not allow it 
to hang over the edge of the table.

3

Print side up

Note



57Paper Handling

Printing on Special Media Types

Gently fold over the perforations between the first and second sheet.4



58Paper Handling

Printing on Special Media Types

Be sure to provide ample space in front of the printer so each sheet is 
supported as it comes out of the printer and then allowed to hang over the 
edge of the table:

A dense printout will require more time to dry. Be careful that wet ink does 
not stain the desk or the floor.

5

Note



59Paper Handling

Printing on Special Media Types

Start the print job.

In the Windows driver, you select Banner Printing on the Page Layout tab.

 Printing on Banner Paper

When using a Macintosh, select Banner Printing before creating a 
document using an application program.

 Printing on Banner Paper

6
Windows

Macintosh
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Printing on Special Media Types

�  Glossy Photo Cards

Make sure the printer is turned on and the paper thickness lever is set to 
the Up position. Raise the paper rest.

1

Paper rest

Paper thickness lever
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Printing on Special Media Types

Load the Glossy Photo Card:

• With the print side (glossy side) facing up, place the Loading Support 
Sheet A provided with the package under the sheet. Load the sheet 
with the edges aligned against the right side of the sheet feeder. (For 
details, refer to the instructions provided with the Glossy Photo Cards 
package.)

• Adjust the paper guide to the left side of the sheet.

• Do not remove the borders from the photo card before printing.

• To avoid touching the print side (glossy side), always handle the sheet by 
the edges. Unclean or scratched print surfaces can adversely affect print
quality.

2

Glossy side

Loading Support Sheet A

Note
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Printing on Special Media Types

Open the Printer Properties dialog box, then select the most appropriate 
icon in the Choose Print Mode box under the Main tab. Select Glossy Photo 
Cards in the Media Type box. Also make sure that the BJ Cartridge setting 
matches the BJ cartridge installed in the printer. 

Change the settings if necessary.

 Using the Windows 98/95 Printer Driver

Select the most appropriate icon that indicates the print mode in the Printer 
Properties dialog box. Specify the media type (Glossy Photo Cards), and 
the BJ cartridge installed in the printer.

 Using the Macintosh Printer Driver

Click the Page Layout tab and make sure that the Page Size setting is 
Canon 4" × 6".

Normally you can set the paper size with the application program. However, 
if the setting on the Page Layout tab does not match the setting in the 
application program, or if your application program does not provide a size 
selection for Glossy Photo Cards, specify the setting here.

 Using the Windows 98/95 Printer Driver

3 Windows

Macintosh

4 Windows



63Paper Handling

Printing on Special Media Types

Select Canon 4" × 6" for the Page Size setting. Normally you can set the 
paper size with the application program.

 Using the Macintosh Printer Driver

Start the print job.

Remove each printed card as it is ejected from the printer.

Do not touch the printed side until the ink is completely dry. About two 
minutes are required for drying.

Tear away the strip of the Glossy Photo Card. For more details, see the 
instructions provided with the Glossy Photo Cards package.

Store unused Glossy Photo Cards in the original package in a dry, cool 
location away from direct sunlight, high temperature, and high humidity.

Macintosh

5

6

7

Note



64Paper Handling

Printing on Special Media Types

�  Glossy Photo Paper

Make sure the printer is turned on and the paper thickness lever is set to 
the Up position. Raise the paper rest.

1

Paper rest

Paper thickness lever



65Paper Handling

Printing on Special Media Types

Fan the Glossy Photo Paper to remove static cling and tap the edges 
against a flat surface to align them neatly. 

If the film is curled, bend it slightly in the opposite direction of the curl to 
straighten it. 

To avoid touching the print surface, always handle the sheets by the edges. 
Unclean or scratched print surfaces can adversely affect print quality.

2

Note



66Paper Handling

Printing on Special Media Types

Load the Glossy Photo Paper.

• With the print side (glossy side) facing up, place the Loading Support 
Sheet A provided with the package under the stack. Load the stack 
with the edges aligned against the right side of the sheet feeder. (For 
details, refer to the instructions provided with the package.)

• Adjust the paper guide to the left side of the stack.

• You can load up to ten sheets in the sheet feeder.

• Do not use the Support Sheet B provided with the package.

3

Print side
(glossy side) up Loading Support Sheet A

Note



67Paper Handling

Printing on Special Media Types

Open the Printer Properties dialog box, then select the most appropriate 
icon in the Choose Print Mode box under the Main tab. Select Glossy Photo 
Paper in the Media Type box. Also make sure that the BJ Cartridge setting 
matches the BJ cartridge installed in the printer.

Change the settings if necessary.

 Using the Windows 98/95 Printer Driver

Select the most appropriate icon that indicates the print mode in the Printer 
Properties dialog box. Specify the media type (Glossy Photo Paper), and 
the BJ cartridge installed in the printer.

 Using the Macintosh Printer Driver

Start the print job.

Remove each printed sheet as it is ejected from the printer.

Do not touch the printed side until the ink is completely dry. About two 
minutes are required for drying.

Store unused film in the original package in a dry, cool location away from
direct sunlight, high temperature, and high humidity.

4 Windows

Macintosh

5

6

Note
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Printing on Special Media Types

�  Greeting Cards

Make sure the printer is turned on and the paper thickness lever is set to 
the Down position. Raise the paper rest.

1

Paper rest

Paper thickness lever
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Printing on Special Media Types

Load the Greeting Cards:

• For 1/4-fold greeting cards, load the sheet with the words "Canon 
Greeting Cards" face down, and align the edge of the sheet against 
the right side of the sheet feeder. 1/2-fold greeting cards can be 
printed on either side. (For details, refer to the instructions provided 
with the Greeting Cards package.)

• Adjust the paper guide to the left side of the sheet.

Open the Printer Properties dialog box, then select the most appropriate 
icon in the Choose Print Mode box under the Main tab. Select High 
Resolution Paper in the Media Type box. Also make sure that the 
BJ Cartridge setting matches the BJ cartridge installed in the printer. 

Change the settings if necessary.

 Using the Windows 98/95 Printer Driver

2

(a)
(b)

3 Windows



70Paper Handling

Printing on Special Media Types

Select the most appropriate icon that indicates the print mode in the Printer 
Properties dialog box. Specify the media type (High Resolution Paper), and 
the BJ cartridge installed in the printer.

 Using the Macintosh Printer Driver

Start the print job.

Remove each printed card as it is ejected from the printer.

Do not touch the printed side until the ink is completely dry. 

Store unused Greeting Cards in the original package in a dry, cool 
location away from direct sunlight, high temperature, and high humidity.

Macintosh

4

5

Note
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Printing on Special Media Types

�  High Gloss Photo Film

Use only the BC-31e Color BJ Cartridge for printing on High Gloss Photo 
Film. Do not use the BC-32e Photo BJ Cartridge.

Make sure the printer is turned on and the paper thickness lever is set to 
the Up position. Raise the paper rest.

Note

1

Paper rest

Paper thickness lever



72Paper Handling

Printing on Special Media Types

Load one sheet of High Gloss Photo Film:

• Remove one sheet from the package and hold the glossy side up with 
the cut corner up and on the right. Align the right edge with the right 
side of the auto sheet feeder and insert the sheet into the auto sheet 
feeder.

• Adjust the paper guide to the left side of the sheet. 

• If the sheet is curled, bend it slightly against the curl to straighten it.

• Always handle the sheet by the edges. An unclean or scratched print
surface can adversely affect print quality.

2

Print side (glossy side) up with the
cut corner up and on the right

Cut corner

Note



73Paper Handling

Printing on Special Media Types

Open the Printer Properties dialog box, then select the most appropriate 
icon in the Choose Print Mode box under the Main tab. Select High Gloss 
Photo Film in the Media Type box. The BJ Cartridge setting is automatically 
set to Color. 

Change the settings if necessary.

 Using the Windows 98/95 Printer Driver

Select the most appropriate icon that indicates the print mode in the Printer 
Properties dialog box. Specify the media type (High Gloss Photo Film), and 
the BJ cartridge (Color).

 Using the Macintosh Printer Driver

Start the print job.

Remove each printed sheet as it is ejected from the printer.

Do not touch the printed side until the ink is completely dry. About 10 
minutes are required for drying.

Store unused film in the original package in a dry, cool location away from 
direct sunlight, high temperature, and high humidity. After storing the 
unused film in the package, place it on a stable, horizontal surface so that 
the film is not curled or creased in the package.

3 Windows

Macintosh

4

5

Note
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Printing on Special Media Types

�  High Resolution Paper

Make sure the printer is turned on and the paper thickness lever is set to 
the Up position. Raise the paper rest.

Fan the stack to remove static cling and align the edges of the stack by 
tapping them on a flat surface. 

1

Paper rest

Paper thickness lever

2



75Paper Handling

Printing on Special Media Types

To avoid touching the print surface, always handle media by the edges. 
Unclean or scratched print surfaces can adversely affect print quality.

Load the stack of paper with the whiter-side facing up:

• Align the stack with the right side of the auto sheet feeder and insert it 
into the auto sheet feeder.

• Adjust the paper guide to the left side of the stack.

Make sure that the top of the stack is not higher than the load limit mark. 
Maximum capacity of the sheet feeder is approximately 80 sheets of High 
Resolution Paper.

Note

3

Load limit mark

Note



76Paper Handling

Printing on Special Media Types

Open the Printer Properties dialog box, then select the most appropriate 
icon in the Choose Print Mode box under the Main tab. Select High 
Resolution Paper in the Media Type box. Also make sure that the 
BJ Cartridge setting matches the BJ cartridge installed in the printer. 

Change the settings if necessary.

 Using the Windows 98/95 Printer Driver

Select the most appropriate icon that indicates the print mode in the Printer 
Properties dialog box. Specify High Resolution Paper for the media type 
and select the BJ cartridge installed in the printer.

 Using the Macintosh Printer Driver

Start the print job.

Check the printed sheets as they are ejected from the printer.
As soon as about 20 sheets have stacked on the paper output tray, remove 
them.
If the printed sheets are excessively curled after they are ejected from the 
printer, remove each sheet immediately to prevent curled sheets from 
blocking other sheets ejected from the printer.

• Store unused paper and other media flat in the original package in a dry, 
cool location away from direct sunlight, high temperature, and high
humidity.

4 Windows

Macintosh

5

6

Note
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Printing on Special Media Types

�  Magnet Sheets

Make sure the printer is turned on and the paper thickness lever is set to 
the Down position. Raise the paper rest.

1

Paper rest

Paper thickness lever
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Printing on Special Media Types

Place one sheet of plain paper behind one magnet sheet. 

Place both sheets on a hard surface to align the bottom edge and sides. 

• From the bottom edge, roll the two sheets together with the plain paper 
facing out and glossy side of the magnet sheet facing inside.

• Once rolled, hold in this position for 20 seconds.

2

Glossy side of magnet sheet

Plain paper

Note

1.5"

1.5"
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Printing on Special Media Types

Unroll the media and place it in the sheet feeder immediately.

• Make sure the print (glossy) side is facing up and one sheet of plain 
paper is under the sheet, load the two sheets with the edges aligned 
against the right side of the sheet feeder.

• Adjust the paper guide to the left side of the sheets.

You can load one Magnet Sheet in the sheet feeder.

Open the Printer Properties dialog box, then select the most appropriate 
icon in the Choose Print Mode box under the Main tab. Select Glossy Photo 
Paper in the Media Type box. The BJ Cartridge setting is automatically set 
to Color. 

Change the settings if necessary.

 Using the Windows 98/95 Printer Driver

3

Print (glossy) side up Plain paper

Note

4 Windows
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Printing on Special Media Types

Select the most appropriate icon that indicates the print mode in the Printer 
Properties dialog box. Specify the media type (Glossy Photo Paper), and 
the BJ cartridge (Color).

 Using the Macintosh Printer Driver

Start the print job.

Remove the printed Magnet Sheet as it is ejected from the printer.

Do not touch the printed side until the ink is completely dry. About 30 
minutes are required for drying.

Discard the sheet of plain paper.

 
• Return unused Magnet Sheets to the original package and store the 

sheets in a flat, dry, cool location away from direct sunlight, high 
temperature, and high humidity.

Macintosh

5

6

Note
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Printing on Special Media Types

�  Transparencies
Make sure the printer is turned on and the paper thickness lever is set to 
the Up position. Raise the paper rest.1

Paper rest

Paper thickness lever



82Paper Handling

Printing on Special Media Types

Fan the transparencies to remove static cling and tap the edges against a 
flat surface to align them neatly. 

• To avoid touching the print surface, always handle the sheets by the 
edges. Unclean or scratched print surfaces can adversely affect print 
quality.

• Do not remove transparencies from the package until you are ready to 
load them in the auto sheet feeder, especially in humid conditions.

2

Note
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Printing on Special Media Types

Load the transparencies:

• Load the stack with the edges aligned against the right side of the 
sheet feeder.

• Adjust the paper guide to the left side of the stack. You can print on 
either side of transparencies, but using a slightly curled surface as a 
print side is recommended.

You can load up to 30 transparencies in the sheet feeder.

Open the Printer Properties dialog box, then select the most appropriate 
icon in the Choose Print Mode box under the Main tab. Select Transparency 
in the Media Type box. Also make sure that the BJ Cartridge setting 
matches the BJ cartridge installed in the printer. 

Change the settings if necessary.

 Using the Windows 98/95 Printer Driver

3

Note

4 Windows
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Printing on Special Media Types

Select the most appropriate icon that indicates the print mode in the Printer 
Properties dialog box. Specify the media type (Transparency), and the 
BJ cartridge installed in the printer.

 Using the Macintosh Printer Driver

Start the print job.

Remove each printed transparency as it is ejected from the printer.

Do not touch the printed side until the ink is completely dry. About 15 
minutes are required for drying.

• After drying, cover each transparency with one sheet of plain paper 
(uncoated) to prevent sticking and abrasion. Also, cover each
transparency if you are storing them in plastic pockets to prevent the
transparencies from sticking to the plastic.

• Store unused transparencies in the original package in a dry, cool
location away from direct sunlight, high temperature, and high humidity.

Macintosh

5

6

Note



85Paper Handling

Printing on Special Media Types

�  Envelopes

Make sure the printer is turned on and the paper thickness lever is set to 
the Down position. 

• To avoid poor print results, do not attempt to print on envelopes with 
embossed or treated surfaces.

• To avoid misfeeds and jams, do not use envelopes with overlapping flaps 
or pressure seals.

1

Paper thickness lever

Note
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Printing on Special Media Types

Prepare the envelopes.

• Press down firmly on the corners of the envelopes and all edges to flatten 
the envelopes and expel all air.

• If the envelopes are still warped, hold the edges of the envelopes 
diagonally and bend gently. Make sure the flaps are straight.

• To ensure the envelopes feed correctly, use a pen or similar object to 
flatten the flaps.

• Failure to flatten the envelopes before loading may cause jams.

• Warping and air pockets in the envelopes should not exceed 0.2 in.
(5 mm).

2

Note
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Printing on Special Media Types

Load the envelopes:

• Load the top edge of the address side (flap side down) into the auto sheet 
feeder and align the stack with the right side of the auto sheet feeder.

• Adjust the paper guide to the left side of the stack.

You can load up to ten envelopes in the sheet feeder.

Open the Printer Properties dialog box, then select the most appropriate 
icon in the Choose Print Mode box under the Main tab. Select Envelope in 
the Media Type box. Also make sure that the BJ Cartridge setting matches 
the BJ cartridge installed in the printer. 

Change the settings if necessary.

 Using the Windows 98/95 Printer Driver

3

Print side (address side)

Note

4 Windows
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Printing on Special Media Types

Select the most appropriate icon that indicates the print mode in the 
Printer Properties dialog box. Specify the media type (Envelope), and 
the BJ cartridge installed in the printer.

 Using the Macintosh Printer Driver

Click the Page Layout tab, then select “#10 Env. 9.50 × 4.12 in.” or “DL Env. 
220.0 × 110 mm” in the Page Size box for the envelope size.

Normally you can set the envelope size with the application program. 
However, if the setting on the Page Layout tab does not match the setting in 
the application progam, change the setting here.

 Using the Windows 98/95 Printer Driver

Select “#10 Env. 9.50 × 4.12 in.” or “DL Env. 220.0 × 110 mm” for the 
envelope size.

Normally you can set the envelope size with the application program.

 Using the Macintosh Printer Driver

Start the print job.

Remove each printed envelope as it is ejected from the printer.

Macintosh

5 Windows

Macintosh

6

7
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Printing Photographs

�  Tips for Printing Photographic Images
To produce the best possible print quality for printing photographic images from a digital 
camera or scanner, or photographic images downloaded from a home page on the Internet, 
follow these guidelines:

• Use the combination of the BC-32e Photo BJ Cartridge and the BC-31e Color 
BJ Cartridge.

• Use special media designed for reproducing photographs.
• Use correct print settings in the printer driver.

Make sure that the printer is turned on. Also make sure that the BC-32e 
Photo BJ Cartridge is installed in the cartridge holder.

Load special print media in the auto sheet feeder of the printer.
Excellent prints of photographs can be obtained with plain paper; for 
superior color reproduction, using one of the following special media is 
recommended.

• Glossy Photo Cards 
• Glossy Photo Paper 
• High Gloss Photo Film
• High Resolution Paper 

 Paper and Other Print Media

1

2
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Printing Photographs

Open the Printer Properties dialog box and select SuperPhoto in the 
Choose Print Mode box under the Main tab.

When SuperPhoto is selected, the BJ Cartridge setting automatically 
changes to Photo/Color so you can use the different types of inks provided 
by the BC-32e Photo BJ Cartridge.

Click the OK button to close the Printer Properties dialog box.

Start the print job.

Select the command used for printing (for example, Print from the File 
menu) to open the Printer Properties dialog box.

Select the Photo icon in the Printer Properties dialog box.

Select Photo/Color in the BJ Cartridge setting, and click the Print button.

For optimum reproduction of all the color tones, make sure that the Media 
Type setting is correct for the media you have loaded in the printer.

Windows

3

4

5

Macintosh

3

4

5

Note
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Printing Photographs

�  About Photo Optimizer
The Photo Optimizer adjusts a photographic image created with a digital camera device 
when it is printed out.  Use the Photo Optimizer to compensate unsatisfactory color balance 
and over- or underexposure before printing.

Open the Printer Properties dialog box, then click the Main tab.

Click the Advanced button.

Select Photo Optimizer in the Quality tab.

Check the Whole Page checkbox, if necessary. 

Enabled:
When the Whole Page setting is enabled, the Photo Optimizer adjusts 
multiple photographic images appearing on the same page separately.  
Use this setting when any trimmed or rotated images are contained in the 
page.

Disabled:
When the Whole Page setting is disabled, the Photo Optimizer adjusts 
multiple graphic images appearing on the same page as a whole.

Windows

1

2

3

4
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Printing Photographs

Open the Photo Optimizer in the Quality panel. The Photo Optimizer feature 
works on the image that is edited using the edit menu such as Cut and 
Rotate in a graphics application program.

Macintosh

1

Disabled Enabled
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Printer Driver Basics

The printer driver controls communication between the printer and your computer. To use 
the printer with your computer, you must install the printer driver. For instructions on 
installing the printer driver, refer to the Quick Start Guide.

A
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Windows 2000 and Windows NT Users

The information in this section is specific to Windows 98 and Windows 95.

If you are a Windows 2000 or Windows NT 4.0 user, please note that some of the operation 
procedures are not identical to Windows 98 and Windows 95, and some of the features are 
not supported. 

To open the S450 Properties dialog box from the Start menu, you click Start, Settings, and 
Printers. Highlight the Canon S450 icon and then select "Printing Preferences" from the 
File menu. The printer settings are arranged on these tabs:

Windows 2000/NT 4.0 tabs

Main

Page Setup

Effects

Profiles

Maintenance

Although the printer settings are arranged differently on these tabs, the functionality is 
basically the same.

For more details on the operation procedures for Windows 2000 or Windows NT 4.0, please 
use the online help feature.

 Using Online Help
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Preparing and Executing a Print Job

Before you start a print job, you need to specify the print settings. The print settings in the 
printer driver allow fine control over the print quality and color adjustment, but you can 
simplify the setup procedure as follows.

Set the paper size you use from within the application program before 
printing.

Select the command used for printing (for example, Print or Print Setup in 
the File menu) in the application program.

Click the Properties button to open the Printer Properties dialog box, then 
select the desired icon for your print mode in the Choose Print Mode box 
under the Main tab.

• The most appropriate print settings are pre-assigned in each icon for a 
particular type of print job.

• The BJ Cartridge and Media Type settings are selected automatically.

Make sure that the BJ Cartridge and Media Type settings match the 
BJ cartridges installed in the printer and the print media you are using. 

Change the settings, as needed.

Also make sure that the Paper Size setting in the Page Layout tab matches 
the setting in the application program.

Click the OK button to close the Printer Properties dialog box.

Click the OK button in the Print window. Printing begins.

1

2

3

4

5

6
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Getting to Know the Windows 98/95 Printer Driver

�  Opening the Printer Properties Dialog Box
When you specify the print settings or use maintenance functions such as print head 
cleaning, you must open the Printer Properties dialog box.

This section describes the general procedures for opening the Printer 
Properties dialog box. Depending on the application program you use, 
different menu items may be used for printing. For more details, refer to the 
documentation for your application program.

From your application program

You can open the Printer Properties dialog box from your application program before 
printing.

Select the command used for printing (for example, Print or Print Setup 
from the File menu) in your application program.

Make sure that Canon S450 is selected in the Printer box.

If another printer name is displayed, click the down-arrow and then select 
Canon S450 from the pull-down list.

Note

1

2
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Getting to Know the Windows 98/95 Printer Driver

Click the Properties button. The Printer Properties dialog box opens. The 
Main, Page Layout, Stamp/Background, and Maintenance tabs are 
displayed in the Printer Properties dialog box.

3
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Getting to Know the Windows 98/95 Printer Driver

From the Start menu

When you wish to specify print settings that are common to all application programs, open 
the Printer Properties dialog box from the Start menu.

This method is also helpful when you wish to use maintenance functions such as print head 
cleaning without starting up an application program.

Click the Start button. Point to Settings, then click Printers.

When the Printers window is displayed, click the Canon S450 icon.

1

2
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Getting to Know the Windows 98/95 Printer Driver

Select Properties from the File menu. Or, right-click and select Properties 
from the pop-up menu. The Properties dialog box opens. The Main, Page 
Layout, Stamp/Background, and Maintenance tabs are contained in the 
Printer Properties dialog box.

When you open the Printer Properties dialog box from the Start menu, 
some other tabs (such as General and Details) are added by the Windows 
operating system. For more details on these additional tabs, refer to your 
Windows documentation.

3

Note
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�  Selecting the Print Mode
Before you start a print job, open the Printer Properties dialog box and specify the print 
mode. The print settings in the Printer Properties dialog box allow fine control over the print 
quality and color adjustment, but you can simplify the setup procedure by selecting the icon 
in which the most appropriate print settings are pre-assigned.

Default settings

The following print modes are set up as defaults in the printer driver. When you select an 
icon in the Choose Print Mode box, the combination of BJ Cartridge and Media Type 
settings changes automatically. Select the most appropriate icon according to your print job.

Icon Purpose BJ Cartridge Media Type

For printing documents that consist mostly of text 
(such as word processor files) at the standard print 
quality.

Black/Color Plain Paper

Gives priority to print speed rather than print quality. 
Use this print mode for trial printing.

Black/Color Plain Paper

Automatically recognizes photographs and graphics 
and prints using the optimum print settings. This print 
mode is the best choice when you print data that 
contains different elements such as text, tables, 
graphs, and photographs in the same document.

Black/Color Plain Paper

Produces high print quality for printing photographs 
and other graphics with fine gradations of tone.

Black/Color High Resolution 
Paper

Produces the best possible print quality for printing 
photographs. This print mode is also suitable for 
printing graphics with fine gradations of tone.

Photo/Color Glossy Photo 
Paper
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• In addition to the BJ Cartridge and Media Type settings, other print
settings are also pre-assigned to each icon in the Choose Print Mode
box. To confirm all default settings, click the Advanced button
after selecting the icon. The settings on the Quality, Special Effects, and
Color tabs are the properties of the print mode.

• You can modify the default print mode settings, as necessary.

 Creating an original print mode

Selecting the print mode

After you select the icon, match the BJ Cartridge and Media Type settings with the 
BJ cartridges and print media installed in the printer.

Open the Printer Properties dialog box, then click the Main tab.

Select the desired icon according to your print job in the Choose Print 
Mode box.

Note

1

2
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Make sure that the BJ Cartridge and Media Type settings are identical to 
the BJ cartridge and print media installed in the printer.

When you change a default setting in the BJ Cartridge or Media Type box, 
the icon that indicates the current settings changes to User-modified.

3

Note

Current settings
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You can start a print job with the User-modified icon, but you can also save and register the 
settings in the Choose Print Mode box under a new icon.

 Customizing the Print Settings in the Printer Driver
   (Creating an original print mode)

�  Setting the Page Size
Set the page size you use from within the application program before printing.

Also make sure that the page size setting in the Printer Properties dialog box is identical to 
the page size setting in the application program.

Confirming the page size

You can view the page size you use in the print settings information box of the Main tab. 
Make sure that Page Size is identical to the setting in the application program before 
printing.

Print settings information box



107Using the Windows 98/95 Printer Driver

Getting to Know the Windows 98/95 Printer Driver

Changing the page size (for regular paper sizes)

Click the Page Layout tab.

Click the down-arrow in the Page Size box, then select the appropriate 
page size from the pull-down list.

1

2
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Changing the page size (for custom paper sizes)

Click the Page Layout tab.

Click the down-arrow in the Page Size box, then select Custom Size from 
the pull-down list. 

The Custom Paper Size dialog box is displayed.

1

2
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Select inch or mm (millimeter) for the unit of measurement in the Unit box, 
and enter the desired width and height within the following ranges:

Width: 3.94" to 9.50" (100.0 mm to 241.3 mm)

Height: 3.94" to 23.0" (100.0 mm to 584.2 mm)

Click the OK button.

3
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�  Using Online Help
When you want to learn about a particular topic, the online help function provides the 
necessary information on the screen of your computer.

Finding information on a particular topic

When you click the “?” button on the upper right corner of the Printer 
Properties dialog box, the shape of the mouse pointer changes to “ ”.

Click the desired item to learn more about the item. A detailed explanation 
appears.

1

2
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Finding information on an operation procedure

Click the Help button on the lower right corner of the Printer Properties 
dialog box.

When the contents of the Canon BJ Printer Driver Help are displayed, 
select the desired item to learn more about that item.

1

2
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�  Closing the Printer Properties Dialog Box
After specifying the necessary print settings, close the Printer Properties dialog box and 
start your print job.

Make sure that the information on Direction, Feed, and Paper Thickness 
Lever in the illustrated guideline is correct.

Click the OK button. The print settings become enabled and the Printer 
Properties dialog box closes.

• When you want to enable the print settings without closing the Printer
Properties dialog box, click the Apply button.

• When you do not want to enable the print settings, click the Cancel
button.

• When you want to revert the print settings to the factory settings, click 
the Defaults button in each tab.

1

2

Note
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Printing Documents Enlarged/Reduced (Scaled Printing)

Printing Multiple Pages on One Sheet (Page Layout Printing)

Printing Documents Enlarged (Poster Printing)

Printing on Banner Paper

Changing the Print Order/Number of Copies

Printing a Stamp

Printing a Background

Optimizing Image Data

Photo Optimizer

Using Special Effects

Changing the Print Quality (Halftoning)

Adjusting Image Data

Customizing the Print Settings in the Printer Driver

Using Background Printing

Using the BJ Status Monitor

Using the BJ Printer Monitor
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�  Printing Documents Enlarged/Reduced (Scaled Printing)
The Scaled Printing feature of the printer driver allows you to set a scaling value to print 
an enlarged or reduced page on a paper size that is larger or smaller than the paper size of 
the original file in the application program.

There are two different ways to use Scaled Printing.

Setting the scaling value

This method is helpful when you know the enlargement or reduction ratio before printing.

Open the Printer Properties dialog box and click the Page Layout tab.

Click Scaled Printing. The Scaling and Printer Paper Size settings are 
enabled.

1

2
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Set the desired enlargement or reduction ratio in the Scaling box.

To change the value of the enlargement or reduction ratio, click the up- or 
down-arrow to the right of the Scaling box. (You can also enter the desired 
value directly.)

Confirm the layout of the printout in the preview area and click the OK 
button.

When you wish to revert Scaled Printing to the original value (100%), click 
Normal-size Printing.

Setting a printer paper size different from the original page size

Open the Printer Properties dialog box and click the Page Layout tab.

Click Scaled Printing. The Scaling and Printer Paper Size settings are 
enabled.

3

4
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Click the down-arrow to the right of the Printer Paper Size box and select 
the desired paper size. When you select a paper size in the Printer Paper 
Size box which is different from the paper size originally set in the Page 
Size box, the enlargement or reduction ratio is calculated automatically and 
is displayed in the Scaling box. (If you need to make a fine adjustment, 
change the value in the Scaling box.)

Confirm the layout of the printout in the preview area and click the OK 
button.

When you wish to revert to the original value (100%), click Normal-size 
Printing.

3

Scaling box

4

Note
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�  Printing Multiple Pages on One Sheet (Page Layout Printing)
By reducing the scale in a 2-Page Print or 4-Page Print layout, you can print multiple pages 
on one sheet. You can save the total amount of paper used for long documents. This feature 
is also useful when you wish to view an image spread or print your document as a book 
cover.

Specifying the layout

Open the Printer Properties dialog box and click the Page Layout tab.

Click Page Layout Printing. The Specify button is displayed and the 
preview area display changes.

1

2
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Click the Specify button, as necessary. You can specify the detailed layout 
setting in the Page Layout Printing dialog box.

Confirm the layout of the printout in the preview area and click the OK 
button.

• When you use Page Layout Printing, check that Background Printing 
is enabled in the Page Layout tab.

• When you wish to revert Page Layout Printing to the original setting,
click Normal-size Printing.

Pages: Click the down-arrow and select the 2-Page Print or 
4-Page Print layout. The 2-Page Print setting prints two 
pages on one sheet of paper and the 4-Page Print 
setting prints four pages on one sheet of paper.

Page Order: Click the icon in the Page Order box. The icon indicates 
the order in which the pages run (for example, running 
from top-left to top-right to bottom-left to bottom-right in 
the 4-Page Print setting).

Frame Border: Check the Frame Border checkbox when you wish to 
print with a frame around each page.

3
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Note
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�  Printing Documents Enlarged (Poster Printing)
By dividing image data (such as a photographic image) and enlarging it for printing, you can 
print one page on multiple sheets. Pasting the pages after printing makes it possible to 
create a large-sized document such as an artistic poster.

Setting the image divisions

Open the Printer Properties dialog box and click the Page Layout tab.

Click the button for Poster Printing. The Specify button is displayed and 
the preview area displays the changes.

1
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Click the Specify button, as necessary. You can specify a detailed image 
division setting in the Poster Printing dialog box.

Image divisions:
Specifies the number of divisions you want to make on the image.

2 × 2:  The number of printouts totals 4.
3 × 3:  The number of printouts totals 9.
4 × 4:  The number of printouts totals 16.

Print Cut/Paste in margins:
When Print Cut/Paste in margins is enabled, the printer prints “cut” and 
“paste” characters. Use these characters as a guideline when you cut and 
paste each page after printing.

Print Cut/Paste lines in margins:
When Print Cut/Paste lines in margins is enabled, the printer prints lines for 
cutting along. Use these lines as a guideline when you cut and paste each 
page after printing.

3
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Confirm the layout of the printout in the preview area and click the OK 
button.

• When you use Poster Printing, check that Background Printing is
enabled in the Page Layout tab.

• When you wish to revert Poster Printing to the original setting, click
Normal-size Printing.

• You can divide the image divisions between printed pages and unprinted
pages.

When you do not wish to print the page, click the image division in the
preview area. (The image division disappears and the page is not
printed.)

When you wish to restore the image division, click the image division in
the preview area again. (The image division reappears and the page is
printed.)

• You can select the printed or unprinted pages at one time. Right-click 
the mouse in the preview area and select Print all pages or Delete 
all pages.

4

Note
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�  Printing on Banner Paper
This section describes the print settings for printing on banner paper. For details on how to 
load banner paper in the printer, refer to the Paper Handling section.

 Banner Paper

Setting banner printing

Open the Printer Properties dialog box and choose the desired icon in the 
Choose Print Mode box of the Main tab. Also make sure that Plain Paper is 
set in the Media Type box.

Click the Page Layout tab.

Click the button for Banner Printing. A confirmation message appears.

• If you click the Help button, detailed instructions on banner printing are 
given.

• If you wish to skip over the detailed instructions on banner printing, click 
the OK button.

Confirm the preview area and click the OK button.

When you wish to revert Banner Printing to the original setting, click 
Normal-size Printing.

1
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�  Changing the Print Order/Number of Copies
Based on the default settings of the printer driver, the printer starts printing one set of any 
document from the first page. When you print multiple copies of the same document, you 
need to specify the number of copies. You can change the print order with Reverse and 
Collate, as needed.

Setting the print order and number of copies

When you wish to print multiple copies of the same document, specify the number of 
copies.

You can also change the print order with Reverse and Collate. 

Open the Printer Properties dialog box, then click the Page Layout tab.

When you print multiple copies of the same document, set the number of 
copies between 1 and 999 in the Copies box.

Reverse order:
Use this setting when you print a multiple page document. The printer 
starts printing from the last page of the document. (When this setting is 
disabled, the printer starts printing from the first page of the document.)

1
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Collate:
Use this setting when you print multiple copies of a multiple page 
document.

When Collate is enabled, the printer prints the document and collates each 
copy from the first page to the last page.

When Collate is disabled, the printer prints the document and collates 
copies of the same page.

Select the print order.

Click the OK button to close the Printer Properties dialog box.

• Before setting the print order and number of copies, make sure that
Background Printing is enabled in the Page Layout tab. (If it is disabled,
you cannot change the print order and number of copies.)

• When Banner Printing is selected in the Page Layout tab, you cannot
change the print order or the number of copies.

• When Poster Printing is selected in the Page Layout tab, Reverse order
is grayed out and cannot be used.

3

4

Note
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�  

 

Printing a Stamp

 

The printer driver allows you to print a stamp on your documents. Stamps are notations 
such as CONFIDENTIAL or IMPORTANT, which are frequently rubber-stamped on 
documents to alert readers. Several default stamps are available for immediate use.

 

Printing a default stamp

 

Open the Printer Properties dialog box, then click the Stamp/Background 
tab.

Click the down-arrow and select the desired stamp item from the 
pull-down list. (The stamp you select is displayed in the preview area at this 
time.)

1
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Specify whether to print the stamp on the first page only or on each page of 
the document.

 

Place stamp over text:

 

Click this checkbox to print the stamp 
over the document data. If you leave 
the box unchecked, the document 
data are printed on top of the stamp.

 

Stamp first page only:

 

Click this checkbox to print the stamp 
on the first page only. If you leave 
the box unchecked, the stamp is 
printed on each page. 

Click the 

 

OK

 

 button to close the Printer Properties dialog box and start the 
print job.

• When Background Printing is disabled or Banner Printing is enabled in
the Page Layout tab, the stamp items are grayed out and cannot be
used.

• To cancel stamp printing, select None from the Stamp pull-down list.

• When you wish to change settings such as size, color, or position of the
stamp, click the 

 

Define Stamp 

 

button.

 

  Customizing the Print Settings in the Printer Driver 

 

(Creating an original stamp)

3
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Note
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�  Printing a Background
The printer driver allows you to print a background on your documents, like a watermark. 
Two types of default backgrounds are available for immediate use.

Printing a default background

Open the Printer Properties dialog box, then click the Stamp/Background 
tab.

Click the down-arrow and select the desired background item from the 
pull-down list. (The background you select is displayed in the preview area 
at this time.)

1
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Specify whether to print the background on the first page of the document 
only, as necessary.

Background first page only:
Click this checkbox to print the background on the first page only.

If you leave this box unchecked, the background is printed on each page.

Click the OK button to close the Printer Properties dialog box and start the 
print job.

• When Background Printing is disabled or Banner Printing is enabled in
the Page Layout tab, the background items are grayed out and cannot 
be used.

• When you wish to revert to the normal print setting without any
background, select None from the pull-down list.

• When you wish to change settings such as the layout or position of the
background, click the Select Background button.

• You can also use a bitmap file as a background.

 Customizing the Print Settings in the Printer Driver
 (Creating an original background)

3
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Note
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�  Optimizing Image Data
The printer driver allows you to compensate and optimize the print quality of image data. 
Depending on the type of image data you print, you can use either Image Optimizer or 
Photo Optimizer.

Image Optimizer

Enlarging an image often causes edges to look jagged. To solve this problem, after 
enlarging an image in your application program, turn on the Image Optimizer before 
printing. For example, you may want to use the Image Optimizer when you print a 
low-resolution image downloaded from a home page on the Internet.

Open the Printer Properties dialog box, then click the Main tab.

Click the Advanced button.

1
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Select Image Optimizer in the Quality tab to enable the Image Optimizer 
setting.

Click the OK button to return to the Main tab. 

Click the OK button to close the Printer Properties dialog box and start the 
print job.

• The Image Optimizer setting may have little or no effect on printing,
depending on the application program you use.

• The Image Optimizer setting has more effect on low-resolution images
than on high-resolution images.

• Using the Image Optimizer setting to smooth an image may require 
more time for printing.

3
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�  Photo Optimizer
The Photo Optimizer adjusts a photographic image created with a digital camera when it is 
printed out. Use the Photo Optimizer to compensate unsatisfactory color balance and over- 
or underexposure before printing.

Open the Printer Properties dialog box, then click the Main tab.

Click the Advanced button.

Select Photo Optimizer in the Quality tab to enable the Photo Optimizer 
setting.

1
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Check the Whole Page checkbox, if necessary. 

Disabled: 
When the Whole Page setting is disabled, the Photo Optimizer adjusts 
multiple photographic images appearing on the same page separately.

Enabled: 
When the Whole Page setting is enabled, the Photo Optimizer adjusts 
multiple graphic images appearing on the same page as a whole. Use this 
setting when any trimmed or rotated images are contained in the page.

Click the OK button to return to the Main tab. 

Click the OK button to close the Printer Properties dialog box and start the 
print job.

• Using the Photo Optimizer setting to adjust an image may require more
time for printing.

• When Background Printing is disabled in the Page Layout tab, the 
Whole Page setting is grayed out and cannot be used.

• When Banner Printing is enabled in the Page Layout tab, the Whole
Page setting can be turned on but does not function.

4
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�  Using Special Effects
The printer driver not only performs simple color adjustments to improve the quality of the 
original image, but also enhances images for artistic effect.

Setting Simulate Illustration

Use this artistic effect to simplify complex image data so that a photograph appears to be 
an illustration.

Open the Printer Properties dialog box, then click the Main tab.

Click the Advanced button.

Click the Special Effects tab.

1
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Check the Simulate Illustration checkbox to enable the setting. The 
appearance of the image data in the preview area changes (as if the 
photograph is converted to an illustration) at this time.

If necessary, drag the slide bar to increase or decrease the contrast.

Click the OK button to return to the Main tab.

Click the OK button to close the Printer Properties dialog box and start the 
print job.

• The Simulate Illustration setting can be used with the Monochrome
Effects setting (see below).

• When Background Printing is disabled in the Page Layout tab, the
Simulate Illustration setting is grayed out and cannot be used.

• When Black is selected in the Main tab, the Simulate Illustration 
setting is grayed out and cannot be used.

Setting Monochrome Effects

Use this setting when you want to give expression to an image by using a monochrome 
effect.

Open the Printer Properties dialog box, then click the Main tab.

Disable Grayscale Print by unchecking the Grayscale Print checkbox.

4
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Click the Advanced button.

Click the Special Effects tab.

Check the Monochrome Effects checkbox to enable the setting. The 
appearance of the image in the preview area changes to a monochrome 
image.

Select the desired monochrome effect from Sepia, Blue, Pink, Green or 
Select Color.

When you select Select Color, drag the color slide bar until the desired 
monochrome image is displayed in the preview area. (You can also select 
the desired monochrome image by clicking the right or left arrow of the 
color slide bar.)

3
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Click the OK button to return to the Main tab.

Click the OK button to close the Printer Properties dialog box and start the 
print job.

• The Monochrome Effects setting can be used with the Simulate
Illustration setting.

 Setting Simulate Illustration

• When Background Printing is disabled in the Page Layout tab, the
Monochrome Effects setting is grayed out and cannot be used.

• When Grayscale Print is enabled in the Main tab, the Monochrome
Effects setting is grayed out and cannot be used.

8
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�  Changing the Print Quality (Halftoning)
When your printouts are not satisfactory, the printer driver allows you to make fine 
adjustments to the print quality and halftoning settings.

Setting the print quality/halftoning

If there is a problem in the image data you wish to print, the print quality 
and halftoning settings may not be visible or effective.

Open the Printer Properties dialog box, then click the Advanced button in 
the Main tab.

Click the Quality tab and set Print Quality and Halftoning, as needed.

Note
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Print Quality:
When you wish to improve the print quality, drag the Print Quality slide bar 
to the right (Fine). The print mode changes according to the setting of the 
slide bar. Please note that using a higher setting in the direction of Fine 
requires more time for printing.

Halftoning:
The colors and shapes of printouts are reproduced by the ink dots ejected 
from the nozzles of the print head. Halftoning determines the color 
boundaries of intermediate tones.

Fine (Fast):
Uses a simplified halftoning method for high speed printing.

Fine:
Lines up ink dots of different colors under the rules specified in the printer 
driver. Use this setting for printing graphics or charts with clearly defined 
color boundaries.

Diffusion:
Randomly places ink dots of different colors. Use this setting for printing 
natural color images such as photographs.

Auto:
The printer driver automatically distinguishes among the types of image 
data, and switches to the most appropriate halftoning method.
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Click the OK button to return to the Main tab.

Click the OK button to close the Printer Properties dialog box.

• Depending on the Halftoning settings, some of the Print Quality settings
cannot be used. When you wish to print at the highest quality, set
Halftoning to Diffusion.

• Depending on the BJ Cartridge and Media Type settings in the Main tab, 
some of the Print Quality and Halftoning settings cannot be used.

�  Adjusting Image Data
When the color reproduction of your printouts is unsatisfactory, you can adjust the color 
balance and intensity as needed. Use this feature only when you wish to make fine 
adjustments to the color balance in the printouts, and do not change the settings 
excessively. (Please note that this feature does not compensate the overall color balance of 
the image data as some application programs for editing image data would do.)

Adjusting the colors

Before adjusting the color balance and intensity, make sure that Color Adjustment is 
enabled in the Colors tab under the Main tab.

Open the Printer Properties dialog box, then click the Advanced button in 
the Main tab.

3
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Click the Color tab and make sure that the Color Adjustment setting is 
enabled.

Set the following items as needed.

Color Balance:
Move the slide bars of the individual colors. For example, when blues are 
too strong in the printouts, drag the slide bar for Cyan to the left.

Output Style:
Specifies whether printouts should emphasize intermediate tones or 
produce bright and sharp colors. When you select Auto, the printer driver 
automatically distinguishes among the types of image data, and switches to 
the most appropriate matching method.

2
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Brightness:
Specifies the contrast among intermediate tones between black and white. 
Adjusting the brightness toward Light makes the overall image brighter, 
with stronger contrast in the light areas and lower contrast in the dark 
areas.

Click the OK button to return to the Main tab.

Click the OK button to close the Printer Properties dialog box.

Depending on the application program you use, you can also use the ICM 
(Image Color Management) feature of the Windows 98 operating system. 
For more details, refer to the online Help for Windows or your Windows 
documentation.

4
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Adjusting the intensity

The Intensity Setting specifies whether to make the overall printout darker or lighter.

Open the Printer Properties dialog box, then click the Advanced button in 
the Main tab.

Click on the Color tab.

Move the Intensity slide bar to the left (lighter) or right (darker).

Click the OK button to return to the Main tab.

Click the OK button to close the Printer Properties dialog box.

1
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�  Customizing the Print Settings in the Printer Driver
Changing the default properties of the Print Mode, Stamp, and Background settings makes 
it possible to use them as customized settings in the printer driver.

You can also register your original stamp and background in the printer driver.

Creating and deleting an original print mode

You can create an original print mode by changing the default properties of the Print Mode 
settings as desired. It is also possible to save your original print mode as a file and delete it 
when it is unnecessary.

Creating an original print mode

Open the Printer Properties dialog box, then select the most appropriate 
icon for printing your document from the Choose Print Mode box in the 
Main tab.

Click the Advanced button. This displays all the properties of the print 
mode you selected in step 1.

When you need detailed descriptions of the print settings on any tab, click 
the ? button and then move the ? symbol to the item you want to learn more 
about in order to display the online Help of the printer driver.

1

2

Note
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Change the print settings in the Quality tab, if necessary.
 

Change the print settings in the Special Effects tab, if necessary.

3

4
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Change the print settings in the Color tab, if necessary.

Click the Save tab. You can save the desired print settings you made in 
steps 3, 4, and 5 here.

5

6
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To save the new print settings, enter a name for the desired print settings in 
the Title box of the Save tab. You can use up to eight characters. Please 
note that you cannot use a title that is pre-assigned in the printer driver 
(such as Draft or Standard).

Select the desired icon from the Icon Selection box.

Write a brief description in the Description box, if necessary.

Click the Save button. The icon you selected in step 8 appears in the Saved 
Settings box at this time.

Click the OK button to return to the Main tab. Make sure that the icon you 
selected in step 8 for the new print settings is in the Choose Print Mode 
box, and that the description you wrote in step 9 appears when you move 
the mouse pointer to the icon.

7

8

9

10

11
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• When User-modified is displayed to the left of the Choose Print Mode
box of the Main tab, you can save the new print settings using the
following procedure.

(1) Right-click the User-modified icon, then select Save As from the
pull-down menu.

(2) To save the new print settings, enter a name for the desired print
settings in the Title box of the Save tab. You can use up to eight
characters.

(3) Select the desired icon from the Icon Selection box.

(4) Write a brief description in the Description box, if necessary.

(5) Click the Save button.

• You cannot use a title that is pre-assigned in the printer driver (such as,
Draft or Standard).

Changing the position of a print mode icon

Open the Printer Properties dialog box, then click the Advanced button in 
the Main tab.

Click the Save tab.

Select the icon you wish to change the position of in the Saved Settings 
box.

Each time you click the arrow  to the right of the Saved Settings box, 
the icon moves in the direction of the arrow. (To move the icon, you can also 
drag the icon directly to the desired position.)

Note

1

2

3

4
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Click the OK button to return to the Main tab.

You cannot move the icon back to its original position by clicking the 
Cancel button.

Saving an original print mode as a file

Open the Printer Properties dialog box, then click the Advanced button on 
the Main tab.

Click the Save tab.

Select the icon you wish to save as a file in the Saved Settings box.

Click the Save As button. This displays the Save File dialog box.

Enter a file name in the File Name box.

Select the drive name and folder name in the Directory box.

Click the OK button. The print mode is saved as a file.

5

Note

1

2

3

4

5

6

7
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You can save multiple print modes to a single file.

Opening an original print mode that was saved as a file

Open the Printer Properties dialog box, then click the Advanced button.

Click the Save tab.

Click the Open button. This displays the Open File dialog box.

Select the drive name and folder name in the Directory box.

Select the file in which the original print mode was saved in the File Name 
box.

Select the icon you wish to open in the Icon Selection box.

Click the OK button. The original print mode you opened in the printer 
driver is displayed in the Saved Settings box.

Deleting an unnecessary print mode

Open the Printer Properties dialog box, then click the Advanced button on 
the Main tab.

Click the Save tab.

Select the icon you wish to delete in the Saved Settings box.

Note

1

2

3

4

5

6

7

1

2

3
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Click the Delete button.

When a confirmation message appears, click the OK button. The icon of 
the original print mode is deleted from the Saved Settings box in the Save 
tab.

Click the OK button to return to the Main tab. (The icon of the original print 
mode is also deleted from the Choose Print Mode box in the Main tab.)

• You cannot delete default print modes such as Standard.

• You can delete the unnecessary print mode directly in the Choose Print
Mode box of the Main tab.

(1) Right-click the icon of the original print mode you wish to delete in the
Choose Print Mode box of the Main tab.

(2) When a confirmation message appears, click the OK button.

Creating and deleting an original stamp

You can create an original stamp by changing the default properties of the Stamp settings 
as desired. You can also register your original stamp in the printer driver.

Creating an original stamp

Open the Printer Properties dialog box, then click the Stamp/Background 
tab.

4

5

6

Note

1
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When you wish to change the settings of a default stamp item, click the 
Stamp box and then select the item you wish to change from the 
pull-down menu. When you wish to create an original stamp, select None in 
the Stamp box.

Click the Define Stamp button. The Stamp Settings Properties dialog box 
is displayed.

When you need detailed descriptions of the settings on any tab, click the ? 
button and then move the ? symbol to the item you want to learn more 
about in order to display the online Help of the printer driver.

Specify original settings related to text in the Text tab.
 

2

3

Note

4
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Specify original settings related to colors in the Color tab.

Specify original settings related to the stamp position in the Placement tab. 

5

6
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Click the Save settings tab.

Enter a name for the original stamp in the Title box of the Save settings tab.

Click the Save button.

When a confirmation message appears, click the OK button.

Click the OK button in the Save settings tab to return to the Stamp/
Background tab.

Deleting an unnecessary stamp

Open the Printer Properties dialog box, then click the Stamp/Background 
tab.

Click the Define Stamp button. The Stamp Settings Properties dialog box 
is displayed.

7

8

9

10

11

1

2
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Click the Save settings tab.

Select the stamp you wish to delete from the Title box.

Click the Delete button.

When a confirmation message appears, click the OK button.

Click the OK button in the Save settings tab to return to the Stamp/
Background tab.

You cannot delete default stamp items such as IMPORTANT and 
CONFIDENTIAL.

Creating and deleting an original background

You can create an original background by changing the default properties of the 
Background settings as desired. You can also register your original background (bitmap file 
only) in the printer driver.

Creating an original background

Open the Printer Properties dialog box, then click the Stamp/Background 
tab.

When you wish to change the settings of a default background item, click 
the Background box and then select the item you wish to change from the 
pull-down menu. When you wish to create an original background, select 
None in the Background box.

3

4

5

6

7

Note

1
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Click the Select Background button. The Background Settings Properties 
dialog box is displayed.

Click the Select File button. The Select image file dialog box is displayed.

Select the name of the drive in which the bitmap file you wish to use as an 
original background is saved.

3

4

5
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Select the name of the folder in which the bitmap file you wish to use as an 
original background is saved.

Select the file name of the bitmap file you wish to use as an original 
background.

Click the OK button. The file name you specified in step 7 is displayed in the 
File box of the Background tab.

Specify the other settings in the Background tab, if necessary. 

Click the Save settings tab.

Enter a name for the original background in the Title box of the Save 
settings tab.

6

7

8

9

10

11
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Click the Save button.

When a confirmation message appears, click the OK button.

Click the OK button in the Save settings tab to return to the Stamp/
Background tab.

Make sure that the file size of the bitmap file you can use as an original 
background is smaller than 15 MB. A bitmap file that is larger than 15 MB 
cannot be used as the background.

Deleting an unnecessary background

Open the Printer Properties dialog box, then click the Stamp/Background 
tab.

Click the Select Background button. The Background Settings Properties 
dialog box is displayed.

Click the Save settings tab.

Select the background you wish to delete from the Title box.

Click the Delete button.

When a confirmation message appears, click the OK button.

Click the OK button in the Save settings tab to return to the Stamp/
Background tab.

12

13

14

Note
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�  Using Background Printing
The print processing method that enables you to do other tasks simultaneously while 
printing documents is called background printing.

Normally, the Canon BJ Printer Driver performs background printing. The BJ Background 
Monitor and BJ Backgrounder allow you to confirm the progress of printing that is being 
performed in the background.

About background printing

You can see the Background Printing checkbox in the Page Layout tab of the Printer 
Properties dialog box. When background printing is enabled, the BJ Background Monitor 
and BJ Backgrounder are launched before the printer starts the print job. You can verify 
information on the print process.

When background printing is disabled in the Page Layout tab, the following 
settings cannot be used because background printing is applied to them.

Page Layout tab:
Page Layout Printing, Poster Printing, Copies, Printer control, Reverse 
order and Collate

Stamp/Background tab:
All stamp and background settings

Quality tab (opens from the Advanced button in the Main tab):
Photo Optimizer

Special Effects tab (opens from the Advanced button in the 
Main tab):
All Simulate Illustration and Monochrome Effects settings

Note
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BJ Background Monitor

When a print command is sent to the printer, the BJ Background Monitor is launched 
automatically and is minimized on the Windows taskbar.

To verify the print process, click the BJ Background Monitor icon minimized on the Windows 
Taskbar. The following items are displayed.

Application/Print Document:
Shows the file names of documents that are queued or currently being 
printed. (Depending on the application program you use, the name of the 
application program is also displayed.) The icon on the left of the file name 
indicates the document which is currently being printed.

Page(s) [Size]:
Shows the file size of the documents in pages and bytes.

Time/Date:
Shows the time and date when the print job started.
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The BJ Background Monitor makes it possible to perform the following tasks:

• You can change the order of the documents you print.
Drag the document you wish to change the priority of to the desired position. 
Please note that you cannot change the priority of the document which is being 
printed.

• You can cancel a print job.
Click the document you wish to stop printing, then select Delete from the Edit 
menu. When a confirmation message appears, click the OK button.

• You can quit the BJ Background Monitor.
Select Quit from the File menu.

• You can give priority to background printing.
Select Priority from the Option menu and drag the slide bar.
As you drag the slide bar to the left, another job you are working on using an 
application program is given priority over the background printing in order to 
make the processing for the application program faster.

• You can change the temporary directory for saving print data.
To perform background printing, a region which is used to save the print data 
temporarily is required on the hard disk. (If sufficient hard disk space is not 
available, background printing cannot be performed.) To solve this problem, you 
need to change the directory that saves the print data temporarily, as described 
on the next page.
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Select Directory from the Option menu.

Select the drive and directory.

Click the OK button.

• When you wish to open the BJ Background Monitor while the printer is
not printing, follow these steps:

(1) From the Start menu, select Programs.

(2) Point to BJ Printer, and then select BJ Background Monitor.

 or

(1) Double-click the BJ Printer icon on the Windows desktop.

(2) Double-click the BJ Background Monitor in the BJ Printer window.

• For more details on the BJ Background Monitor, refer to the online 
Help for the BJ Background Monitor.

1

2

3

Note
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BJ Backgrounder

When Background Printing is enabled in the Page Layout of the Printer Properties dialog 
box, the BJ Backgrounder is displayed in the lower right corner of the screen.

The BJ Backgrounder makes it possible to perform the following tasks:

• You can cancel a print job.
When you wish to cancel printing in mid-job, click the Cancel button. When a 
confirmation message appears, click the OK button.

• You can stop the print process of the printer driver temporarily.
When you wish to stop the print process of the printer driver temporarily for some 
reason, click the Pause button.
While the print job is paused, the Pause button changes to the Resume button. 
Click the Resume button to start printing again.
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�  Using the BJ Status Monitor
The BJ Status Monitor (which is found in the Maintenance tab) is a utility program that 
allows you to check the status of the printer. If an error occurs for some reason, the 
BJ Status Monitor displays the cause of the error and a solution.

In addition, the BJ Status Monitor detects the remaining ink of the BJ cartridge and displays 
a warning message when the ink is low.

About the operating environment

The following are the minimum requirements to run the BJ Status monitor.

When using the parallel interface only:

• Check that your computer supports bi-directional communications.
• Check that your printer cable (interface cable) supports bi-directional 

communications.

When using the parallel or USB interface:

• Check that the settings to support bi-directional communications are enabled in 
the Windows operating system.
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To check that the settings to support bi-directional communications are 
enabled in Windows, follow these steps:

(1) Open the Printer Properties dialog box from the Start menu.

(2) Click the Canon S450 icon in the Printers window, then select
Properties from the File menu.

(3) Click the Details tab.

(4) Click the Spool Settings button.

(5) Check that the “Enable bi-directional support for this printer” is enabled
in the Spool Settings dialog box.

Launching the BJ Status Monitor

When a print command is sent to the printer or low ink is detected, the BJ Status Monitor is 
launched automatically and is minimized on the Windows taskbar.

Note



 

165Using the Windows 98/95 Printer Driver

Making the Most of the Windows 98/95 Printer Driver

 

To verify the print process and the type of BJ cartridge, click the BJ Status Monitor icon 
minimized on the Windows taskbar. The following items are displayed.

 

Printer Name:

 

Shows the name of the printer you are using.

 

Document Name:

 

Shows the file name of the document that is currently being printed. 
(Depending on the application program you use, the name of the 
application program is also displayed.)

 

Status:

 

Shows the printer status and print job progress using graphics and 
messages.
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Start Time:
Shows the time and date when the print job started.

Progress:
When “Spool print jobs so program finishes printing faster” is enabled and 
the “Spool data format” is set to RAW in the Spool Settings dialog box 
under the Details tab, the print job progress is indicated by the percentage 
and gauge shown here.

Pages Printed:
Shows the number of printed pages.

Cancel Printing:
Click this button when you wish to cancel the print job (before data transfer 
is completed).

Cartridges:
Shows the BJ cartridges currently installed in the printer.

Left cartridge holder:
—Black BJ Cartridge

—Photo BJ Cartridge

—Scanner Cartridge

Right cartridge holder:

—Color BJ Cartridge

Low Ink:
Shows the remaining ink warning icon when the ink is low.

 Error and warning display
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• When you wish to open the BJ Status Monitor while the printer is not
printing, follow these steps:

(1) Open the Printer Properties dialog box.

(2) Click the Maintenance tab.

(3) Click the Start Status Monitor button.

• You can select the way of launching the BJ Status Monitor. For more
details, refer to the online Help for the BJ Status Monitor.

• When nothing is displayed in Progress, follow these steps:

(1) Open the Printer Properties dialog box from the Start menu.

(2) Click the Details tab.

(3) Click the Spool Settings button.

(4) Check that “Spool print jobs so program finishes printing faster” is
enabled in the Spool Settings dialog box.

(5) Check that RAW is displayed in the Spool data format box.

• To close the BJ Status Monitor, click the X button on the upper right
corner of the BJ Status Monitor window. When the BJ Status Monitor is
minimized on the Windows Taskbar, right-click the BJ Status Monitor
icon on the Taskbar and then select Close.

Note
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Error and warning display

If an error occurs, the BJ Status Monitor launches automatically. Check the meaning of the 
error in the Status box of the Printer Status tab first. Then click the Guide tab and refer to 
the information on the solution.

When the remaining ink is running low, the BJ Status Monitor displays a low ink warning 
icon in the Printer Status tab.

—Black is running low.

—Cyan is running low.

—Magenta is running low.

—Yellow is running low.
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When the ink runs out, the  low ink warning icon is replaced with the  ink empty icon. 
For more details, click the Ink Information tab.

Even after the ink runs out, the printer continues to print for a while. 
However, it is recommended that you install a new ink tank.

 Replacing the Ink Tanks

Note
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Cancelling the print job

You can cancel the print job using the BJ Status Monitor. To cancel the print job, open the 
BJ Status Monitor and then click the Cancel Printing button in the Printer Status tab.

Switching the BJ Status Monitor

When you are using multiple Bubble Jet printers and launching the BJ Status Monitor of 
each printer as well, select the port to which the printer you wish to display is connected 
from the Port menu.

The BJ Printer Monitor displays all Bubble Jet printers installed in your 
system. To launch the BJ Status Monitor of a specific printer, double-click 
the printer name in the BJ Printers tab.

 Using the BJ Printer Monitor

Note
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�  Using the BJ Printer Monitor
The BJ Printer Monitor displays all Bubble Jet printers installed in your system. You can 
view information such as the printer status, printer port to which the printer is connected, 
and installed BJ cartridges.

You can also launch the BJ Printer Monitor for a desired printer.

About the operating environment

The following are the minimum requirements to run the BJ Printer monitor.

When using the parallel interface only:

• Check that your computer supports bi-directional communications.
• Check that your printer cable (interface cable) supports bi-directional 

communications.

When using the parallel or USB interface:

• Check that the settings to support bi-directional communications are enabled in 
the Windows operating system.
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To check that the settings to support bi-directional communications are 
enabled in Windows, follow these steps:

(1) Open the Printer Properties dialog box from the Start menu.

(2) Click the Canon S450 icon in the Printers window, then select
Properties from the File menu.

(3) Click the Details tab.

(4) Click the Spool Settings button.

(5) Check that “Enable bi-directional support for this printer” is enabled in
the Spool Settings dialog box.

Launching the BJ Printer Monitor

From the Start menu, select Programs.

Point to BJ Printer, and then select BJ Printer Monitor.

 or

Double-click the BJ Printer icon on the Windows desktop.

Double-click the BJ Printer Monitor in the BJ Printer window.

Note

1

2

1

2
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Information display of the BJ Printer Monitor

Printer Name:
Shows the name of the printer installed in your system. The icon to the left 
of the printer name shows the printer status.

— Normal condition.

— A warning occurred for some reason.

— An error occurred for some reason.

Port:
Shows the port to which the printer is connected.

Status:
Shows a brief description about the printer status.

Cartridges:
Shows the type of the installed BJ cartridges.

Ink Information:
Shows ink information when the remaining ink is running low or when it 
runs out.

Jobs:
Shows the number of print jobs that are currently being processed.
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Other Information:
Shows information such as paper size and the availability of options (when 
using the S450, no information is displayed).

• The following printers are not displayed in the BJ Printer Monitor:

A printer that is connected using a USB/parallel conversion cable

A printer that is being shared by other computers

• Make sure that the printer port setting is correct before using the BJ
Printer Monitor. For example, if you are using a printer which does not
support USB or infrared communication but the printer port is set to a
USB port or IrDA port, the printer is not displayed in the BJ Printer
Monitor.

• To close the BJ Printer Monitor, click the X button on the upper right
corner of the BJ Printer Monitor window. When the BJ Printer Monitor 
is minimized on the Windows Taskbar, right-click the BJ Printer Monitor
icon on the Taskbar and then select Close.

Note

BJ Printer Monitor icon
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• To view a printer connected using a USB interface cable, click the USB
Connected Printer tab (Windows 98 only).

• When you wish to refresh the information display of the BJ Printer
Monitor, select Refresh from the View menu.

• To launch the BJ Status Monitor from the BJ Printer Monitor screen,
select the desired printer name and then select Start Status Monitor
from the Printer Info menu. (You can also launch the BJ Status Monitor
by double-clicking the printer name.)

• For more details, refer to the online Help for the BJ Printer Monitor.

Note
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Cleaning the Print Heads

Printing a Nozzle Check Pattern

Aligning the Print Heads

Turning the Printer On and Off

Using the Special Settings

Using ECP Mode

Uninstalling the BJ Printer Driver
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�  Cleaning the Print Heads
Cleaning the print heads clears the nozzles. There are two ways to clean the print heads: 
normal print head cleaning and deep print head cleaning. Always execute normal print head 
cleaning first. If this does not correct the problem then execute deep print head cleaning.

Cleaning the print heads consumes ink so clean the print heads only when 
necessary.

Normal print head cleaning 

Open the Printer Properties dialog box, then click the Maintenance tab.

Click the first (left) print head cleaning icon in the Print Head Cleaning box.

Note

1

2
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When a confirmation message appears, make sure that the printer is 
turned on and then click the OK button. 

Print head cleaning begins. (It takes about 40 seconds to complete print 
head cleaning and the POWER light stops flashing.)

Print a Nozzle Check Pattern to confirm the success of normal print head 
cleaning.

 Printing a Nozzle Check Pattern

You can also start print head cleaning with the RESUME button on the 
printer. Press and hold down the RESUME button until the POWER light 
flashes once, and then release it.

3

4

Note
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Deep print head cleaning

Always execute normal print head cleaning first. Only when the normal 
print head cleaning does not correct the problem, perform deep print head 
cleaning.

Open the Printer Properties dialog box, then click the Maintenance tab.

Click the print head deep cleaning icon in the Print Head Cleaning box.

Note

1

2
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When a confirmation message appears, make sure that the printer is 
turned on and then click the OK button. 

Print head cleaning begins. (It takes about two minutes to complete print 
head cleaning and the POWER light stops flashing.)

Print a Nozzle Check Pattern to confirm the success of deep print head 
cleaning.

 Printing a Nozzle Check Pattern

If the cleaning had no effect, perform normal print head cleaning and deep 
print head cleaning again. After cleaning the print heads several times, if 
the Nozzle Check Pattern is not satisfactory, a print head may be worn out 
and the corresponding BJ cartridge must be replaced.

 Replacing a BJ Cartridge

3

4

Note
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�  Printing a Nozzle Check Pattern
The Nozzle Check Pattern confirms whether the inks are being correctly ejected from the 
print head nozzles and whether the print heads on the BJ cartridges are correctly aligned. 
Print the Nozzle Check Pattern when your printouts are streaked or the color tones are not 
correct, or after performing print head cleaning.

Open the Printer Properties dialog box, then click the Maintenance tab. 

Click the nozzle check pattern icon in the Test Prints box.

1

2
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When a confirmation message appears, make sure that paper is loaded in 
the printer and the printer is turned on.

Click the OK button.

You can also start printing a Nozzle Check Pattern with the RESUME 
button on the printer. Press and hold down the RESUME button until the 
POWER light flashes twice, and then release it.

3

4

Note
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Look at the check patterns and perform the correction procedure. Separate 
patterns are printed to display the status of each BJ cartridge.

If patterns (1) or (2) are broken or missing, print head cleaning is required.
 Cleaning the Print Heads

If patterns (3) are not overlapped perfectly, print head alignment is required.
 Aligning the Print Heads

(1) (2)

(3)

• Standard color combination 
BC-30e (Black BJ Cartridge and BC-31e Color BJ Cartridge)

(1) BC-30e Black BJ Cartridge nozzle check 
pattern

(2) BC-31e Color BJ Cartridge nozzle check 
pattern

(3) Print head alignment check pattern for both 
BJ cartridges
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If patterns (1) or (2) are broken or missing, print head cleaning is required.
 Cleaning the Print Heads

If patterns (3) are not overlapped perfectly, print head alignment is required.
 Aligning the Print Heads

(3)

(1) (2)

(1) BC-32e Photo BJ Cartridge nozzle check 
pattern

(2) BC-31e Color BJ Cartridge nozzle check 
pattern

(3) Print head alignment check pattern for both 
BJ cartridges

• Photo color combination—optional 
(BC-32e Photo BJ Cartridge optional and BC-31e Color BJ Cartridge)
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If the cleaning had no effect, perform normal print head cleaning and deep 
print head cleaning again. After cleaning the print heads several times, if 
the Nozzle Check Pattern is not satisfactory, one of the print heads may be 
worn out and the corresponding BJ cartridge must be replaced.

 Replacing a BJ Cartridge

Note
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�  

 

Aligning the Print Heads

 

Two BJ cartridges are always installed in the S450 printer. Each time you replace a 
BJ cartridge or switch BJ cartridges for a special print job, you must align the print 
heads to ensure optimum results in printing.

There are two ways to align the print heads: automatically and manually. Normally you will 
execute the automatic print head alignment feature of the printer driver.  If this does not 
work for some reason, then you can execute manual print head alignment.

 

Automatic print head alignment

 

Open the Printer Properties dialog box, then click the Maintenance tab.

Click the print head alignment icon in the Test Prints box.

When a confirmation message appears, make sure that the printer is 
turned on and at least one sheet of plain paper is loaded in the printer.

Click the 

 

OK

 

 button. The printer starts to print the head alignment pattern.

1

2

3

 

06-UsingWinPrinter.fm  Page 186  Thursday, June 1, 2000  4:55 AM



187Using the Windows 98/95 Printer Driver

Using Maintenance Functions

After the following pattern prints, the print heads of the two BJ cartridges 
are aligned properly.

• The automatic print head alignment feature may not work properly in the 
following circumstances.
– When ink runs out.
– The nozzles of the print heads are clogged.
– The printer is exposed to strong light.

If automatic alignment does not work properly, execute manual print head 
alignment.

 Manual print head alignment

• To turn off the printer after automatic head alignment, always press the 
POWER button to turn off the printer. If you do not turn off the printer 
correctly with the POWER button, the print head alignment settings 
are not saved.

Note
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Manual print head alignment

 

If the automatic print head alignment does not work effectively for some reason, align the 
print heads manually.

Open the Printer Properties dialog box, then click the Maintenance tab.

Click Custom Setting on the bottom right of the screen. You see this screen:

Check “Align heads manually,” then click the 

 

Send

 

 button.

When a confirmation message appears, click the 

 

OK

 

 button.

Now click the print head alignment icon on the Maintenance tab.

1
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When a confirmation message appears, make sure the printer is turned on 
and at least two sheets of letter-size plain paper are loaded; then click the 
OK button. The printer starts to print the standard head alignment pattern.  
During print head alignment, do not open the front cover.

When this pattern is printed, click the Yes button.

6

7

Print head alignment pattern
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You see this screen:

Check all the patterns in lines of (Y), from (X1) to (X6), and from (B1) to 
(B2).

For each line enter the appropriate number where you see the lines 
perfectly aligned.

When you finish entering numbers, click the 

 

OK

 

 button to save the settings.

8

Correct:

Incorrect:

(Y) (X1) (B1)
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Make sure that the printer is turned on and letter-size plain paper is loaded; 
then click the OK button.  The printer starts to print the high-resolution head 
alignment pattern.

Check all the patterns in lines of (Y), from (X1) to (X6), and from (B1) to 
(B2).

For each line enter the appropriate number where you see the lines 
perfectly aligned.

10

11

Correct:

Incorrect:

(Y) (X6) (B1)
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When you finish entering numbers, click the OK button to save the settings.

Click the OK button.  This completes the manual print head alignment 
procedure.

When you wish to turn off the printer after manual head alignment, always 
press the POWER button to turn off the printer. If you do not turn off the 
printer correctly with the POWER button, the print head alignment settings 
are not saved.

12

13

Note
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�  Turning the Printer On and Off
You can turn the printer on and off from the Printer Properties dialog box.

The Auto Power On/Off capability of the printer driver also allows you to turn the printer off 
when no data is sent to the printer for a certain period of time, or turn the printer back on 
again when data is sent to the printer.

Turning the printer off

Open the Printer Properties dialog           
box, then click the Maintenance tab.

Click the Power-off icon.

When a confirmation message 
appears, click the OK button. 
The printer is turned off.

The next time you turn on the printer, press the POWER button of the 
printer.

Setting Auto Power on/off

Open the Printer Properties dialog          
box, then click the Maintenance tab.

Click the Power on/off icon.

1

2

3

Note
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Select the desired settings in the Auto Power dialog box.

Auto Power On:
Click the down-arrow and select either Enable or Disable. When this setting 
is enabled, the printer is turned on when data is sent to the printer. The 
default setting is Disable.

Auto Power Off:
Click the down-arrow and select the desired value. When no data is sent to 
the printer within the set time interval, the printer is turned off automatically. 
The default setting is Disable.

Make sure that the printer is turned on and click the Send button.

When a confirmation message appears, click the OK button.

When you wish to disable the Auto Power On/Off setting, select Disable for 
Auto Power On and Auto Power Off in the Auto Power dialog box.

3
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�  

 

Using the Special Settings

 

You can use some special settings that allow you to change the printer operation mode in the 
printer driver.

 

Changing the printer operation mode

 

Open the Printer Properties dialog box, and then click the 

 

Custom Setting… 

 

button in the Maintenance tab. This displays the Custom Setting dialog box.

Change the printer operation mode, as needed.

 

Set printer to ECP mode (when using the parallel interface only)

 

Click this checkbox when you wish to use the ECP mode setting to operate 
the printer.

 

 Using ECP Mode

High-speed printing

 

Click this checkbox when you wish to shorten the response speed of the 
printer to enable high-speed printing.

1
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Pause Page
Click this checkbox when you wish to increase the pause between printed 
pages after performing high density printing. Use this setting to prevent the 
backs of pages from becoming stained after they are printed and ejected 
from the printer.

Pause Scan
Click this checkbox when you wish to increase the pause in the print head 
operation while the print job is being executed. Use this setting to prevent 
the next page from stacking on top of a printed page before it is dry.

Automatically align heads after replacing BJ cartridge
Click this checkbox when you wish to perform print head alignment 
automatically each time you change a BJ cartridge.

Align heads manually
Click this checkbox when you wish to perform manual print head alignment.

Make sure that the printer is turned on and click the Send button.

When a confirmation message appears, click the OK button to close the 
dialog box and send the setting to the printer.

3
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�  Using ECP Mode
Normally, data transfer between the computer and printer are conducted using the 
Centronics®-compatible mode, which is a widely used printer interface type.

You can change the data transfer method to ECP mode, as needed. The ECP mode makes 
it possible to conduct data transfer between the computer and printer at a higher speed 
while keeping compatibility with the former interface type. This shortens the time required 
for printing, depending on the computer system.

Before changing the data transfer method to the ECP mode, consider the 
following points:

• The computer system and printer cable you are using must support ECP 
mode. For details, contact your computer manufacturer.

• The parallel port must be set for ECP in the BIOS settings of your 
computer. When you change the BIOS settings of your computer system, 
be sure to refer to your computer’s documentation, or contact the 
computer manufacturer.

Note
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If the print job cannot be executed properly after changing the data transfer 
method to ECP mode, follow these steps:

(1) Click the Custom Setting button in the Maintenance tab.

(2) Uncheck the Set printer to ECP mode checkbox in the Custom Setting
dialog box.

(3) Click the Send button.

(4) Shut down Windows, then turn the printer off.

(5) Turn the printer back on again. The ECP mode setting is released.

Note
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�  Uninstalling the BJ Printer Driver
The printer driver may be updated to improve the performance of the printer. When you 
install a new version of the printer driver, delete the old version before installing the new 
version.

Uninstalling the BJ Printer Driver with the Uninstaller

When you use multiple Bubble Jet printers and wish to delete all the printer drivers for the 
Bubble Jet printers at the same time, use the Uninstaller feature.

Select Programs from the Start menu, then click BJ Printer.

Click Uninstall.

When a confirmation message appears, click the Yes button.

Click the OK button. This completes the uninstallation procedure.

Depending on the system you use, you may be prompted to restart the 
system. Click the OK button.
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• You can also delete all printer drivers for Bubble Jet printers at the same
time from the Windows desktop. Follow these steps:
(1) Double-click the BJ Printer icon on the Windows desktop.
(2) Double-click the Uninstall icon in the BJ Printer folder.

• When you wish to delete a specific printer driver, follow these steps:
(1) Select Settings from the Start menu, then click Printers.
(2) Select the icon of the printer driver you wish to delete in the Printers

window.
(3) Select Delete from the File menu.
(4) When a confirmation message appears, click the Yes button. 

• You cannot run the uninstaller while the BJ Printer Status Monitor 
is active.

Note
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Printer Driver Basics

The printer driver controls communication between the printer and your computer. To use 
the printer with your computer, you must install the printer driver. For instructions on 
installing the printer driver, refer to the Quick Start Guide.

A
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Preparing and Executing a Print Job

Before you start a print job, you need to specify the print settings. The print settings in the 
printer driver allow fine control over the print quality and color adjustment, but you can 
simplify the setup procedure as follows.

Set the paper size you use from within the application program before 
printing.

Select the command used for printing (for example, Print in the File menu) 
in the application program.

Select the most appropriate icon that indicates the print mode in the Printer 
Properties dialog box.

Specify the BJ Cartridge setting according to the BJ cartridge you are 
using. 

Specify the Media Type setting acording to the print media you are using.

Click the Print button. Printing begins.
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�  Selecting a Printer Driver
Before using the Page Setup dialog box and the Print dialog box, you must first go into 
Chooser in the Apple Menu and choose the correct printer driver for your type of 
connection. 

Once you have chosen the printer driver, it will remain selected. You will only need to 
choose it again if you change to another driver.

Selecting the printer driver using the Chooser

If the printer is directly connected to your Macintosh, use the procedure below to choose 
the printer driver.

Select Chooser from the Apple Menu. The Chooser is displayed.

Click the S450 icon.

1
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When you wish to perform background printing, set Backgrounding to On.

Click in the Close box to close the Chooser. A dialog box may appear with 
this message:

You have changed your current printer. 
Please choose “Page Setup...” in all the open applications.

Simply click OK.

You can now use the S450 for printing.

3
Close
box

4
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�  

 

Changing the Page Setup Dialog Box Settings

 

The size of the paper to be used for printing is usually set when a document is created with 
an application. In your application, open the Page Setup dialog box and select the paper 
size that you want to use with your printer. (The default Paper Size is Letter.)

 

Selecting the page size and the orientation

 

You can open the Page Setup dialog box from your application program.

Select the command used for Page Setup in your application program.
Normally, click Page Setup from the File menu, and the Page Setup dialog 
box is displayed.

Click on the Paper Size drop-down box, and then select the appropriate 
paper size from the pop-up menu.

1
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Select Orientation.

Click the 

 

OK

 

 button.

The Page Setup dialog box closes.

 

Selecting the paper size (for custom paper sizes)

 

When you use custom paper sizes, select any one of Custom1 to Custom3.

Select the command used for Page Setup in your application program.
Normally, click Page Setup from the File menu, and the Page Setup dialog 
box is displayed.
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In Paper Size, select Custom1, Custom 2, or Custom3 and then click the 

 

Custom

 

 button.

The Custom dialog box is displayed.

Select inch or mm for the unit of measurement in Unit and enter the desired 
width and height.
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Click the Apply button.

The Custom dialog box closes and the specified paper size is set.

• Any Custom can be specified as the user-defined paper size.

• To make the setting made with the Page Setup dialog box the default,
so that it is automatically selected whenever a new document is created,
place a check mark in the Save Settings checkbox.

4

Note
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�  

 

Changing the Print Dialog Box Settings

 

Before you can start printing, a few basic settings must be made. Set the BJ Cartridge and 
Media Type settings to match your printer setup, then select the icon corresponding to the 
print mode which you want to use to print your document.

 

Setting the print mode and starting printing

 

Select the command used for Print in your application program.

Normally, click Print from the File menu, and the Print dialog box is 
displayed.

Type in the number of copies to be printed, and then set which pages are to 
be printed.

When only certain pages of a document are to be printed, enter the first 
(From) and last (To) print pages.

1
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Select BJ Cartridge and then select Media Type.
Click the drop-down box to display a pop-up menu. Select the BJ cartridge 
combination you have installed and the media type you have loaded.

When a document created in color is to be printed out in monochrome, 
place a check mark in the Print Grayscale checkbox.

3

Note
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Select the Print Mode icon.
Select the icon that is closest to your document type and intended results.
The Current Settings show the name of the selected icon, along with the 
types of Print Quality, Halftoning, and Color Correction.

 

Print Mode Icons

 

Text

 

Prints documents made up primarily of text at normal 
quality.

 

Graphic

 

Intended for printing graphs and other computer 
graphics with clear color boundaries.

 

Photo

 

Intended for printing photographs and other graphics 
that use gradations of color and tone.

 

Manual

 

Allows you to customize the print mode settings.

 

 Setting for Manual Printing

 

Click the 

 

Print

 

 button to close the Print dialog box and start the print job.
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Displaying a print preview of the document 

To view a preview of the document as it will appear when printed, click the Options... button 
and change the output destination.

Open the Print dialog box, and click the Options... button.
The Options dialog box is displayed.

Select Preview as the output destination, and click the OK button.

Click the Preview button in the Print dialog box.
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The Preview dialog box is displayed.

When you are satisfied with the document and want to print it, click the 
Print button. To close the preview screen without printing, click the Cancel 
button.

4
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Saving a document as a PICT file

To save your document as a PICT file, click the Options... button and change the output 
destination.

Open the Print dialog box, and click the Options... button.
The Options dialog box is displayed.

Select PICT File as the output destination, and click the OK button.

Click the File button in the Print dialog box.
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Type in the Filename under “Save as:” and click the Save button.

The document data is saved in PICT file format and displayed on 
your desktop.

4
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�  

 

How to Use Help

 

The printer driver has many helpful functions. To display an explanation of these functions, 
use the balloon help. When you position the cursor over a given item, a brief explanation of 
that item appears in a balloon.

 

Displaying balloon help

 

Select Show Balloons from the Help menu.

Display the printer driver screens (the Page Setup dialog box, the Print 
dialog box, etc.).

Position the cursor over the item for which you want to display an 
explanation. An explanation of the item is displayed.

To turn off the balloon help, select Hide Balloons from the Help menu.
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�  Printing Documents Enlarged/Reduced
The scaled printing feature of the printer driver allows you to set a scaling value so you can 
print an enlarged or reduced page on a paper size that is larger or smaller than the page 
size of the original file in the application program.

Setting the scaling value

Set a value between 25% and 400% as the enlargement/reduction scale in the Page Setup 
dialog box.

Open the Page Setup dialog box.
Normally, select Page Setup from the File menu.

Set Paper Size, as necessary.

Set the desired enlargement or reduction ratio in Scale.
Enter the value of the enlargement or reduction ratio; or you can click the 
drop-down box in Scale. 
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Click the OK button.
The Page Setup dialog box closes.

To start printing, click the Print button in the Print dialog box.
Normally, select Print from the File menu to open the Print dialog box.

• When you wish to revert Scaled Printing to the original value, set the 
original value (100%) in the Scale box.

• You can type in a Scale value from 25 to 400%. When clicking the 
arrows, the Scale values run from 50 to 200%.
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�  Printing on Banner Paper

 Banner Paper

Setting banner printing

Place a check mark in the Banner Printing checkbox in the Page Setup dialog box.

Open the Page Setup dialog box. 
Normally, select Page Setup in the File menu.

Select Letter in Paper Size.

Click the Banner Printing checkbox to place a √  in the box.

Click OK.

When a confirmation message appears, click the OK button.

The Page Setup dialog box closes.
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Open the Print dialog box.
Normally, select Print from the File menu.

Select Plain Paper in Media Type.

Click the Print button to close the Print dialog box and start the print job.

• Always set 1 in the Copies box in the Print dialog box. If you set
multiple copies, the data cannot be printed on the banner paper properly. 

• When you wish to return to normal printing, clear the check mark from
the Banner Printing checkbox. 

�  Printing Multiple Pages on One Sheet
By reducing the scale in a 2-up or 4-up layout, you can print multiple pages on one sheet of 
paper. You can save the total amount of paper used for long documents. This feature is also 
useful when you wish to view an image spread or print your document as a book cover.

Specifying the layout

Open the Options dialog box from the Print dialog box and make the necessary settings.

Open the Print dialog box.
Normally, select Print from the File menu.

Click the Options... button.
The Options dialog box is displayed.
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Click on the Page Layout drop-down box and select the 2 Up or 4 Up layout 
from the pop-up menu.
The 2-Page Print setting prints two pages on one sheet of paper and the 
4-Page Print setting prints four pages on one sheet of paper. Confirm the 
layout of the printout in the Preview.

Make the following settings, as necessary.

Page Order:
Click on the Page Order drop-down box. The illustration indicates the order 
in which the pages run:

Horizontally from top left
Horizontally from top right
Vertically from top left
Vertically from top right

3
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Frame:
When you print multiple pages of data on one sheet, this option allows 
you to select whether to add a border around each page. Click on the 
drop-down box to select None, Fine line, or Broad line.

Click the OK button.
The Options dialog box closes.

Click the Print button to close the Print dialog box and start the print job.

When you wish to revert Page Layout printing to the original setting, select 
the 1 Up layout in Page Layout.

�  Changing the Print Order 
Based on the default settings of the printer driver, the printer starts printing one set of any 
document from the first page. When two or more copies of the same data are to be printed, 
specify collation reverse order printing. This saves you from having to rearrange the copies 
after they have printed.

Setting the print order 

When you wish to print multiple copies of the same document, you can change the print 
order with “Print in reverse order” and “Print collate pages,” as necessary. 

Open the Print dialog box.
Normally, select Print in the File menu.

Click the Options... button.
The Options dialog box is displayed.
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Set the print order using “Print in reverse order” or “Print collate pages,” as 
necessary.

Print in reverse order:
Use this setting when you print a multiple page document. The printer 
starts printing from the last page of the document. When this setting is 
disabled, the printer starts printing from the first page of the document.

Print collated pages:
Use this setting when you print multiple copies of a multiple page 
document.

When “Print collated pages” is enabled, the printer prints the document and 
collates each copy from the first page through to the last page.

When “Print collated pages” is disabled, the printer prints the document 
and collates copies of the same page. In this case, you will need to 
manually combine the pages to create each set of a multiple-page 
document.

3
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Click the OK button.
The Options dialog box closes.

Click the Print button to close the Print dialog box and start the print job.

�  Setting for Manual Printing
Selecting the icon allows you to set your own printing parameters, including the quality, 
halftoning, color balance, and density. Also, once you have specified your custom settings, 
you can reapply those settings simply by clicking the icon.

Specifying the print settings manually

Select the icon from Print Mode in the Print dialog box. You can then set the items in the 
Quality panel and the Color panel.

Open the Print dialog box.
Normally, select Print from the File menu.

Click the icon in Print Mode.

Click the Details... button.
The Quality panel of the Detailed Setting dialog box is displayed.
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Set Print Quality or Halftoning, as necessary.

 Changing the Print Quality/Halftoning

 Photo Optimizer 

4
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When you wish to adjust the color settings, click the Color icon. 
The Color panel is displayed.

 Adjusting the Image Data

When you have completed the settings, click the OK button.
Then return to the Print dialog box.

Click the Print button to close the Print dialog box and start the print job.

When the same print mode setting is to be used the next time you print, 
select the icon from Print Mode in the Print dialog box.

5

6

7

Note



230Using the Macintosh Printer Driver

Executing Special Functions

�  Changing the Print Quality/Halftoning
When your printouts are not satisfactory, the printer driver allows you to make fine 
adjustments to the print quality and halftoning settings. If there is a problem in the image 
data you wish to print, changes to the print quality and halftoning settings may not be visible 
or effective.

Adjusting the print quality

When you wish to specify detailed Print Quality and Halftoning, select the icon in Print 
Mode. 

Open the Print dialog box. 
Normally, select Print from the File menu.

Select the icon in Print Mode.

Click the Details... button.
The Quality Panel of the Detailed Setting dialog box is displayed.
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Set the Print Quality.
The further you move the slide bar toward the right, the better the print 
quality will be, but the longer it will take to perform the printing. The print 
mode display varies with the position of the slide bar.

Select the Halftoning icon, as necessary.
The halftoning selection determines the way in which the ink dots are 
arranged on the page, and changes the appearance of halftones.

4

5



232Using the Macintosh Printer Driver

Executing Special Functions

Pattern:
Dots of different colors are arranged in a specified order.

Select this option when you want to print graphics with clearly defined color 
boundaries or graphs in which large areas are filled with the same color.

Scatter:
Dots of different colors are arranged at random.

Select this option when you want to print images with blurred boundaries 
and fine gradations of tone and color. This setting is best for printing 
photographs.

Click the OK button. You return to the Print dialog box.

Click the Print button to close the Print dialog box and start the print job.

• Some Print Quality settings cannot be selected depending on the
setting made for Halftoning. To obtain the best quality printing, select
Scatter.

• Some settings cannot be selected depending on the type of 
BJ cartridge and the selected paper type. In such cases, make 
the necessary adjustments within the supported range.
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�  Optimizing Image Data
The Photo Optimizer adjusts a photographic image created by a scanner or a digital 
camera when it is printed out. Use the Photo Optimizer to compensate for unsatisfactory 
color balance and over- or under-exposure before printing.

Photo Optimizer

Place a check mark in the Photo Optimizer checkbox in the Detailed Settings dialog box.

Open the Print dialog box.
Normally, select Print from the File menu.

Select the icon in Print Mode.

Click the Details... button.
The Quality Panel of the Detailed Setting dialog box is displayed.

Place a check mark in the Photo Optimizer checkbox.
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Click the OK button. You return to the Print dialog box. 

Click the Print button to close the Print dialog box and start the print job.

�  Adjusting the Image Data
When the color reproduction of your printouts is unsatisfactory, you can adjust the color 
balance and density as needed.  Use this feature only when you wish to make fine 
adjustments to the color balance in the printouts, and do not change the settings 
excessively. (Please note that this feature does not compensate the overall color balance of 
the image data as some application programs for editing image data would do.)

Adjusting the colors

Select the icon in Print Mode and then click the Color icon in the Detailed Setting dialog 
box. 

Open the Print dialog box.
Normally, select Print from the File menu.

Select the icon in Print Mode.

Click the Details... button.
The Quality panel is displayed.
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Click the Color icon.
The Color panel is displayed.

 

Set the following items as needed.

Color Correction
BJ Standard: Applies the optimum color correction for printing with a 

Bubble Jet printer. Normally, you will select this setting.
ColorSync: Selected when color correction is performed with ColorSync.
None: Selected when color correction is not to be applied.

Matching Method
This sets the color representation method.

Photo: For printing overlapping intermediate color.
Graphic: To print primary color more brightly.
Spot Color: To print documents that use large amounts of a basic color. 

4

5



236Using the Macintosh Printer Driver

Executing Special Functions

Printer Profile
This selects the profile to suit the type of document. Generally, you will use 
the Recommended by Canon setting.

Recommended by Canon lists the color features that are suitable for the 
BJ cartridge, paper size, print quality, halftoning, etc.

Gamma Correction
Gamma Correction enables the adjustment of halftone contrast between 
perfect white and perfect black.

If you want to adjust the contrast, place a check in this box and move the 
slider left or right to set a value.

When Gamma Correction is not to be performed, clear the check mark from 
the checkbox.

Color Balance
The color intensity is set separately for cyan, magenta, yellow, and black.

The color intensity is adjusted by dragging the slide bar for each color to the 
right or left. For example, if you feel that the blue (cyan) component is too 
strong, drag that slider in the negative direction (to the left). On the other 
hand, if you think that the blue (cyan) is too weak, drag the slider in the 
positive direction (to the right). Once you have made the adjustment, the 
balance of the four colors changes and the overall color tone changes as 
well. It’s a good idea to make such adjustments in very small steps.

Density
Moving the slider to the right increases the density while moving it to the left 
decreases the density.
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Click the OK button. Then return to the Print dialog box. 

Click the Print button to close the Print dialog box and start the print job.

�  Registering and Managing Print Settings
You can name the settings in the Print dialog box (such as BJ Cartridge, Media Type, Print 
Grayscale, and Print Mode) when you perform registration. You can set default mode for any 
setting that is used often.

Registering print settings

You can use names to register the contents of those settings that are performed with the 
Print dialog box.

Open the Print dialog box, and then select options as needed.

Click the Apply button.
The Register Settings dialog box is displayed.

Click the Apply button.

6
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Type in the name under which you want to register the settings and then 
click the OK button.

You return to the Register Settings dialog box.

Click the Close button.
You return to the Print dialog box.

You cannot specify a name that is already being used for a set of print 
mode settings. Use a different name, or remove the settings with that name 
before you register the new settings. 

Importing registered print setting

You can read in a previously registered print mode and set it as the Print dialog box for the 
icon.

Open the Print dialog box and click the Apply... button.
The Register Settings dialog box is displayed.

4

5

Note

1
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Click on the print mode setting you want to import and then click the Import 
button.

Click the Close button.

You return to the Print dialog box.

When a registered Print Mode is to be set as the default (so this print mode 
is always selected when the Print dialog box is open), select its name in the 
Register Settings dialog box and click the Defaults button. If a check mark 
is shown next to a name, it indicates that the print mode is set as the 
default.

Removing registered print settings

When a registered print mode is no longer necessary or you want to register a different 
setting under the same name, delete it by following these steps:

Open the Print dialog box and click the Apply... button.
The Register Settings dialog box is displayed.

2

3

Note

1
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Click the print mode setting you want to remove and then click the Remove 
button.

When a confirmation appears, click the OK button.

The selected print setting is removed from the list.

Click the Close button. You return to the Print dialog box.

• Factory Defaults cannot be deleted.

• Once you delete a print setting, you cannot restore it. If you need it, 
you will have to go through the entire setting process again.

2

3

4

Note
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�  Using Background Printing
If background printing is selected with the Chooser, you can open the BJ PrintMonitor to 
confirm the progress of printing or to stop printing.

Also, the order in which suspended documents are printed can be changed.

About background printing

The print processing method that enables you to do other tasks simultaneously while 
printing documents is called background printing. When background printing is to be 
performed, select Chooser from the Apple Menu, select a printer driver, and set 
Backgrounding to On.

 Selecting a Printer Driver

While background printing is being performed, you can display the BJ PrintMonitor to 
confirm the progress of printing or to stop the printing.

Displaying the BJ PrintMonitor window

When Backgrounding is set to On, the BJ PrintMonitor starts up automatically when you 
print. The BJ PrintMonitor appears in the Application Menu.

To verify the print process, click the BJ PrintMonitor icon in the Application Menu.
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Closing the BJ PrintMonitor window

When you select Close Status Window from the File menu, the BJ PrintMonitor window 
closes.

BJ PrintMonitor Function

The BJ PrintMonitor shows the document currently being printed and a list of the 
documents queued for printing.

Print queue document information includes the document name, number of pages, number 
of copies, and the time when the print job was accepted. The total number of print queue 
documents is displayed in the bottom row.
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The BJ PrintMonitor makes it possible to perform the following tasks.

• The order of the documents in the print queue can be changed.
Position the cursor over the name of the document whose position you want to 
change and drag it to the desired position in the queue while holding down the 
mouse button. When you release the button, the document moves to the 
selected position.
You can temporarily suspend the printing of one document so that another 
document in the print queue can be printed out.

• Printing can be stopped.
Click the name of the document name for which you want to stop printing and 
then click the icon. The selected document is deleted from the list.

• Printing can be suspended/restarted.
Click the name of the document for which you want to suspend printing and then 
click the .  To restart printing, click the icon.

Suspends printing of the document. Restarts 
the printing of the document.

Suspends the printing of specified documents 
only.

Restarts the printing of the documents 
suspended with .

Stops printing of the specified document.

Shows information about the document currently being 
printed. The icon on the left gradually fills with black as 
printing proceeds.

Lists the names of the queued documents.

Control Buttons
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�  Using the Printer With a Network
The S450 can be connected to a network. To enable use of the printer from any computer 
connected to the network, the necessary printer driver must be installed on each computer.

Connection environment and installation

• The S450 can be connected to an Ethernet environment.
• Install the printer driver on all the computers that will use this printer.

See your Quick Start Guide.

• The printer must be connected to the computer acting as the print server via a 
USB interface cable. The print server and the client machines use different 
printer drivers and different tools to confirm printing progress. Refer to the 
example shown below.

Client
Client

Client

Client Client

Ethernet
Environment

USB interface cable

Print Server S450
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Print server
Refers to the computer to which the printer is directly connected via a USB interface cable. 
On the print server, select the printer driver called S450. From the print server, the progress 
of printing can be confirmed using the BJ PrintMonitor.

Client machine
Refers to a computer that is connected to the print server via an Ethernet network. From a 
client machine, select the printer driver called S450 (Server). When printing is executed, 
data is sent to the printer via the print server. Although the BJ PrintMonitor cannot be 
started from a client machine, the progress of printing can be confirmed by starting the 
BJ StatusMonitor on the print server.

Selecting the printer driver

To use the printer with a network, the correct printer driver must be installed on each 
computer. The print server must be set up first. Then, the necessary settings are made for 
each client machine.

Setting up the print server

Select Chooser from the Apple Menu.1
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Select the S450 icon and select the printer name from “Connected to:”

Click the Share button.

Confirm that S450 Server is selected for “Enter new print server name:”, 
and then click the Send button.

2

3

4
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Confirm that a new print server name has been added to “Current print 
servers,” and then click the Close button.

Click the close box to close the Chooser.

Setting up client machines

Select Chooser from the Apple Menu.

Select the S450 (Server) icon and select the print server in “Connected to:”.

Click the close box to close the Chooser.

5

6

1

2

3
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Confirming the status of the print server from a client machine

When the progress of printing with the print server is to be confirmed in the BJ PrintMonitor, 
start the BJ StatusMonitor.

Starting the BJ StatusMonitor

Double-click the BJ StatusMonitor icon in the BJ Extras folder.

Closing the BJ StatusMonitor window

Select Quit from the File menu to close the BJ StatusMonitor.
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Functions of the BJ StatusMonitor

The progress of print jobs being performed by the print server machine can 
be confirmed using the BJ StatusMonitor. A list of documents that are 
currently being printed as well as those in the print queue is displayed. The 
information related to the jobs in the print queue includes the document 
name, number of pages, number of copies, and the time at which the print 
job was accepted. The total number of documents in the print queue is 
displayed in the bottom row.

The following operations can be performed with the BJ StatusMonitor. 
Note, however, that the owner of the client machine and the owner of the 
document must be the same. If you double-click a document name, you can 
determine the owner of the print job.

Suspends the printing of specified documents 
only.

Restarts printing of the documents suspended 
with .

Stops printing of the specified document.

Functions of the buttons

Displays information related to the document currently 
being printed.

The icon on the left gradually fills with black as printing 
proceeds.

Lists the names of the queued documents.
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• Stop printing
Click the name of the document for which you want to stop printing and 
then click the icon. The selected document is deleted from the list.

• Suspend/Restart printing
Click the name of the document for which you want to suspend printing 
and then click the icon. To restart printing, click the icon.

• The owner of a computer can be determined from the Owner Name item
after selecting File Sharing from the Control Panel.

• When you are using two or more print servers, you can switch the
display of BJ StatusMonitor. Select the desired print server from Print
Server and then click the OK button. You can then switch the display 
of the BJ StatusMonitor.

Note
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Cleaning the Print Heads

Printing a Nozzle Check Pattern

Aligning the Print Heads

Turning the Printer On and Off

Special Settings

Uninstalling the Printer Driver
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�  Cleaning the Print Heads
Cleaning the print heads clears the nozzles. There are two ways to clean the print heads: 
normal print head cleaning and deep print head cleaning. Always execute normal print head 
cleaning first. If this does not correct the problem, then execute deep print head cleaning, 
which produces more intensive cleaning.

Cleaning the print heads consumes ink, so clean the print heads only when 
necessary.

Normal print head cleaning 

Open the Page Setup dialog box.
Normally, select Page Setup from the File menu.

Click the Utilities button.

After confirming that Print Head Cleaning is selected in the drop-down 
menu, click the icon.

Note

1

2

3
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When a confirmation message appears,         
make sure that the printer is turned on 
and then click the 

 

OK

 

 button. Print head 
cleaning begins. (It takes about 40 seconds 
to complete print head cleaning and the 
POWER light stops flashing.)

Print a Nozzle Check Pattern to confirm the success of print head cleaning.

 

 Printing a Nozzle Check Pattern

 

Deep print head cleaning

 

Always execute normal print head cleaning first. Only when the normal 
print head cleaning does not correct the problem, perform deep print head 
cleaning.

Open the Page Setup dialog box. 
Normally, select Page Setup from the File menu.

Click the 

 

Utilities

 

 button.

4

5

Note
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After checking that Print Head Cleaning is selected, click the icon.

When a confirmation message appears, make sure that the printer is 
turned on and then click the OK button. 

Print head cleaning begins. (It takes about two minutes to complete print 
head cleaning and the POWER light stops flashing.)

Print a Nozzle Check Pattern to confirm the success of deep print head 
cleaning.

 Printing a Nozzle Check Pattern

3

4

5
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If the cleaning had no effect, perform normal print head cleaning and deep 
print head cleaning again. After cleaning the print head several times, if the 
Nozzle Check Pattern is not satisfactory, one of the print heads may be 
worn out and the corresponding BJ cartridge must be replaced.

 Replacing a BJ Cartridge

�  Printing a Nozzle Check Pattern
The Nozzle Check Pattern confirms whether the inks are being correctly ejected from the 
print head nozzles and whether the print head on the BJ cartridge is correctly aligned. Print 
the Nozzle Check Pattern when your printouts are streaked or the color tones are not 
correct, or after print head cleaning has been executed.

Open the Page Setup dialog box.
Normally, select Page Setup from the File menu.

Click the Utilities button. 

Select Test Print, then click the icon.

Note

1
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When a confirmation message appears, make sure that paper is loaded in 
the printer and the printer is turned on. 

Click the OK button. The Nozzle Check Pattern is printed.

Look at the check patterns and perform the correction procedure. Separate 
patterns are printed to display the status of the BJ cartridge.

If patterns (1) or (2) are broken or missing, print head cleaning is required.
 Cleaning the Print Heads

If patterns (3) are not overlapped perfectly, print head alignment is required.
 Aligning the Print Heads

4

5

(1) (2)

(3)

• Standard color combination 
(BC-30e Black BJ Cartridge and BC-31e Color BJ Cartridge)

(1) Black BJ Cartridge nozzle check pattern
(2) Color BJ Cartridge nozzle check pattern
(3) Print head alignment check pattern for both 

BJ Cartridges
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If patterns (1) or (2) are broken or missing, print head cleaning is required.
 Cleaning the Print Heads

If patterns (3) are not overlapped perfectly, print head alignment is required.
 Aligning the Print Heads

(3)

(1) (2)

(1) Photo BJ Cartridge nozzle check pattern
(2) Color BJ Cartridge nozzle check pattern
(3) Print head alignment check pattern for both 

BJ Cartridges

• Photo color combination—optional
(BC-32e Photo BJ Cartridge (optional) and BC-31e Color 
BJ Cartridge)
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�  Aligning the Print Heads
Two BJ cartridges are always installed in the S450 printer. Each time you replace a 
BJ cartridge or switch BJ cartridges for a special print job, you must align the print 
heads to ensure optimum results in printing.

There are two ways to align the print heads. Normally you will execute the automatic print 
head alignment feature of the printer driver.  If this does not work for some reason, then you 
can execute manual print head alignment.

Aligning the print heads automatically

Open the Page Setup dialog box.
Normally, select Page Setup from the File menu.

Click the Utilities button.

Select Test Print, then click the icon.

1

2

3
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When a confirmation message appears, make sure that the printer is 
turned on and that plain paper is loaded in the printer. 

Click the OK button. 

The printer starts to print the head alignment pattern. During print head 
alignment, do not open the front cover.

After the following pattern prints, the print heads of the two BJ cartridges 
are aligned properly.

4

5
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• The automatic print head alignment feature may not work properly in the 
following circumstances.
– When ink runs out.
– The nozzles of the print heads are clogged.
– The printer is exposed to strong light.

If automatic alignment does not work properly, execute manual print head 
alignment.

 Aligning the print heads manually

• To turn off the printer after automatic head alignment, always press the 
POWER button to turn off the printer. If you do not turn off the printer 
correctly with the POWER button, the print head alignment settings 
are not saved.

Note
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Aligning the print heads manually

If the automatic print head alignment does not work effectively for some reason, align the 
print heads manually.

Select Page Setup from the File menu.

Click the Utilities button.

Select Special Settings by clicking the up- or down-arrow.

Check “Align heads manually,” then click the Send button.

When a confirmation message appears, click the OK button.

Click the up- or down-arrow to select Test Print, then click the Print head 
alignment icon.

When a confirmation message appears, make sure the printer is turned on 
and at least two sheets of letter-size plain paper are loaded; then click the 
OK button. The printer starts to print the standard head alignment pattern.  
During print head alignment, do not open the front cover.

1

2

3

4
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When this pattern is printed, click the Yes button.

Check all the patterns in lines of (Y), from (X1) to (X6), and from (B1) to 
(B2).

For each line enter the appropriate number where you see the lines 
perfectly aligned.

8

Print head alignment pattern

9

Correct:

Incorrect:

(Y) (X1) (B1)
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When you finish entering numbers, save the settings.

Make sure that the printer is turned on and letter-size plain paper is loaded; 
then click the OK button.  The printer starts to print the high-resolution head 
alignment pattern.

Check all the patterns in lines of (Y), from (X1) to (X6), and from (B1) to 
(B2).

For each line enter the appropriate number where you see the lines 
perfectly aligned.

When you finish entering numbers, save the settings.

10

11

12

Correct:

Incorrect:

(Y) (X6) (B1)

13
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Click the OK button.  This completes the manual print head alignment 
procedure.

When you wish to turn off the printer after manual head alignment, always 
press the POWER button to turn off the printer. If you do not turn off the 
printer correctly with the POWER button, the print head alignment settings 
are not saved.

14

Note
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�  Turning the Printer On and Off
The Auto Power On/Off capability of the printer driver allows you to turn the printer off when 
no data is sent to the printer for a certain period of time and turn the printer back on again 
when data is sent to the printer.

Open the Page Setup dialog box.
Normally, select Page Setup from the File menu.

Click the Utilities button.

Click Auto Power Setting, and then select the auto power settings Auto 
Power On and Auto Power Off, as necessary. Click the Send button.

1

2

3
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Auto Power On:
When this setting is enabled, the printer is turned on when data is sent to 
the printer.

The default setting is off.

Auto Power Off:
When no data is sent to the printer for the set time, the printer is turned off 
automatically.

The default setting is off.

When a confirmation message appears, click the OK button.

When Auto Power On/Off is to be cancelled, remove the check mark from 
each checkbox using the same procedure.

4

Note
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�  Special Settings
With the special settings in the Print Utility dialog box, you can change the printer’s mode 
settings and printer driver to change its operation.

Use the Chooser to change the driver-supported resolution.

Changing the printer’s mode 

A pause can be specified to allow the most recent printout to dry, or to adjust the print head 
position.

Open the Page Setup dialog box.
Normally, click Page Setup from the File menu.

Click the Utilities button.

Select Special Settings, and then place a check mark in the checkboxes 
corresponding to the required settings. Click the Send button.

1

2

3
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Pause Between Pages
Inserts a pause after completing high-density printing of a page. Select this 
item, by setting it to On, if you find that print quality is being affected by the 
next page being fed before the ink on the previous page has completely 
dried.

Pause Between Scanning
Inserts a pause between passes of the print head. Select this item, by 
setting it to On, if you find that the printed pages are not drying well.

When a confirmation message appears, click the OK button.
This completes changing the printer’s mode.

Changing the driver-supported resolution

The driver-supported resolution is usually set to Standard. Try changing this setting.

Select Chooser from the Apple menu.

Click the S450 icon.

4

1

2
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Click the Setup button.

Click on Driver-Supported Resolution and select High from the pop-up 
menu.

Click the OK button.

Click the close box to close the Chooser.

3

4

5
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�  Uninstalling the Printer Driver
When the Printer Driver is no longer necessary, you can remove an installed printer by 
selecting Custom remove. The Custom remove option allows you to remove just those files 
that are not needed when you change your computer environment.

Uninstalling the printer driver with the Custom remove

If there are any unsaved documents in applications that are currently 
running, save your documents. 

Double-click S450 folder and then double-click Printer Driver folder.

Double-click the BJ Installer icon.

When the Software License Agreement is displayed, click the Agree 
button.

Select Uninstall from the pop-up menu.

1
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Click the Uninstall button.

When a confirmation message appears, click the Continue button.

When a confirmation message appears, click the OK button to restart the 
computer.

6

7

8
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Routine Maintenance

Prolonging the Service Life of the Printer

BJ Cartridges You Can Use With the Printer

Notes on Handling BJ Cartridges

BJ Cartridge Maintenance 

When to Replace a BJ Cartridge

Printing a Nozzle Check Pattern

Cleaning the Print Heads

Replacing the Ink Tanks

Replacing a BJ Cartridge

Aligning the Print Heads

Cleaning the Printer

Transporting the Printer
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Prolonging the Service Life of the Printer

To ensure a long service life for your printer, clean it frequently and replace consumable 
items such as the BJ cartridges when required. Before you move the printer to a new 
location, pack it in its original box and packing material to prevent damage during shipping.

Guidelines for replacement of consumable items

 BJ Cartridge Maintenance

 When to Replace a BJ Cartridge

How to maintain the printer

 Cleaning the Printer

 Transporting the Printer

How to pack the printer for moving

 Transporting the Printer
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BJ Cartridges You Can Use With the Printer

You can install two combinations of BJ cartridges for printing.

• Standard color combination • Photo color combination (optional)
Use this standard color combination for Use this photo color combination for 
business graphics or standard color printing photographs and scanned images 
printing of charts and text. that require fine halftone colors.

Left: BC-30e Black BJ Cartridge Left: BC-32e Photo BJ Cartridge 
Right: BC-31e Color BJ Cartridge (optional) 
 Right: BC-31e Color BJ Cartridge 
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BJ Cartridges You Can Use With the Printer

�  BC-30e Black BJ Cartridge 
This BJ cartridge contains pigment black ink, which takes longer to dry than general dye 
ink, but produces extremely sharp, water-resistant text and graphics. The BC-30e Black 
BJ Cartridge, used in combination with the BC-31e Color BJ Cartridge, is ideal for business 
and technical reports that contain text with color charts or graphs.

The BC-30e Black BJ Cartridge is composed of two distinct parts, a replaceable print head 
and one replaceable ink tank, the BCI-3eBk Ink Tank. When this BJ cartridge runs out of 
black ink, only the ink tank needs to be replaced.

 Replacing the Ink Tanks
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BJ Cartridges You Can Use With the Printer

�  BC-31e Color BJ Cartridge
This BJ cartridge contains three inks: Cyan, Magenta, Yellow (CMY). The BC-31e Color 
BJ Cartridge is always installed on the right side of the cartridge holder. When this color 
BJ cartridge is used with the BC-30e Black BJ Cartridge installed on the left side of the 
cartridge holder, the combination is ideal and economical for printing text and color graphs 
and charts.

The BC-31e Color BJ Cartridge is composed of four distinct parts, a replaceable print head 
and three replaceable ink tanks. When a color runs out, only that ink tank needs to be 
replaced.

Cyan: BCI-3eC Ink Tank 
Magenta: BCI-3eM Ink Tank 
Yellow: BCI-3eY Ink Tank 

 Replacing the Ink Tanks

BJ Cartridge

Ink tanks
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�  BC-32e Photo BJ Cartridge (optional)
This BJ cartridge contains three photo inks: Photo Cyan and Photo Magenta, which are 
slightly lighter than ordinary cyan and magenta, and dye black. The combination of the 
Photo Cyan and Photo Magenta of the BC-32e Photo BJ Cartridge with the three colors of 
the BC-31e Color BJ Cartridge achieves the most spectacular photo-realistic effects in 
printed photographic images.

The BC-32e Photo BJ Cartridge is composed of a replaceable print head and three 
replaceable ink tanks. When a color runs out, only that ink tank needs to be replaced.

Photo Black: BCI-3ePBk Photo Ink Tank  
Photo Cyan: BCI-3ePC Photo Ink Tank  
Photo Magenta: BCI-3ePM Photo Ink Tank 

 Replacing the Ink Tanks
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Notes on Handling BJ Cartridges

�  When you handle BJ cartridges...

• To avoid personal injury or damage to the print head, do not touch the 
print head of a BJ cartridge. The print head becomes very hot during 
printing and can cause a minor burn. Touching the print head could 
damage it and make further printing impossible.

• To avoid ink spills and stains on your clothing or the surrounding area, do 
not drop or shake BJ cartridges or ink tanks.

Caution

CanonBCI-3BK

InkTank

Black
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Notes on Handling BJ Cartridges

�  When you store BJ cartridges...
When you replace a BJ cartridge, always store the BJ cartridge you are not using in an Ink 
Cartridge Storage Box. If the BJ cartridge is not properly stored in the container, the ink will 
dry out and you can no longer use the BJ cartridge. Also, after removing the seal on an
ink tank, always insert it into a BJ cartridge to prevent the ink tank from drying out.

Always store BJ cartridges and ink tanks out of the reach of small children. 
If any ink enters an eye or is accidentally ingested, seek medical assistance 
immediately.

BCI-3Y

InkTank

Canon

Canon
BCI-3C

InkTank Canon
BCI-3M

InkTankMagenta

Cyan

Yello

Canon
BCI-3BK

Ink
ank
T

Black

Caution
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Notes on Handling BJ Cartridges

• Do not attempt to reattach the protective cap and protective tape after 
removing them. Observe all local regulations regarding the location and 
method of disposing of them.

• Do not leave an empty ink tank in a BJ cartridge. Remove it immediately 
after ink runs out, and replace it with a new ink tank.

• If, for some reason, you remove a usable ink tank from the BJ cartridge,
re-insert the ink tank right away. Otherwise the ink will dry and print jobs
may not be performed properly when you install the ink tank later.

• For optimum print quality, an ink tank or BJ cartridge should be used up
within six months or a year respectively, after opening the original
packaging.

 Replacing the Ink Tanks

�  When you replace an ink tank or BJ cartridge...
The BC-30e Black, BC-31e Color, and BC-32e Photo BJ Cartridges contain replaceable ink 
tanks. Ink tanks and BJ cartridges are consumable items. When an ink tank runs out of ink, 
or after a print head wears out, replace the item.

 Replacing the Ink Tanks

 Replacing a BJ Cartridge

• When you replace an ink tank, note the name and number and replace it 
only with an identical ink tank.

• If the print head is worn out, replace the entire BJ cartridge.

Note

Note
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BJ Cartridge Maintenance

Over time, ink tanks run out and require replacement, and eventually the BJ cartridges 
also require replacement after the print heads wear out. The following topics regarding 
BJ cartridge maintenance describe how to check the status of the BJ cartridges and 
take the appropriate actions to correct problems.

 Printing a Nozzle Check Pattern

 Cleaning the Print Heads

 Replacing the Ink Tanks

 Replacing a BJ Cartridge

 Aligning the Print Heads



282Routine Maintenance

When to Replace a BJ Cartridge

If your printout appears streaked or blurred, open the front cover of the printer and visually 
check the level of the ink in all the ink tanks. If the remaining ink is low or has run out, 
replace the necessary ink tank(s).

 Replacing the Ink Tanks

If an ink tank runs out of ink, the printer beeps four times and the BJ Status 
Monitor for Windows starts up to display a message to warn you that an ink 
tank has run out of ink.

If, after you replace the ink tank(s), the print quality is still poor, follow the 
procedure outlined in the flow chart on the next page.

Note
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When to Replace a BJ Cartridge

 Printing a Nozzle Check Pattern

 Cleaning the Print Heads 

 Replacing a BJ Cartridge

 Aligning the Print Heads

Nozzle check pattern poor quality?

Nozzle check pattern poor quality?

Nozzle check pattern poor quality?

Print a nozzle check pattern

Execute normal print head cleaning

Execute deep print head cleaning

Replace the BJ cartridge

Execute print head alignment
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Printing a Nozzle Check Pattern

The Nozzle Check Pattern confirms whether the inks are being correctly ejected from the 
print head nozzles and whether the print head on the BJ cartridge is correctly aligned. Print 
the Nozzle Check Pattern when your printouts are streaked or the color tones are not 
correct, or after you perform print head cleaning.

 Printing a Nozzle Check Pattern

 Printing a Nozzle Check Pattern

You can print a Nozzle Check Pattern with the printer driver or with the 
RESUME button on the printer. To print the Nozzle Check Pattern from the 
operation panel, press and hold down the RESUME button until the 
POWER light flashes twice, and then release it.

Windows

Macintosh

Note
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Cleaning the Print Heads

Cleaning the print heads clears the nozzles. There are two ways to clean the print heads: 
normal print head cleaning and deep print head cleaning. Always execute normal print head 
cleaning first. If this does not correct the problem, then execute deep print head cleaning.

Cleaning the print heads consumes ink, so clean the print heads only when 
necessary.

 Cleaning the Print Heads

 Cleaning the Print Heads

You can also start print head cleaning with the RESUME button on the 
printer. Press and hold down the RESUME button until the POWER light 
flashes once, and then release it.

Note

Windows

Macintosh

Note
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Replacing the Ink Tanks

When you purchase extra ink tanks, make sure that you get the correct ink 
tanks for each BJ cartridge.

• For BC-30e Black BJ Cartridge:
BCI-3eBk Black Ink Tank

  BC-30e Black BJ Cartridge 

• For BC-31e Color BJ Cartridge: 
BCI-3eC Cyan Ink Tank 
BCI-3eM Magenta Ink Tank 
BCI-3eY Yellow Ink Tank

  BC-31e Color BJ Cartridge 

• For BC-32e Photo BJ Cartridge: 
BCI-3ePBk Photo Black Ink Tank 
BCI-3ePC Photo Cyan Ink Tank 
BCI-3ePM Photo Magenta Ink Tank 

  BC-32e Photo BJ Cartridge (optional)

Make sure that the printer is turned on and open the front cover. The 
cartridge holder moves to the left side.

Note

1
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Replacing the Ink Tanks

• If you need to replace more than one ink tank, do not remove the ink 
tanks together. Remove and replace each ink tank one by one to ensure 
that each new ink tank is inserted in the correct slot. If you insert an ink 
tank in the wrong slot, colors will not print correctly.

• To avoid interfering with the ink supply from a tank, never touch the
opening on an ink tank.

To remove the empty ink tank, press in on the tab on the ink tank to release 
it; then lift it out of the slot.

Do not remove the BJ cartridge!  Leave the BJ cartridge installed in the 
printer and remove only the ink tank(s).

Note

2

Fix tab
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Replacing the Ink Tanks

• Discard empty ink tanks according to the local laws and regulations
regarding disposal of consumables.

• To avoid staining your hands, clothing, or areas of your work site, do not
shake or drop ink tanks when you are handling them.

Remove the new ink tank from its package. Pull the orange tape up and 
against the perforations to open the packing film.

• Remove the film carefully so you do not remove the label from the ink 
tank. The label is needed to match the ink tank with the correct slot of
the BJ cartridge.

• Remove the film by pulling on the orange tape. Do not attempt to
remove the film before you remove the orange tape.

Note

3

Note
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Replacing the Ink Tanks

Grip the bottom of the ink tank and twist off the orange protective cap in the 
direction of the arrow.

Do not attempt to reattach a protective cap to an ink tank. Discard the 
protective cap immediately.

4

Protective cap

To prevent ink spills, do not press this side of the ink tank.

Note
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Replacing the Ink Tanks

Hold the new ink tank at a slight angle and align it with the correct slot. 
Then insert the ink tank in its place.

Make sure you insert the ink tank into the correct slot of the cartridge 
holder.

To lock the ink tank in place, press down on top of the ink tank. Press down 
until the ink tank locks in place with a click.

5

6
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Replacing the Ink Tanks

Close the front cover.

The cartridge holder returns to the home position, and print head cleaning 
begins automatically.

The POWER light flashes during print head cleaning. When print head 
cleaning is complete and the POWER light stops flashing, you can resume 
normal operation.

7
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Replacing a BJ Cartridge

If print quality remains poor even after replacing the ink tanks and cleaning the print heads, 
the print head is worn out and you must replace the corresponding BJ cartridge.

Use only the following BJ cartridges with the S450 printer:

• BC-30e Black BJ Cartridge 

• BC-31e Color BJ Cartridge 

• BC-32e Photo BJ Cartridge (optional)

Make sure that the printer is turned on and open the front cover. The 
cartridge holder moves to the left side.

Note

1
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Replacing a BJ Cartridge

Raise the cartridge lock lever to unlock the BJ cartridge.
• If you are replacing a BC-30e Black BJ Cartridge or a BC-32e Photo 

BJ Cartridge, raise the left cartridge lock lever.

• If you are replacing the BC-31e Color BJ Cartridge, raise the right 
cartridge lock lever.

Make sure you raise the lever all the way up.

To avoid staining your hands, clothing, or areas in your work site, handle 
the BJ cartridge carefully. Avoid dropping or shaking the BJ cartridge.

2

Cartridge lock lever

Note
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Replacing a BJ Cartridge

Remove the entire BJ cartridge with the ink tanks in place.

• If you are removing a partially used BJ cartridge, store it in the Ink
Cartridge Storage Box.

• Always hold the BJ cartridge by the handles embossed on the left and
right sides of the BJ cartridge. Do not touch the metal contacts or the
print head on the BJ cartridge.

 Notes on Handling BJ Cartridges

3

Note
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Replacing a BJ Cartridge

Remove a new BJ cartridge from its package. Remove the orange 
protective cap then slowly remove the orange protective tape.

• Do not attempt to reattach the tape or cap to the BJ cartridge. Discard
the protective cap and tape immediately.

• To avoid poor print quality, do not touch the print head area of the 
BJ cartridge.

4

Protective tape

Protective cap

Note



296Routine Maintenance

Replacing a BJ Cartridge

Set the BJ cartridge in the cartridge holder, then lower the cartridge lock 
lever until it locks in place.

When you install either a BC-30e Black BJ Cartridge or an optional BC-32e 
Photo BJ Cartridge, insert it into the left side of the cartridge holder. You 
insert the BC-31e Color BJ Cartridge into the right side of the cartridge 
holder.

Press in on the tab of the protective cartridge insert and remove it.

5

Note

6
Fix tab
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Replacing a BJ Cartridge

Insert the ink tank(s) in the new BJ cartridge.

You can use new ink tanks or the ink tanks from the worn BJ cartridge.

 Replacing the Ink Tanks

Install an ink tank immediately after removing it from the worn BJ cartridge 
or its package. If an ink tank remains exposed for a long period, it may run 
out of ink quickly after it is installed.

Close the front cover.

The cartridge holder returns to the home position and print head cleaning 
begins automatically. Do not open the front cover during print head 
cleaning.

After you replace a BJ cartridge, always align the print heads.

 Aligning the Print Heads

7

Note

8
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Aligning the Print Heads

Two BJ cartridges are always installed in the S450 printer. Each time you replace a 
BJ cartridge or switch BJ cartridges for a special print job, you must align the print heads 
to ensure optimum printing.

There are two ways to align the print heads: automatically or manually. Normally you will 
execute the automatic print head alignment feature of the printer driver.  If this does not 
work for some reason, then you can execute manual print head alignment.

 Aligning the Print Heads

 Aligning the Print Heads

Windows

Macintosh
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Cleaning the Printer

With routine use paper dust and room dust may accumulate around the paper output tray 
and other parts of the printer. Clean the printer periodically.

• To avoid personal injury from burns or electrical shock or damage to the 
printer during cleaning, do not use a flammable solvent such as thinner, 
benzene, or alcohol.

• To avoid personal injury from touching printer components, always unplug 
the printer before cleaning.

• Do not unplug the power cord when the POWER light is on or flashing. 
This may damage the printer.

Press the POWER button ( ) to turn the printer off. Check the POWER 
light and make sure that it is not on or blinking.

Make sure that the POWER light is off, then unplug the power cord from the 
power outlet.

Caution

1

2
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Cleaning the Printer

Remove the paper output tray and wipe the paper output area with a soft 
cloth.

3
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Transporting the Printer

Use the original box and packing material to repack the printer for shipping or moving to 
another location. (When you do not use the original box, make sure that the printer is 
packaged properly so that it does not get damaged during transportation.)

Make sure that the printer is turned on and open the front cover. The 
cartridge holder moves to the left side.

Raise the cartridge lock lever to unlock the BJ cartridge.

Remove the entire BJ cartridge with the ink tanks in place.

• Always hold the BJ cartridge by the handles embossed on the left and 
right sides of the BJ cartridge. Do not touch the metal contacts or the 
print head area on the BJ cartridge.

• To avoid staining your hands, clothing, or areas in your work site, handle 
the BJ cartridge carefully. Avoid dropping or shaking the BJ cartridge.

• If you are removing a partially used BJ cartridge, store it in the Ink
Cartridge Storage Box.

 Notes on Handling BJ Cartridges

Lower the cartridge lock lever.

1

2

3

Note

4



302Routine Maintenance

Transporting the Printer

Press the POWER button ( ) while leaving the front cover open. The 
POWER light turns off and the cartridge holder remains in the same 
position. Now unplug the power cord from the power outlet.

Fix the cartridge holder with tape and the cartridge lock lever with packing 
material.

Close the front cover.

Lower the paper rest.

Remove the paper output tray.

5

6

7

8

9
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Transporting the Printer

Disconnect the printer cable from your computer and printer, and 
disconnect the power cord from the printer. (Illustration shows use of a 
parallel printer cable.)

Reattach the tape and packing material to the printer and insert the printer 
into its plastic bag. 

10

11

Packing material

Tape
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Transporting the Printer

Fit the packing material on either end of the printer and pack the printer into 
the original box.

If you are shipping the printer through a shipping agent, mark the box with 
FRAGILE or HANDLE WITH CARE.

12

Note
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Troubleshooting

Printout Is Unsatisfactory

Printer Does Not Start or Stops Mid-Job

Paper Jams or Does Not Feed

The POWER Light Flashes Orange

An Error Message Appears

Other Problems

Before You Call for Help

Getting Help From Canon
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Printout Is Unsatisfactory

Colors not clear
Printed and on-screen colors do not match
Meaningless characters or symbols printed
Text cut off at bottom right corner, right edge, or bottom edge
Colors streaked or wrong
Straight lines are broken
Printed pages curled
Backs of pages stained with ink
Ink blurred
Printed surface scratched
White streaks visible
Colors streaked or uneven
Last part of print job not printing
Characters and figures notched/gradation streaked or unnatural
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Printout Is Unsatisfactory

�  Colors not clear
The colors in printed photographs and illustrations are not as clear as you expected.

Check 1 BJ CARTRIDGE AND MEDIA CORRECT FOR THE PRINT JOB?

For printing photographs or illustrations, use of High Resolution Paper, 
Glossy Photo Paper, or High Gloss Photo Film is recommended. These 
media provide better color reproduction and brighter colors than plain 
paper.

For best results, use the combination of the BC-31e Color BJ Cartridge 
and the optional BC-32e Photo BJ Cartridge. 

For printing color graphs or charts with text, use the combination of the 
BC-30e Black BJ Cartridge and the BC-31e Color BJ Cartridge.

A clogged or worn BJ cartridge may also cause printing problems. 
Print a Nozzle Check Pattern and check the printed patterns.

 Printing a Nozzle Check Pattern

Check 2 PRINTER DRIVER SETTINGS CORRECT FOR MEDIA AND PRINT JOB?

Open the Printer Properties dialog box and select the print mode best 
suited for the print job in the Choose Print Mode box under the Main tab.

Also make sure that the BJ Cartridge and Media Type settings match the 
BJ cartridge and media currently set in the printer.

 Using the Windows 98/95 Printer Driver
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Printout Is Unsatisfactory

You may also want to click the Advanced button in the Main tab. Click the 
Color tab, check that Color Adjustment is enabled, and then adjust the 
Color settings such as Color Balance, Output Style, and Brightness.

Select the Color panel and change the settings such as the Matching 
Method.

Check 3 RE-FILLED INK TANK INSTALLED IN THE BJ CARTRIDGE?

You may not be able to achieve satisfactory performance with an ink tank 
that does not contain genuine Canon ink. It is recommended that you use 
genuine Canon ink tanks especially designed for use with the Canon BJ 
cartridges.

 Replacing the Ink Tanks

Note

Windows

Macintosh
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Printout Is Unsatisfactory

�  Printed and on-screen colors do not match
The colors you see on the screen do not match the colors you see in the printed copy of the 
same image. For example, objects that appear blue on the screen are printed purple and 
objects that appear pale green on the screen are printed dark green.

A color display and printer do not reproduce color in the same way. The printed color tones 
may not perfectly match the colors you see on the screen because screen colors vary 
based on how the screen is viewed and calibrated.

If the differences between displayed and printed colors are extreme, check the following.

Check 1 IS THE INK IN THE BJ CARTRIDGE IN GOOD CONDITION?

If there are wide differences between the screen colors and printed colors, 
one of the ink tanks may have run out of ink or some of the print head 
nozzles may be clogged. Print a Nozzle Check Pattern and check the 
results.

 Printing a Nozzle Check Pattern

Check 2 IS THE INK TANK INSTALLED IN THE CORRECT SLOT OF THE CARTRIDGE 
HOLDER?

Make sure that you install the ink tanks in the correct slots of the 
BJ cartridge.

 Replacing the Ink Tanks
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Printout Is Unsatisfactory

Check 3 ARE THE PRINTER DRIVER SETTINGS CORRECT?

Open the Printer Properties dialog box and select the print mode best 
suited for the print job in the Choose Print Mode box under the Main tab.

Also make sure that the BJ Cartridge and Media Type settings match the 
BJ cartridge and media currently set in the printer.

 Using the Windows 98/95 Printer Driver

If Monochrome Effects is selected for Special Effects, the colors displayed 
on the screen may differ from those that are printed. Make sure the correct 
settings are selected.

You may also want to click the Advanced button in the Main tab; then click the 
Color tab and adjust the color settings such as Color Balance, Output Style 
and Brightness. If Color Adjustment is off, click the checkbox to turn it on.

Use Manual for printing.

Note

Windows

Macintosh
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Printout Is Unsatisfactory

�  Meaningless characters or symbols printed
The document is displayed correctly on the screen but meaningless text and symbols are 
printed.

Check 1 ARE YOU USING THE CORRECT PRINTER DRIVER? 

Meaningless characters and symbols may print if you have selected the 
wrong printer driver for the print job.

Start the print procedure again and make sure that Canon S450 is 
displayed in the Name entry box of the Print dialog box.

If another driver is selected, click the down-arrow and select Canon 
S450 from the pull-down list.

If you use only the Canon S450 printer, select the Canon S450 as the 
default printer. Click Start, Settings, and then Printers. Highlight the S450 
icon and right-click. Click “Set as default”; make sure a checkmark appears 
next to “Set as default”.

Check 2 ARE THE PRINTER AND COMPUTER SECURELY CONNECTED?

Check the printer cable connections at the printer and computer. A faulty or 
loose connection can generate meaningless characters and symbols to 
print.

Windows

Note
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Printout Is Unsatisfactory

Check 3 IS THE PROBLEM IN THE ORIGINAL FILE?

If meaningless characters or symbols are printed only when you print a 
certain file, the cause of the problem may be in the file or the application 
program you are using. Rebuild the file and print it again.

If the rebuilt file prints correctly, the original file was probably faulty.

If the rebuilt file does not print correctly, contact the applications company.

 Before You Call for Help
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Printout Is Unsatisfactory

�  Text cut off at bottom right corner, right edge, or bottom edge
The text is printing in the bottom right corner of the page or printing beyond the right or 
bottom margins and cut off from view.

Check IS SCALED PRINTING SET FOR ENLARGEMENT IN THE PRINTER DRIVER?

If Scaled Printing is set for enlargement in the printer driver, the document 
is enlarged and printed in the bottom right corner, or cut off at the bottom or 
right edge of the paper.

If you want to use Scaled Printing with enlargement, make sure that the 
correct percentage is set and confirm that the Page Size selection is 
correct.

To disable Scaled Printing, open the Printer Properties dialog box, click the 
Page Layout tab, and click Normal-size Printing.

 Using the Windows 98/95 Printer Driver

To disable Scaled Printing, select Page Setup from the File menu and set 
100% in the Scale box.

 Using the Macintosh Printer Driver

Windows

Macintosh
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Printout Is Unsatisfactory

�  Single file page prints over two or more pages
Check DOES THE PAGE SIZE SETTING IN THE APPLICATION 

PROGRAM AND PRINTER DRIVER MATCH?                 

Set the same Page Size setting for the application program and the printer 
driver.

Open the Printer Properties dialog box, click the Page Layout tab, and 
select the Page Size that matches the Page Size setting in the application 
program.

Windows
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Printout Is Unsatisfactory

�  Colors streaked or wrong
The text appears scratched, streaked, or the wrong colors are printed.

Check 1 IS THE INK IN THE BJ CARTRIDGE IN GOOD CONDITION?

If text or images are streaked, scratched, faint, or if the wrong colors are 
printing, one of the ink tanks may have run out of ink, the print nozzles may 
be clogged, or the print head may be worn out.

Print a Nozzle Check Pattern and check the printed patterns.

 Printing a Nozzle Check Pattern

Check 2 HAS THE PROTECTIVE TAPE OR CAP BEEN REATTACHED TO THE 
BJ CARTRIDGE?

After removing the orange protective cap and tape, do not attempt to 
re-attach them to the BJ cartridge. Re-attaching the tape or cap can cause 
air bubbles, trap dirt or dust, and clog the ink nozzles.

If the protective tape or cap has been re-attached, remove it. Install the 
BJ cartridge in the printer and clean the print heads immediately.

Check 3 DID YOU PRINT ON THE CORRECT PRINT SIDE OF THE MEDIA?

The correct print side is different for each type of media.

Make sure that the correct print side is facing up when you load the media 
in the auto sheet feeder.

 Paper and Other Print Media—Print Side
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Printout Is Unsatisfactory

�  Straight lines are broken
Check 1 HAVE THE PRINT HEADS BEEN ALIGNED?

Each time you install a BJ cartridge, you must align the print heads. If you 
do not align the print heads, straight lines may appear broken or uneven.

 Aligning the Print Heads

Check 2 IS PRINT QUALITY SET TO FAST IN THE PRINTER DRIVER?

Changing Print Quality to Fine in the printer driver may improve the quality 
of printed straight lines. 

Open the Printer Properties dialog box.

Click the Advanced button in the Main tab.

In the Quality tab, drag the slide bar to the right to select Fine.

When using Manual for printing, click the Details button in the Printer 
Properties dialog box.

In the Quality panel, drag the slide bar to the right to select Fine.

Windows

1

2

3

Macintosh

1

2
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Printout Is Unsatisfactory

Check 3 IS THE PAPER THICKNESS LEVER SET CORRECTLY?

If straight lines are printed uneven or broken after changing the setting of 
the paper thickness lever on the front of the printer, re-align the print heads.

 Aligning the Print Heads

�  Printed pages curled
As printed pages are ejected from the printer, they are curled or wavy.

Check 1 ARE YOU PRINTING ON THIN PAPER?

The large amount of ink used to print color photographs and illustrations 
can cause printed pages to curl or warp.

For such cases, be sure to use special media such as High Resolution 
Paper or Glossy Photo Paper.

When you use High Resolution Paper, Glossy Photo Paper, or other special 
media, always load the pages with the print side (whiter side) facing up. 
Only one side of these media is treated with a special coating for better ink 
absorption.

Check 2 IS THE PRINTER DRIVER SET FOR HIGH DENSITY PRINTING?

Move the Intensity setting (print density) in the Color tab to a lower setting 
and execute the print job again. A lower Intensity setting uses less ink and 
thus causes less curling of the printed page. 

Note
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Printout Is Unsatisfactory

Open the Printer Properties dialog box and click the Advanced button in 
the Main tab.

Click the Color tab.

Use the Intensity slide bar to change the Intensity setting.

When using Manual for printing, click the Details button in the Printer 
Properties dialog box.

Click the Color panel, and use the Density slide bar to change the intensity 
setting.

Curling occurs most frequently with small paper sizes such as A5. 
To avoid this curling problem, try not to use small paper sizes to print 
documents that contain photographs or illustrations.

Windows

1

2

3

Macintosh

1

2

Note
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Printout Is Unsatisfactory

�  Backs of pages stained with ink
The backs of pages are stained after they are printed and ejected from the printer.

Check IS GRAYSCALE PRINTING BEING PERFORMED?

If you are performing grayscale printing, the backs of the pages may be 
stained with ink. You may be able to eliminate this problem by reducing the 
black density on the printer driver setting screen.

Open the Printer Properties dialog box and click the Advanced button in 
the Main tab.

Click the Color tab. 

Use the Black slide bar to change the print density setting.

If this does not produce an improvement, try using the optional BC-32e 
Photo BJ Cartridge (with the BC-31e Color BJ Cartridge) to perform your 
printing.

When using Manual for printing, click the Details button in the Printer 
Properties dialog box.

In the Color panel, use the Black slide bar to change the print density 
setting.

Windows

1

2

3

Macintosh

1

2



320Troubleshooting

Printout Is Unsatisfactory

�  Ink blurred
The ink has blurred in the print job; images are not sharp and the ink has spread and run 
together.

Check 1 ARE YOU USING PLAIN PAPER?

If you are using plain paper, use another type of print media. To minimize 
ink spread, use High Resolution Paper, Glossy Photo Paper, or High Gloss 
Photo Film.

Check 2 IS THE PRINT HEAD DIRTY?

Clogged print head nozzles can cause ink spread and blurring, so clean the 
print heads.

 Cleaning the Print Heads

Check 3 IS THE PRINTER DRIVER SET FOR HIGH-DENSITY PRINTING?

The Intensity setting in the printer driver can be used to adjust print density 
(that is, the amount of ink used to print).

Lowering the print density setting can reduce the tendency for ink to spread 
in color photographs or illustrations.
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Printout Is Unsatisfactory

Open the Printer Properties dialog box and click the Advanced button in 
the Main tab.

Click the Color tab.

Use the Intensity slide bar to change the intensity setting.

When using Manual for printing, click the Details button in the Printer 
Properties dialog box.

In the color panel, use the Density slide bar to change the print density 
setting.

Windows

1

2

3

Macintosh

1

2
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Printout Is Unsatisfactory

�  Printed surface scratched
The print side of the paper is scratched and stained.

Check 1 ARE YOU PRINTING ON THICK PAPER?

If you print on thick paper, the print head may scratch the printed surface of 
the page. If you experience difficulty when printing on thick paper, clean the 
print heads.

 Cleaning the Print Heads

Check 2 IS THE PAPER THICKNESS LEVER SET CORRECTLY?

When you use thick paper such as envelopes or Artist Canvas, set the 
paper thickness lever to the Down position.

If the printed surface is scratched or stained on plain paper, it may also help 
to set the paper thickness lever to the Down position.

Check 3 ARE YOU PRINTING ON CURLED PLAIN PAPER?

If curled plain paper is loaded with the curl bowing up, the print heads may 
scratch the bottom edge of the paper.

Try to uncurl the paper. If necessary, turn the paper over, and load it in the 
sheet feeder again.
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Printout Is Unsatisfactory

Check 4 ARE YOU EXECUTING A HIGH-DENSITY PRINT ON PLAIN PAPER?

If you execute a high-density print job on plain paper, the paper may absorb 
too much ink and curl, and the print heads may scratch the surface of the 
curled page. Lower the Intensity setting.

Open the Printer Properties dialog box, and click the Advanced button in 
the Main tab.

Click the Color tab.

Use the Intensity slide bar to change the print density setting.

Check 5 ARE YOU PRINTING OUTSIDE THE RECOMMENDED PRINTING AREA?

If you print outside the recommended printing area, the print heads may 
scratch the bottom edge of the page. To avoid problems, print only in the 
recommended printing area.

When you print on High Gloss Photo Film or Back Print Film, the bottom 
margin must be larger than 1.02 in. (26 mm).

 Printing Area

Windows

1

2

3

Note
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Printout Is Unsatisfactory

�  White streaks visible
Check PRINT A NOZZLE CHECK PATTERN.

If colors are broken or missing, clean the print heads.

If lines are not aligned properly, align the print heads.

If any portion of the Nozzle Check Pattern is streaked, the print heads 
could be clogged, may not be aligned properly, or the BJ cartridge may be 
worn out.

If the problem persists after cleaning the print heads and aligning the print 
heads, try replacing the BJ cartridge.

If the Nozzle Check Pattern prints normally, there may be a problem in the 
application program. For details, refer to the Troubleshooting sections of the 
documentation of your application program.

 Printing a Nozzle Check Pattern

Note
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Printout Is Unsatisfactory

�  Colors streaked or uneven
Patterns of uneven or streaked coloring appear on the printout.

Check 1 IS PRINT QUALITY ON THE QUALITY TAB IN THE PRINTER DRIVER SET 
TO FAST?

Set Print Quality to Fine and print again. This reduces uneven coloration 
you may see in a document where a large amount of ink is used.

Open the Printer Properties dialog box.

Click the Advanced button in the Main tab.

In the Quality tab, drag the slide bar to the right toward Fine and click the 
OK button.

When using Manual for printing, click the Details button in the Printer 
Properties dialog box.

In the Quality panel, drag the slide bar to the right toward Fine.

Windows

1

2

3

Macintosh
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Printout Is Unsatisfactory

Check 2 IS HALFTONING SET FOR OPTIMUM PERFORMANCE?

Check the Halftoning setting in the Quality tab of the printer driver. The 
Diffusion setting smoothes uneven or streaked colors.

Open the Printer Properties dialog box.

Click the Advanced button in the Main tab.

In the Halftoning box under the Quality tab, disable Auto if it is checked and 
enabled.

Click Diffusion and click the OK button.

When using Manual for printing, click the Details button in the Printer 
Properties dialog box.

In the Quality panel, set Halftoning to Scatter.

Windows

1

2

3

4

Macintosh
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Printout Is Unsatisfactory

�  Last part of print job not printing
The last part of each page in the document is not printed.

Check 1 ARE YOU USING THE PAPER SIZE SPECIFIED IN THE PAGE SIZE 
SETTING?

If the size of the paper loaded in the printer does not match the Page Size 
setting in the printer driver, part of each page may not print.

Check the Page Size or Paper Size setting. If it does not match the size of 
the paper you are using, click the down-arrow and select the correct size 
from the pull-down list.

Check the Page Layout tab.

Check the Page Setup dialog box.

Set the same Page Size setting for the application program and the printer 
driver.

Set the Page Size that matches the Page Size setting in the application 
program.

Check 2 ARE THE COMPUTER AND PRINTER SECURELY CONNECTED?

Check the connection of the printer cable at the computer and printer. A 
loose connection can cause losing part of a print job.

Windows

Macintosh

Note
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Printout Is Unsatisfactory

Check 3 IS A WPS PRINTER DRIVER INSTALLED?  

You may not be able to print correctly with a WPS (Windows Printing 
System) printer driver installed in your system. Confirm whether or not a 
WPS driver is installed in your system.

Change the WPS driver port setting to FILE or delete the WPS driver.

Open the WPS Driver Properties window.

In the Details tab, select FILE in the Print to Port setting.

To delete the WPS driver, select Programs and then Windows Printing 
System from the Windows Start menu and click Uninstall.

Windows

1

2

3
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Printout Is Unsatisfactory

�  Characters and figures notched/gradation streaked or unnatural  
Characters and figures print with unnatural notches.

Gradation appears streaked.

Check ARE YOU USING AN APPLICATION PROGRAM THAT ONLY SUPPORTS 
POSTSCRIPT?

The S450 is a QuickDraw printer and is not a PostScript printer. Therefore, 
if you use an application program that supports only PostScript, the lines of 
characters and figures may print with unnatural notches. Always use an 
application program that supports QuickDraw.

Some PostScript application programs have a setting that allows you to use 
ATM fonts or TrueType fonts. When you specify the ATM fonts or TrueType 
fonts in the application program, then characters, figures and gradation can 
be reproduced properly.

Windows
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Printer Does Not Start or Stops Mid-Job

Printer does not turn on

Print job does not start

Printing halts

Printing starts but nothing prints

Cartridge holder does not move to the center
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Printer Does Not Start or Stops Mid-Job

�  Printer does not turn on
The printer does not turn on when you press the POWER button.

Check 1 HAVE YOU PRESSED THE POWER BUTTON FIRMLY?

Press the POWER button fully down, then release it. If you do not press the 
button hard enough, the printer may not turn on.

Check 2 IS THE POWER CORD PLUGGED IN?

Make sure that the power cord is plugged into a power outlet.

Check 3 IS THE POWER OUTLET LIVE?

Connect another electrical device to the same power outlet. If the other 
device operates normally, the power outlet is functioning normally.

If you perform all these checks and the problem is not solved, unplug the 
printer and contact the Canon Customer Care Center.

 Before You Call for Help

 Getting Help From Canon
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Printer Does Not Start or Stops Mid-Job

�  Print job does not start
Printer does not operate after print job is executed from the computer.

Check 1 IS THE PRINTER TURNED ON?

Check the POWER light to see if it is green.

If the POWER light flashes green, the printer is either warming up or 
receiving data.

When the POWER light is on, the printer is ready to use.

Check 2 ARE YOU PRINTING A VERY LARGE FILE?

A very large file may require some time to process before printing begins. 
Photographs and illustrations can increase the size of a file. For a very 
large file, wait a few minutes for the print job to begin.

Check the POWER light. If the POWER light flashes green, the computer is 
sending print data to the printer and the job is executing normally.

Check 3 ARE THE PRINTER AND COMPUTER SECURELY CONNECTED?

Check the printer cable connections at the printer and computer. A faulty or 
loose connection can prevent the printer from starting.
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Printer Does Not Start or Stops Mid-Job

Check 4 ARE YOU USING THE CORRECT PRINTER DRIVER?

A print job may not start if you have selected the wrong printer driver for the 
print job.

Check that Canon S450 is displayed in the Name entry box of the Print 
dialog box.

If another driver is selected, click the down-arrow and select Canon 
S450 from the pull-down list.

If Canon S450 does not appear in the list, you must install the printer driver.

If you use only the Canon S450 printer, select the Canon S450 as the 
default printer. Click Start, Settings, and then Printers. Highlight the S450 
icon and right-click. Click “Set as default”; make sure a checkmark appears 
next to “Set as default”.

Select S450 from the Chooser of the Apple menu.

Windows

Note

Macintosh
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Printer Does Not Start or Stops Mid-Job

Check 5 IS THE CORRECT PRINTER PORT SELECTED?  

If you are using the parallel interface to connect your printer, set your 
printer port to LPT1. 

If you are using USB Interface to connect your printer, set your printer port 
to USBPRN.

Open the Printer Properties dialog box: click Start, select Settings, and 
click Printers. Highlight the Canon S450 icon and right-click. Now select 
Properties.

Click the Details tab and select LPT1 or USBPRN in the Print to the 
following port box (LPT1: Canon BJ LPT Printer Port).

Windows

1

2
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Printer Does Not Start or Stops Mid-Job

�  Printing halts
The printer stops printing before the print job is complete.

Check 1 IS THE PRINT JOB A FINELY DETAILED PHOTOGRAPH OR 
ILLUSTRATION?

The printer requires more time to process a finely detailed illustration or 
photograph.

Check the POWER light. If the POWER light flashes green, the computer is 
sending print data to the printer and the job is executing normally.

If the print job requires a large amount of black ink on plain paper, the print 
job may require more time.

Check 2 HAS THE PRINTER BEEN OPERATING FOR A LONG TIME?

The print heads may occasionally overheat during a long print job.

If the print heads overheat, printing pauses at the end of a pass across the 
page to allow time for the print heads to cool and then restarts after a brief 
interval. Interrupt printing at a convenient point, turn the printer off, and wait 
for at least 15 minutes for the print heads to cool.

If the printer overheats while printing a densely colored photograph or 
illustration, the printer may beep and stop printing to protect the print 
heads. In this case, you cannot continue printing. Turn the printer off and 
wait at least 15 minutes for the print heads to cool.

To avoid minor burns, never touch the print heads or the surrounding area.Caution
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Printer Does Not Start or Stops Mid-Job

�  Printing starts but nothing prints
The printer operates but nothing is printed on the page.

Check 1 IS THE INK IN THE BJ CARTRIDGE IN GOOD CONDITION?

The print head nozzles may be clogged, one or more of the ink tanks may 
be low, or the BJ cartridge may be worn.

Visually check the level of the ink in the ink tanks. If the tanks are empty, 
replace them.

 Replacing the Ink Tanks

Next, print a Nozzle Check Pattern to check the status of the print heads 
and clean the print heads.

 Printing a Nozzle Check Pattern

 Cleaning the Print Heads

If the problem is not solved, replace the BJ cartridge.

 Replacing a BJ Cartridge

If you can print a Nozzle Check Pattern, check that the printer is connected 
to the computer securely. If the connection is loose, printing starts but 
nothing may be printed.

Also check that there is no problem with the original file.
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Printer Does Not Start or Stops Mid-Job

Check 2 DID YOU REMOVE THE ORANGE PROTECTIVE TAPE FROM THE PRINT 
HEAD?

If the orange protective tape is not removed from the BJ cartridge, ink 
cannot be ejected from the BJ cartridge. Remove the BJ cartridge and 
check the print head.

If the tape has not been removed, remove it. 

Align the print heads before you resume printing.

 Replacing a BJ Cartridge

 Aligning the Print Heads
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Printer Does Not Start or Stops Mid-Job

�  Cartridge holder does not move to the center
You want to switch the BJ cartridge, replace an ink tank, or replace the BJ cartridge, but the 
cartridge holder does not move to the center when you open the front cover.

Check 1 IS THE PRINTER TURNED ON?

Check the POWER light and make sure that it is green. If the POWER light 
is off, turn on the printer.

If you have just turned on the printer and the POWER light flashes green, 
the printer is warming up. Wait until the POWER light stops flashing.

Check 2 HAS THE FRONT COVER BEEN OPEN LONGER THAN 10 MINUTES?

If the front cover remains open longer than 10 minutes, the cartridge holder 
automatically returns to the home position to prevent the print heads from 
drying out.

Close the front cover and open it again. The cartridge holder moves to the 
center.



339Troubleshooting

Paper Jams or Does Not Feed

Paper does not feed from auto sheet feeder

Paper skews during feeding

Multiple sheets feed together

Paper jams
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Paper Jams or Does Not Feed

�  Paper does not feed from auto sheet feeder
After the print job is started, the paper loaded in the auto sheet feeder does not feed.

Check 1 IS THE PAPER TOO THICK?

Thick paper does not feed from the auto sheet feeder. Do not attempt to 
print on paper or other media thicker than .024" or 28 lb (0.6 mm or 
105 g/m2).

Check 2 IS THE SHEET FEEDER OVERLOADED?

The number of sheets you can load in the auto sheet feeder depends on 
the media you are using. The media does not feed correctly if you exceed 
the prescribed number of sheets.

Check 3 DID YOU RAISE THE PAPER REST?

Before you load media other than envelopes in the auto sheet feeder, you 
should always raise the paper rest. If you do not raise the paper rest before 
loading, the media does not completely enter the paper feed slot during 
feeding.

Check 4 IS THE PAPER FOLDED OR CURLED?

To avoid misfeeds and paper jams, never load paper in the auto sheet 
feeder that is folded, curled, or wrinkled.

 Media Sizes You Can Use With the Printer

 Media Types You Cannot Use With the Printer



341Troubleshooting

Paper Jams or Does Not Feed

�  Paper skews during feeding
The paper or other media does not feed straight into the paper feed slot.

Check 1 IS THE AUTO SHEET FEEDER OVERLOADED?

The number of sheets you can load in the auto sheet feeder depends on 
the media you are using. The media does not feed correctly if you exceed 
the prescribed number of sheets.

Check 2 IS THE PAPER FOLDED OR CURLED?

To avoid misfeeds and paper jams, do not load paper in the auto sheet 
feeder that is folded, curled, or wrinkled.

 Media Types You Cannot Use With the Printer

Check 3 IS THE PAPER GUIDE SET CORRECTLY?

If the paper guide on the auto sheet feeder is not set correctly, the paper 
does not feed straight or may jam in the printer.

The paper guide must be snug against the side of the stack and not too 
tight.
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Paper Jams or Does Not Feed

�  Multiple sheets feed together
More than one sheet feeds from the stack at the same time.

Check 1 DID YOU FAN THE STACK BEFORE LOADING?

Before loading a stack of media in the auto sheet feeder, always fan the 
pages to remove static cling and align the edges. Fanning the stack 
separates the sheets so they can feed smoothly from the auto sheet feeder.

Check 2 IS THE AUTO SHEET FEEDER OVERLOADED?

The number of sheets you can load in the auto sheet feeder depends on 
the media you are using. The media does not feed correctly if you exceed 
the prescribed number of sheets.

Check 3 IS THE PAPER FOLDED OR CURLED?

To avoid misfeeds and paper jams, never load paper in the auto sheet 
feeder that is folded, curled, or wrinkled.

 Media Types You Cannot Use With the Printer

Check 4 ARE YOU PRINTING ON TRANSPARENCIES?

When more than one transparency feeds from a stack at the same time, 
lower the paper rest, set the stack, and try again.

 Transparencies



343Troubleshooting

Paper Jams or Does Not Feed

�  Paper jams
If paper jams in the printer, remove it.

Slowly pull the paper out of the printer from the auto sheet feeder or the 
paper output slot, whichever is easier. (If the paper tears or shreds, open 
the front cover and remove all the fragments of paper.)

Close the front cover, load the paper, and then press the RESUME button.

1

2
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Paper Jams or Does Not Feed

• If the paper cannot be removed, press the POWER button twice to eject 
the paper automatically and start the print job again.

• Paper within the range of 17 to 28 lb (64 to 105 g/m2) can be loaded in the
auto sheet feeder.

 Media Sizes You Can Use With the Printer

• To avoid misfeeds and paper jams, do not load wrinkled, folded, or
curled paper in the auto sheet feeder.

 Media Types You Cannot Use With the Printer

Note
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The POWER Light Flashes Orange

When an error occurs, the POWER light flashes orange. The number of flashes indicates 
the cause of the problem.

Two flashes: Out of paper, paper jam, paper feed error

Three flashes: Paper jam

Four flashes: BJ cartridge out of ink

Five flashes: BJ cartridge not installed correctly

Six flashes: BJ cartridge not installed

Seven flashes: BJ cartridge defective

Eight flashes: Waste ink absorber almost full

The POWER light flashes orange and green alternately: Service error
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The POWER Light Flashes Orange

�  Two flashes: Out of paper, paper jam, paper feed error
If no paper is loaded in the auto sheet feeder, or if the paper is not loaded correctly, set the 
paper correctly and press the RESUME button.

If paper has jammed in the printer, remove the jam and press the RESUME button.

 Paper Jams or Does Not Feed

If the paper is not feeding into the auto sheet feeder, adjust the paper guide 
and insert the paper.

�  Three flashes: Paper jam
If paper has jammed in the printer, remove the jam and press the RESUME button.

 Paper Jams or Does Not Feed

Note
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The POWER Light Flashes Orange

�  Four flashes: BJ cartridge out of ink
An ink tank in a BJ cartridge has run out of ink.

Replace the empty ink tank and press the RESUME button.

 Replacing the Ink Tanks

�  Five flashes: BJ cartridge not installed correctly
One of the BJ cartridges is not installed correctly. Install a BJ cartridge for the S450. 

 BJ Cartridges You Can Use With the Printer

�  Six flashes: BJ cartridge not installed
One of the BJ cartridges is not installed. Select and install two BJ cartridges (black and 
color or photo and color) according to the work you are doing.

�  Seven flashes: BJ cartridge defective
There is a problem with one of the BJ cartridges installed in the printer.

Remove each BJ cartridge and check that the contacts on the BJ cartridge and cartridge 
holder are clean. Also check that the orange protective tape has been removed from the 
print head then install the BJ cartridge again.

If the error occurs again after you resume operation, replace the BJ cartridge.

 Replacing a BJ Cartridge
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The POWER Light Flashes Orange

�  Eight flashes: Waste ink absorber almost full
The printer has a built-in waste ink absorber to hold the ink that is consumed during print 
head cleaning.

Eight flashes indicate the waste ink absorber is nearly full. Press the RESUME button to 
skip the error so you can continue printing.

Call the Canon Customer Care Center for help to have the waste ink absorber replaced 
immediately.

 Getting Help From Canon

When the waste ink absorber becomes full, the POWER light flashes 
orange and green alternately, and printing will no longer be possible.

Call the Canon Customer Care Center.

�  The POWER light flashes orange and green alternately: Service error
A service error means the printer requires the attention of a qualified technician.

Count the number of flashes. (You may be asked for this information.) Call the Canon 
Customer Care Center.

 Before You Call for Help
 Getting Help From Canon

Note
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An Error Message Appears

Error writing to LPT1 or USBPRN  

Application error, general protection fault  

Other error messages

Windows

Windows
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An Error Message Appears

�  Error writing to LPT1 or USBPRN  

You cannot print when this message appears.

Check 1 IS THE PRINTER TURNED ON?

Check the POWER light to see if it is green.

If the POWER light flashes green, the printer is warming up.

After the POWER light is on, the printer is ready to use.

Check 2 ARE THE PRINTER AND COMPUTER CONNECTED PROPERLY?

Check the connections of the printer cable at the computer and the printer.

Check 3 IS PRINT SPOOLING OPERATING CORRECTLY?

Cancel spooling and send the print job directly to the printer. 

Open the Printer Properties dialog box from the Start menu: click Start, 
select Settings, and click Printers. Highlight the Canon S450 icon and right-
click. Select Properties.

Click the Details tab and click the Spool Settings button. Click the button 
for “Print directly to the printer.”

Windows

1

2
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An Error Message Appears

Check 4 IS THE PRINTER PORT OPERATING CORRECTLY? 

Check the status of the printer port.

When you are using the parallel interface:

Right-click the My Computer icon and select Properties from the pop-up 
menu.

Click the Device Manager tab, double-click Ports (COM & LPT), and then 
double-click Canon BJ LPT Printer Port (LPT1).

In the General tab, check that Original Configuration (Current) is enabled. 
An error occurs if this item is disabled. Read the message under Device 
Status and verify that no problem is indicated.

Click the Resources tab and read the message under Conflicting device 
list. If a conflict is indicated, reconfigure the competing device to another 
port.

When you are using the USB interface:

Right-click the My Computer icon and then select Properties from the pop-
up menu.

Click the Device Manager tab, select the Universal serial bus controller, and 
then double-click Canon S450.

In the General tab, note what is displayed. Resolve any problems.

1
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4
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An Error Message Appears

Check 5 IS THE PRINTER DRIVER INSTALLED CORRECTLY?

There may be a problem with the printer driver. Uninstall the printer driver 
and install it again.

 Uninstalling the BJ Printer Driver

See the Quick Start Guide for details on installing the printer driver.

Check 6 IS THE PRINTER PORT SETTING IDENTICAL TO THE INTERFACE YOU ARE 
USING?

If the printer port setting is not identical to the interface connected to the 
printer, an error message appears.

To check the printer port setting, open the Printer Properties dialog box and 
click the Details tab.

• If LPT1 is displayed in the “Print to the following port” box, the printer 
port is set to the parallel port.

• If USBPRN nn (nn: numerals) is displayed in the “Print to the following 
port” box, the printer port is set to the USB port.

If the printer port setting does not match the interface connected to the 
printer, shut down Windows and turn the printer off. Then connect the 
printer using the correct interface specified in the printer driver, or install the 
correct printer driver that matches the connected interface.
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An Error Message Appears

Check 7 IS A WPS DRIVER INSTALLED?

You may not be able to print correctly if a WPS (Windows Printing System) 
driver is installed on your computer.

Click Start, point to Settings, and click Printers.

If a WPS driver is installed, right-click the icon and then select Properties 
from the pop-up menu.

Click the Details tab and check the “Print to the following port” setting.

If the selected port is the port also used by the S450, change the WPS 
driver port setting to FILE or delete the WPS driver.

1
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An Error Message Appears

�  Application error, general protection fault    

Check 1 ARE YOU USING A WINDOWS 3.1 APPLICATION PROGRAM?

Attempting to print from a Windows 3.1 application program installed on a 
system with Windows 98 or Windows 95 may cause an error. Use a 
Windows 98 or Windows 95 compatible application program.

You cannot use the Canon S450 with the Windows 3.1 operating system.

Check 2 ARE SEVERAL APPLICATION PROGRAMS RUNNING IN THE 
BACKGROUND?

If you are running several application programs at the same time, there may 
not be enough memory available for the print job.

Quit the other application programs and try again.

Check 3 DOES THE COMPUTER HAVE SUFFICIENT MEMORY?

Make sure that you have the required amount of memory installed for the 
application program you are using to print.

For details, refer to the documentation for your application program.

If the amount of memory is insufficient, install more memory.

 Checking the Windows version and memory capacity

Windows

Note
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An Error Message Appears

Check 4 IS THERE SUFFICIENT FREE SPACE ON THE HARD DISK?

An error may occur if there is not enough free space available on the hard 
disk.

Check the amount of free space on the hard disk.

If there is little free space available on the disk, delete any unneeded files.

 Checking the amount of free space on hard disk

Check 5 IS THERE A PROBLEM IN THE FILE YOU ARE TRYING TO PRINT?

If these errors occur only when you try to print a particular file, there may be 
a problem in the file or the application program. Rebuild the file and try 
printing it again.

If there is no problem with the new file, the old file was probably faulty.

If the same error occurs with the new file, call either the software company 
or the Canon Customer Care Center.

 Before You Call for Help

Check 6 IS THE PRINTER DRIVER INSTALLED CORRECTLY?

There may be a problem with the printer driver. Uninstall the printer driver 
and install it again.

 Uninstalling the BJ Printer Driver

See the Quick Start Guide for details on installing the printer driver.
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An Error Message Appears

�  Other error messages
Check 1 AN ERROR DISPLAYED IN THE BJ STATUS MONITOR?   

When an error occurs, the BJ Status Monitor screen opens.

The Print Status tab displays a short description of the error and other 
information about the print job. Click the Guide tab to display instructions on 
how to solve the problem.

For problems that require more than one step in correcting the problem, 
click the Next button to see the next screen, or click the Back button to see 
the previous screen.

Check 2 AN ERROR DISPLAYED IN ANY SCREEN OTHER THAN   
THE BJ STATUS MONITOR?

One of the following messages may be displayed.

Delete any unneeded files to make more disk space available.

 Checking the amount of free space on hard disk

Quit any other application programs you are running in the background.

 Checking the Windows version and memory capacity

Windows

Windows

Insfficient disk space. ...

Insfficient memory. Cannot spool normally. ...
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An Error Message Appears

Uninstall the printer driver and reinstall it.

 Uninstalling the BJ Printer Driver

See the Quick Start Guide for details on installing the printer driver.

Restart Windows and try again.

Try printing again after the current job is finished.

Check 3 ANY ERROR NUMBER (XXXX:) DISPLAYED?  

Error number (*202) displayed

Sufficient memory not available for the application program.

Check that the required amount of memory is allocated to the application 
program.

If there is not enough memory installed, install more memory.

Refer to your computer documentation for information on installing 
additional memory.

Cannot read printer driver. ...

Background printing failed.

[Application name] cannot print. ... 

Macintosh
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An Error Message Appears

Error number (*203) displayed

Installed printer driver not operating correctly.

Remove the installed Macintosh printer driver and then install the printer 
driver again.

 Uninstalling the Printer Driver

See the Quick Start Guide for details on installing the printer driver.

Error number (*300) displayed

Check the following.

• Printer is turned on?

• Printer cable is connected securely?

Make sure that the printer cable is securely fastened to the 
computer and the printer.

If the problem cannot be solved, check the settings in the Chooser. 

Select the Chooser from the Apple menu.

Click the S450 icon.

Make sure that S450 is specified in the “Connect to” box.

1

2

3
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Other Problems

Cannot install the printer driver

BJ Status Monitor does not open 

Cannot execute background printing
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Other Problems

�  Cannot install the printer driver
Check 1 DID YOU FOLLOW THE PRINTER DRIVER INSTALLATION INSTRUCTIONS 

IN THE QUICK START GUIDE?

The Quick Start Guide provides step-by-step instructions for installing the 
printer driver. If you are reinstalling the printer driver, remove any other 
Bubble Jet printer drivers which have been installed on the computer before 
reinstalling the printer driver.

If an error occurred during installation and you had to shut down the 
installation procedure, you may not be able to install the printer driver 
because Windows is no longer stable. Restart Windows and then reinstall 
the printer driver.

Check 2 ARE ANY OTHER APPLICATION PROGRAMS RUNNING?

The installation program may not execute successfully if it is run with other 
applications running in the background.

Before you run the installation program again, shut down all other 
application programs.

If other BJ printer drivers are installed on your system, uninstall them 
before you run the installation program again.

Note
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Other Problems

Check 3 DID YOU SPECIFY THE CORRECT CD-ROM DRIVE FOR 
INSTALLATION?

If the printer driver installation program did not start automatically when you 
loaded the CD-ROM, double-click the My Computer icon, then double-click 
the CD-ROM icon on the Windows desktop.

For details about the installation procedure, refer to the Quick Start Guide.

• When you install the printer driver from Run in the Start menu, specify
the CD-ROM drive and file name (Setup.exe) correctly.

• The drive name (E:, for example) varies according to how your system 
is set up.

Check 4 IS THERE A PROBLEM WITH THE S450 CANON CREATIVE CD-ROM?

The S450 Canon Creative CD-ROM may be damaged. On the Windows 
desktop, double-click the My Computer icon then double-click the CD-ROM 
icon. If Windows cannot read the CD-ROM, call the Canon Customer Care 
Center.

 Before You Call for Help

 Getting Help From Canon

Windows

Note
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Other Problems

�  BJ Status Monitor does not open     

Check 1 DOES YOUR PRINTER CABLE SUPPORT BI-DIRECTIONAL 
COMMUNICATION?

Check the hardware specifications of your printer cable. Operation of the 
BJ Status Monitor requires bi-directional data transfer between the 
computer and printer. The printer cable must be capable of bi-directional 
data transfer.

Check 2 IS THE BI-DIRECTIONAL OPTION SELECTED IN THE PRINTER DRIVER?

Check the bi-directional option.

Open the Printer Properties dialog box from the Start menu.

Click the Details tab and click the Spool Settings button.

In the Spool Settings dialog box, click the button for “Enable bi-directional 
support for this printer.”

Windows
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Other Problems

�  Cannot execute background printing
The BJ Backgrounder is not displayed during a print job and you cannot use background 
printing.

Check 1 IS THERE ENOUGH FREE SPACE AVAILABLE ON THE HARD DISK?

You may not be able to print if there is not enough free space on the hard 
disk. Delete unneeded files to create more space.

 Checking the amount of free space on hard disk

If you are unable to make more space available on your hard disk by 
deleting files, turn background printing off.

Check 2 IS BACKGROUND PRINTING ENABLED IN THE PRINTER DRIVER?

Open the Printer Properties dialog box, then click the Page Layout tab.

Check Background Printing in the Background checkbox.

Select Chooser from the Apple menu.

Set Backgrounding to On.

Note

Windows

1

2

Macintosh
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Before You Call for Help

Narrowing down the problem

Checking the printing environment
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Before You Call for Help

�  Narrowing down the problem
If you are experiencing difficulties, try to narrow the problem down to one of these factors.

Printer problem

If the printer will not operate, or if the POWER light flashes orange and green alternately 
with beeps, call the Canon Customer Care Center. Count the number of flashes and beeps. 
(You may be asked for this information.)

Hardware problem other than the printer

If the printer is operating normally and the settings in the application program are also 
correct, there may be a problem with a printer cable or in the computer system (for 
example, memory, hard disk, or interface). Contact your computer manufacturer.

Application program problem

Problems that arise only when you use a particular application program are probably 
caused by the application program. For details, consult the software company.

The problem may also be solved by installing the latest version of the printer driver.
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Before You Call for Help

�  Checking the printing environment
Check the information on the operating environment such as the name and version number 
of your operating system, the amount of memory installed, hard disk capacity and amount 
of free space on hard disk, and the printer driver version number.

Checking the Windows version and memory capacity

Right-click the My Computer icon and select Properties from the pop-up 
menu.

On the General tab note the system name, version number, and memory 
capacity.

Select About This Computer from the Apple menu.

Windows

1

2

Macintosh
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Before You Call for Help

Checking the amount of free space on hard disk

On the Windows desktop, double-click the My Computer icon.

Right-click the icon of the hard disk and select Properties from the pop-up 
menu.

On the General tab, check the hard disk capacity and the amount of free 
space.

On the desktop, click the icon of the hard disk.

Select Get Info from the File menu.

Select General Information.

Windows

1

2

3

Macintosh

1

2

3
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Before You Call for Help

Checking the version number of the printer driver

On the Windows desktop, click the Start button, point to Settings, and click 
Printers.

Right-click the S450 icon and select Properties from the pop-up menu.

Click the Main tab and click the About button. The version number of the 
printer driver is displayed.

Double-click the Extensions Folder in the System Folder and then select 
the S450 icon.

Select Get Info from the File menu.

Select General Information. The version number of the printer driver is 
displayed.

Windows

1

2

3

Macintosh

1

2

3
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Getting Help From Canon

Canon Computer Systems, Inc. offers a full range of customer technical support* options 
including:

• For e-mail technical support, the latest driver downloads and answers to 
frequently asked questions (www.ccsi.canon.com)

• 24-hour, 7-day-a-week,automated support for troubleshooting issues on most 
current products (1-800-423-2366)

• 24-hour, Fax-On-Demand System for product specifications and technical 
information (1-800-526-4345)

• Free technical support Monday-Saturday (excluding holidays) for products still 
under warranty** 
(1-757-413-2848)

• Technical support 7 days a week (excluding holidays) for products no longer 
under warranty, for $24.99 per call (1-800-423-2366), or for $2.50 per minute, to 
a maximum of $25.00 per call (1-900-246-1200)

• For information about extending your Canon service and support up to an 
additional two years, call 1-800-385-2155, or visit our Web Site at 
www.ccsi.canon.com (within 90 days from the date you purchase your Canon 
peripheral).

Within Canada, call for technical support 24 hours a day, 7 days a week 
(1-800-OK-CANON)

* Support program specifics subject to change without notice.
**Refer to individual product information for warranty details.

Note
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System Requirements
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General Specifications

Printing method
Bubble Jet on-demand

Printing resolution
• Black and color: 1440 (horizontal) x 720 (vertical) dpi 
• Photo: 720 x 720 dpi

Print speed (printing with Canon standard pattern)
• Black: 10 ppm 
• Color: 7 ppm

Print direction
Bi-directional

Print width
8 in. (203.2 mm) max.

Receive buffer
128 KB max.

Interface (parallel)
IEEE 1284-compatible
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General Specifications

Interface (USB)
USB 1.1-compatible 

Interface connector (parallel)
Amphenol 57-40360 or equivalent

Interface connector (USB)
USB standard Series B receptacle (USB interface)

Recommended parallel printer cable — IEEE 1284-compatible
• Material AWG28 or larger
• Type Twisted-pair shielded cable
• Length Up to 6.5 ft (2.0 m)
• Connectors Amphenol 30360 or equivalent

Recommended USB printer cable
• Material AWG28 (data wiring pair) or AWG20 to 28 

(distribution pair)
• Type Twisted-pair shielded cable
• Length Up to 16.4 ft (5.0 m)
• Connectors USB standard Series B pluggable

Acoustic noise level
Less than approx. 45 dB (per ISO 9296)
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General Specifications

Operating environment
• Temperature 41 to 95˚F (5 to 35˚C)
• Humidity 10 to 90% RH (no condensation)

Storage environment
• Temperature 32 to 95˚F (0 to 35˚C)
• Humidity 5 to 90% RH (no condensation)

Power supply
USA/Canada                 AC 120V, 60Hz

Power consumption
• Off Approx. 1W (AC 230±10%)

Approx. 1W (AC 120V)
• Standby Approx. 3W (AC 230±10%)

Approx. 3W (AC 120V)
• Printing Approx. 30W

Dimensions (with paper rest and paper output tray retracted)
• 17.9" x 12.3" x 6.8" (W x D x H)
• 455 x 312 x 173 mm (W x D x H)

Weight
Approx. 9.5 lb. (4.1 kg)
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General Specifications

Sheet feeder capacity

• Plain paper (17 lb. or 64 g/m2) 100 sheets max.
• Artist Canvas 1 sheet
• Back Print Film 10 sheets max.
• Banner Paper 1 sheet (2 to 6 sheets in length)
• Glossy Photo Cards 1 sheet
• Glossy Photo Paper 10 sheets max.
• Greeting Cards 1 sheet
• High Gloss Photo Film 1 sheet
• High Resolution Paper 80 sheets max.
• Magnet Sheet 1 sheet
• Transparencies 30 sheets max.
• Envelopes 10 pieces max.
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General Specifications

Ordinary print media

Regular size
Letter, Legal, A4, A5, B5, US Com.#10, European DL

Custom size
• Width 3.94" to 9.50" (100.0 to 241.3 mm)
• Height 3.94" to 23.0" (100.0 to 584.2 mm)

Weight 17 to 28 lb (64 to 105 g/m2)

Thickness 0.24" (0.6 mm) max. 
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General Specifications

Canon Specialty Papers
• Artist Canvas
• Back Print Film
• Banner Paper
• Brilliant White Paper
• Bubble Jet Paper (water-resistant)
• Glossy Photo Cards
• Glossy Photo Paper
• Greeting Cards
• High Gloss Photo Film
• High Resolution Paper
• Magnet Sheets
• Transparencies
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General Specifications

Graphic image printing

Data format Canon extended mode—Raster image format

Resolution Canon extended mode—180, 360, 720, 1440 dpi



378Specifications

System Requirements

Printer driver software

Windows® 98/95

486 processor; 16MB RAM; 38MB free hard-disk space

Windows 2000

Pentium® processor, 133MHz or faster; 3.2MB RAM for Professional, 64MB 
RAM for Server; 25MB free hard-disk space

Windows NT® 4.0

Pentium®; 16MB RAM; 25MB free hard-disk space

Macintosh® 

Macintosh with USB; Mac® OS (8.1 or later); 10MB RAM; 30MB free hard-disk 
space



379Specifications

System Requirements

• The BJ Status Monitor cannot be used when the printer is used in a 
network operating environment.

• When connecting the printer and computer through a USB interface, use 
the system under the following operating environment.

Computer with Microsoft Windows 98 or Windows 2000, which is 
preinstalled by a computer manufacturer on purchase. (USB port 
operation also needs to be assured by the manufacturer.)

Macintosh computer with Mac OS 8.1 or later, which is preinstalled by 
a computer manufacturer on purchase. (When using an iMac running 
under Mac OS 8.1, the system must be upgraded using iMac 
Firmware 1.0, which can be downloaded from the home page of 
Apple Computer, Inc.)

• Specifications subject to change without prior notice.

Note
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Using the Optional IS-32 Color Image Scanner Cartridge

Using the Scanner 

Using the Scanner With Windows

Using the Scanner With Macintosh

Scanner Problems
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Using the Scanner

Scanner Driver Basics

Unpacking the Scanner Cartridge

Installing the IS Scan Software

Installing the Scanner Cartridge

Basic Scanning Procedure

Using the White Calibration Sheet

Scanning Area Guidelines

Loading an Image
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Scanner Driver Basics

Installing the optional IS-32 Color Image Scanner Cartridge in the printer makes it possible 
to scan and save images such as your favorite photographs and greeting cards.

Photograph

Wallpaper for your computer 
Home page 

Greeting card
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Scanner Driver Basics

To use the scanner cartridge, you must install the IS Scan software, which includes the 
IS Scan scanner driver and the IS Scan Plus utility program. These two programs provide 
many features that allow you to perform simple color adjustments to improve the quality of 
the original image or enhance the image for artistic effect.

You can run the IS Scan driver from within a TWAIN-compliant graphics application 
program, or you can run the IS Scan Plus utility program directly as a stand-alone 
application program. The IS Scan Plus utility program allows you to scan, edit, enhance, 
and save the image data.

To use the scanner cartridge, you must install the IS Scan software. You can run the 
IS Scan driver from within a TWAIN-compliant graphics application, or you can run it 
directly as a stand-alone program.

TWAIN is an industry interface standard that allows software applications to 
communicate with digital imaging devices such as scanners. Applications 
that support TWAIN provide a standardized method of acquiring images.

Windows

Macintosh

Note
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Unpacking the Scanner Cartridge

Make sure you have the following items.

�  IS-32 Color Image Scanner Cartridge

The scanner cartridge is composed of precision components. To avoid poor 
scanning results, do not touch the optical components or electrical 
contacts.

Optical components

Electrical contacts

Caution
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Unpacking the Scanner Cartridge

�  White Calibration Sheet
You use this sheet to maintain the correct color balance of scanned images. The first time 
you install the scanner cartridge, you need to run the white level calibration. You will also 
run calibration when the white level calibration data needs to be updated.

�  Scanning Holder

You can use this holder to hold a photo or other small image you wish to scan. The holder is 
two layers, one being a clear plastic cover to protect photographs.
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Installing the IS Scan Software

 

Make sure the S450 Printer Driver is installed on your computer before you proceed with 
the following instructions.

Insert the S450 Canon Creative CD-ROM in your CD-ROM drive.

Double-click the S450 icon on your desktop:    

You’ll see this screen:

1

2
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Installing the IS Scan Software

 

Click the Manuals, Supplies, and Help button. 

You’ll see this screen:
3
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Installing the IS Scan Software

Click Canon Accessories and Paper. 

You’ll see this screen:

Click the Install IS-32 Driver button.

Follow the instructions on the screen.

4

5

6
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Installing the Scanner Cartridge

• The scanner cartridge is composed of precision components. To avoid
poor scanning results, do not touch the optical components or electrical 
contacts.

• To avoid damaging the scanning head of the scanner cartridge, do not 
store the scanner cartridge in an Ink Cartridge Storage Box. The 
pad for the BJ cartridge print head inside the container is covered with 
ink that could damage the scanning head of the scanner cartridge. 

Optical components

Electrical contacts

Caution
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Installing the Scanner Cartridge

�  Replacing a BJ Cartridge With the Scanner Cartridge

Make sure that the printer is plugged in and turned on. Open the front 
cover; the cartridge holder moves to the center automatically.

Raise the left cartridge lock lever to unlock the BJ cartridge.

Remove the BJ cartridge from the left slot.

To avoid staining your hands, clothing, or work area, handle the 
BJ cartridge carefully. Avoid dropping or shaking the BJ cartridge. 
Store the BJ cartridge in the Ink Cartridge Storage Box.

Insert the scanner cartridge into the left slot of the cartridge holder, then 
lower the cartridge lock lever until it locks in place.

1

2

3

Caution

4
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Basic Scanning Procedure

After installing the IS Scan scanner driver, you can use the S450 printer as a scanner.

Remove the BJ cartridge installed in the left slot of the cartridge holder and 
then install the IS-32 Color Image Scanner Cartridge in the left slot.

Start a graphics application program.

For Windows Users

• If you use a TWAIN-compliant graphics application program, launch the 
TWAIN-compliant application program. IS Scan launches from within the 
application program.

• If you use IS Scan Plus, select Programs from the Start menu first. Point 
to IS Scan Plus and then select IS Scan Plus.

For Macintosh Users

• If you use a TWAIN-compliant graphics application program, launch the 
TWAIN-compliant application program first. IS Scan launches from within 
the application program.

• If you use IS Scan as a stand-alone application program, double-click IS 
Scan S450 in the folder you specified during the installation procedure.

1

2

Windows

Macintosh
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Basic Scanning Procedure

The first time you use the scanner, you need to perform the White Level 
Calibration.

 Using the White Calibration Sheet

Insert the image you wish to scan into the scanning holder, then load the 
scanning holder into the auto sheet feeder.

 Loading an Image

Scan the image.

 Scanning an Image

 Scanning an Image

Save the scanned image.

Now you can install the BJ cartridge and print the scanned image.

3

4

5
Windows

Macintosh

6

7
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Using the White Calibration Sheet

The white calibration sheet provided with the scanner cartridge is used for maintaining the 
correct color balance of scanned images. White level calibration is required when the 
scanner cartridge is used for the first time and when the white level calibration data needs 
to be updated.

When white level calibration is needed, you will see this screen when you click the Prescan 
or Scan button.

  

Windows

Macintosh
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Using the White Calibration Sheet

Load the white calibration sheet with the cropped corner at upper left.

Click the OK button on your screen.

When the white calibration sheet is ejected from the paper output tray, 
White Level Calibration processing is complete. Click the OK button.

1

Scanning holder

White calibration sheet

2

3
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Using the White Calibration Sheet

• Do not leave the white calibration sheet in locations that are exposed to 
direct sunlight or that are subject to high temperatures or humidity.

• Do not bend or wrinkle the white calibration sheet.

• When cleaning the white calibration sheet, use a soft cloth that is dipped 
in a weak, neutral detergent solution, and then wipe its wet surface off 
with a dry, soft cloth.

• The white level calibration data is stored into memory and used for 
maintaining the correct color balance of scanned images. When a 
message appears and prompts you to load the white calibration sheet, 
click the OK button and perform white level calibration.

You can also initiate White Level Calibration from the IS Scan driver.

 Other IS Scan Features

 Other IS Scan Functions

Note

Windows

Macintosh
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Scanning Area Guidelines 

• The scanning area varies according to conditions such as the scanning resolution and 
display resolution.

• If you wish to scan images larger than the size of the scanning holder provided with the 
IS-32 Color Image Scanner Cartridge, the SH-101 A4/LTR scanning holder is available 
for purchase. Visit the Canon Web site to find out about accessories and supplies 
(www.ccsi.canon.com).

• The maximum thickness of the image must be within 0.12 inch (0.45 mm), including the 
scanning holder. The scanning holder is 0.008 inch (0.2 mm) thick so the image you 
wish to scan must be less than 0.01 inch (0.25 mm) thick.

• To prevent possible damage to the printer or scanner cartridge, do not scan an image 
with paper clips or staples.

Paper size Scanning area

Letter 8.50 × 11.00 in 8.19 × 10.00 Inches

A6 105.0 × 148.0 mm 3.86 × 5.42 Inches

A5 148.0 × 210.0 mm 5.55 × 7.86 Inches

A4 210.0 × 297.0 mm 8.00 × 11.28 Inches

B5 182.0 × 257.0 mm 6.89 × 9.71 Inches
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Loading an Image

Slide the paper guide to the left edge of the auto sheet feeder.

Place the image in the scanning holder.

• To prevent paper jams, always insert the image you wish to scan into 
the scanning holder.

• Do not leave the scanning holder in locations that are exposed to 
direct sunlight or that are subject to high temperatures or humidity.

• When you load the scanning holder on the printer, be sure to set the 
paper thickness lever to the down (or envelope) position. Scanning 
with the lever set incorrectly will adversely affect the print quality.

Load the scanning holder in the auto sheet feeder of the printer.

1

2

3
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Loading an Image

Adjust the paper guide to the left edge of the scanning holder.

To prevent possible damage to the scanning holder, always insert the 
seamed side into the auto sheet feeder first.

4

Caution
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Using the Scanner With Windows

Using IS Scan

Changing the Scanning Mode

Using the Customized Scanning Mode

Saving the Settings

Using the Saved Settings

Other IS Scan Features

Using IS Scan Plus

Using Copy

Using Capture Image

Using Capture Photo

Editing a Scanned Image

Printing a Scanned Image

Saving a Scanned Image
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Using IS Scan

This section describes how to scan an image when you launch IS Scan from within a 
TWAIN-compatible application program.

�  Scanning an Image

These basic procedures may vary according to the application program you 
are using.

Install the IS-32 Color Image Scanner Cartridge in the printer.

 Installing the Scanner Cartridge

Make sure Canon IS Scan 2 is set as the Acquire Source and then select 
the command used for scanning (such as Acquire or TWAIN) from the 
menu of the application program. The main IS Scan dialog box displays:

Note

1

2
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Using IS Scan

Specify the basic settings.

• Click the down-arrow on the right of the Paper Size box and select the 
most appropriate paper size for the image you wish to scan.

• Select the most appropriate scanning mode for the image you wish to 
scan in the Scanning Mode box.

 Changing the Scanning Mode

Load the image you wish to scan in the auto sheet feeder of the printer and 
click the Prescan button.

It’s a good idea to use prescanning to determine whether or not an image 
can be scanned properly or to test the effects of image adjustments. If the 
image is slanted or a portion of the image is cut off in the preview area, click 
the Clear button. Load the image correctly and click the Prescan button 
again.

To scan only a portion of the image, you can drag the mouse to specify the 
portion. The specified portion is called a Selection Box and only the area in 
the Selection Box will be scanned. To specify the Selection Box:

• Point to a corner of the rectangular area of the image that you want to 
select.

• Drag the mouse to the opposite corner of the rectangle.

3

4

Note

5
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Using IS Scan

• Release the mouse button. The Selection Box appears on the image. 

• To move the Selection Box, place the mouse pointer within the Selection 
Box and drag the mouse to the desired position.

• To resize the Selection Box, point to a corner of the Selection Box and 
then drag the mouse.

• You can confirm the dimensions of the Selection Box in the Image Size 
box.

• The minimum size of the Selection Box is 1" × 1" (25.4 mm × 25.4 mm).

Note



403Using the Scanner With Windows

Using IS Scan

Load the image you wish to scan in the auto sheet feeder again.

Click the Scan button. Remember, if you specified a Selection Box in 
step 5, only that portion of the image is scanned.

After scanning is complete, click the Transfer button to transfer the image 
data to the TWAIN-compatible graphics application program. Adjust, edit, or 
enhance the image in the application program as needed.

6

7

8
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Using IS Scan

• Some TWAIN-compliant graphics application programs do not display 
the main IS Scan dialog box but instead display a different screen 
characteristic of the application program. If you are using this type of 
application program, read the documentation of the application program 
carefully and perform prescanning or normal scanning.

• After launching IS Scan from within a TWAIN-compatible application 
program, do not close the application program. If you do, the system may 
not be able to respond.

• To quit IS Scan, select Exit Driver from the Settings menu.

Note
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Changing the Scanning Mode

You can select a scanning mode according to your scanning purpose. Optimum settings, 
such as image type and resolution, are pre-assigned based on the contents of a scanning 
job. When you wish to customize the settings for special scanning jobs, click the Custom 
button.

�  Selecting a Default Scanning Mode
Select the most appropriate icon in the Scanning Mode box of the main IS Scan dialog box 
according to your scanning purpose.

Scanning 
Mode

Purpose
Image Type
Resolution

Edge Emphasis
Character Emphasis

Color Matching

Prescan 
Mode

Standard setting for scanning a 
color image

Color
180 dpi

Off
Off
On

Grayscale

Standard setting for scanning a 
monochrome image

Grayscale
180 dpi

Off
Off
Off

Grayscale

Suitable for scanning a 
photographic print such as a 
snapshot

Color
360 dpi

Off
Off
On

Grayscale
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Changing the Scanning Mode

When you select FAX or OCR, the document is scanned and processed as 
a grayscale image and converted to monochrome binary image data. This 
process eliminates unnecessary image background and increases the 
quality of the scanned text and line art. When you select Text, the document 
is scanned and processed as a monochrome image.

Scans by converting a 
monochrome image into the 
data suitable for facsimile 
transmission

Monochrome
200 dpi

Off
On
Off

Monochrome

Scans by converting a 
monochrome image into the 
data suitable for OCR input

Monochrome
360 dpi

Off
On
Off

Monochrome

Suitable for scanning an image 
that consists mostly of text

Monochrome
180 dpi

On
Off
Off

Monochrome

Used for customizing the 
settings for special scanning 
jobs

Using the Customized 
Scanning Mode

— — —

Scanning 
Mode

Purpose
Image Type
Resolution

Edge Emphasis
Character Emphasis

Color Matching

Prescan 
Mode

Note
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Using the Customized Scanning Mode

When you select Custom in the Scanning Mode box of the main dialog box, the Custom 
dialog box opens and allows you to adjust the scanning settings for special scanning jobs. 

Open the main IS Scan dialog box.

Click the Custom button in the Scanning Mode box. This displays the 
Custom dialog box:

1

2
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Using the Customized Scanning Mode

Specify these settings in the Custom dialog box:

Standard Value
You change the standard values for the default settings here.

Image Type
Select a type of image: Color (the default), Grayscale, or Monochrome.

Resolution
Determines the precision of the scanned image. The higher the resolution 
setting, the higher the precision and quality of the scanned image. 
(However, the higher the resolution setting, the larger the file size.)

• The 90 dpi setting is sufficient for viewing images on a screen.
• The 180 dpi setting is sufficient for printing images.

Threshold
Determines the intensity of halftones for monochrome images. Drag the 
slide bar to the left for a lighter image or drag it to the right for a darker 
image. The Threshold option is available only when the Image Type is set 
for Monochrome and Character Emphasis is off.

Edge Emphasis
Sharpens the edges of a soft image to create a clearer, more accented 
appearance in the entire image. This option is available only when the 
Image Type is set for Monochrome. Edge Emphasis is not used with 
prescanning.

3
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Using the Customized Scanning Mode

Character Emphasis
Determines whether or not Image Trust processing is used for scanning 
grayscale images. Image Trust processing sharpens the appearance of 
characters in monochrome documents. This is especially helpful if you 
intend to use the scanned original with an OCR software application. This  
option is available only when the Image Type is set for Monochrome.

Color Matching
In some cases, the colors displayed on your monitor may not match the 
colors you see in your printout. Color Matching attempts to match the 
colors of the scanned image with the selection in the Monitor Type box in 
order to attain a better match between the colors you see on the monitor 
and the colors you see in your printout. This option is available only when 
the Image Type is set for Color.

Monitor Type
Displays the name of the monitor profile currently in use. To select another 
monitor type setting, click the down-arrow and select a name from the drop-
down list. This list includes the names of ICC profile formats, standard 
profiles for monitors, installed in the system. A monitor profile can be 
selected only when Color Matching is selected.

Prescan
Selects the type of image for prescanning. Select Monochrome, Grayscale 
(the default), or Color.



410Using the Scanner With Windows

Using the Customized Scanning Mode

Click the OK button to return to the main dialog box.

Make sure that the image you wish to scan is inserted into the scanning 
holder properly and is loaded in the auto sheet feeder of the printer, then 
click the Scan or Prescan button.

4

5



411Using the Scanner With Windows

Saving the Settings

You can save the settings in the main IS Scan dialog box to a file. The next time you scan, 
you only need to open the file in which the desired settings are stored and start scanning.

�  Saving the Settings to a File
Save the Page Size, Scanning Mode, and Image Size settings in the main IS Scan dialog 
box as a file.

Specify the desired settings in the Paper Size, Scanning Mode, and Image 
Size boxes.

Select Save Settings File from the Settings menu.

Select the folder in which the file is to be saved.

Enter a File name.

Click the Save button.

1

2

3

4
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Using the Saved Settings

Open the file in which the desired settings were saved and use those settings for scanning.

Select Open Settings File from the Settings menu.

Select the file you wish to use, then click the Open button. The file name 
is displayed in the Settings File box, and the settings change in the main 
IS Scan dialog box.

• When you open the file while an image is displayed in the preview area, 
the prescanned or scanned image is discarded. Prescan or scan the 
image again.

• Select Save Settings File from the Settings menu when you have 
changed the settings and you wish to overwrite the current file and save 
all the current settings to it.

• Select Save Settings File As from the Settings menu when you have 
changed the settings and you wish to save all the current settings under 
a new file name.

1

2

Note
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Other IS Scan Features

�  White Level Calibration
Use this feature to maintain the correct color balance of scanned images. You need to 
perform White Level Calibration when you use the scanner cartridge for the first time and 
when the white level calibration data needs to be updated.

Select White Level from the Option menu of the main IS Scan dialog box.

When a message appears, insert the white calibration sheet into the auto 
sheet feeder of the printer.

 Using the White Calibration Sheet

Click the OK button.

When the white calibration sheet is ejected from the paper output tray, the 
White Level Calibration process is complete.

1

2

3

4



414Using the Scanner With Windows

Other IS Scan Features

�  Device Information
When you select Device Information from the Option menu of the main IS Scan dialog box, 
you can verify the name of the printer that is currently connected to your system and 
information on the communication mode.

• If the printer is connected using the parallel interface, Device Information displays a 
communication mode such as ECP/1 or ECP/2.

• If the printer is connected using the USB interface, Device Information displays USB as 
the communication mode.

�  Enlarging the Scanned Image in the Preview Area

To enlarge the scanned image in the preview area, click the Enlarge icon ( key) or select 

Large from the View menu.

To return to the original size, click the Standard icon ( key) or select Normal from the 

View menu.

�  Using Online Help

When you click the symbol in the main IS Scan dialog box, the online Help for IS Scan 

opens so you can learn more about IS Scan.
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Using IS Scan Plus

IS Scan Plus is a utility program that allows you to edit, enhance, print, and save an image 
acquired by the IS Scan scanner driver. You can use IS Scan Plus if you do not have a 
graphics application program.

�  Launching IS Scan Plus

Select Programs from the Start menu, then click IS Scan Plus.

Select IS Scan Plus. The main IS Scan Plus screen appears:

1

2
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Using IS Scan Plus

Select an option:

Copy
Scan and immediately print an image without editing.

 Using Copy

Capture Image
Scan and edit an image other than a photographic print.

 Using Capture Image

Capture Photo
Scan and edit a photographic print such as a snapshot.

 Using Capture Photo

Device Information
Verify the name of the printer that is currently connected to your system 
and information on the communication mode.

3
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Using IS Scan Plus

�  Using Online Help
When you need detailed instructions, click the Help button in the upper right of the 
main screen. You can access the online Help from all the screens that IS Scan Plus 
displays.

�  Verifying the Device Information
Make sure that the printer is connected properly and is turned on, and click the Device 
Information button.

• If the printer is connected using the parallel interface, Device Information 
displays a communication mode such as ECP/1 or ECP/2.

• If the printer is connected using the USB interface, Device Information displays 
USB as the communication mode.

�  Closing IS Scan Plus
When you wish to close IS Scan Plus, click the Exit button in the upper right of the 
main screen. You can access the Exit button from all the screens that IS Scan Plus 
displays.
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Using IS Scan Plus

�  IS Scan Buttons

Returns to the main IS Scan Plus screen.

Moves back to the previous screen.

Displays the Edit screen.

 Editing a Scanned Image

Prints a scanned image.

 Printing a Scanned Image

Saves a scanned image.

 Saving a Scanned Image
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Using Copy

Use the Copy feature when you wish to print an image immediately after scanning. You 
cannot edit or enhance the scanned image before printing.

Click the Copy button in the main IS Scan Plus screen. The Copy screen 
displays:

Specify any required settings:

• Select Color or Monochrome in the Document Type box.
• Select Fine or Fast in the Copy Mode box.
• Select the paper size in the Paper Size box.
• The Copies box is disabled.

1

2
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Using Copy

Click the Print Setting button. This displays the Print Setup dialog box. 
Make sure Canon S450 is displayed as the default printer. Click the 
Properties button, if necessary, to display the Printer Properties dialog box 
and specify any printer settings. 

 Using the Windows 98/95 Printer Driver

When you click the Copy button, a message box appears. Click OK in the 
message box to confirm that the scanner cartridge is installed. Copying 
begins.

Another dialog box appears to remind you to remove the scanner cartridge, 
and install the BJ cartridge according to your print job. Also, make sure 
paper is loaded in the auto sheet feeder of the printer.

3
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Using Copy

Click the OK button in the dialog box. Printing begins.

• To print the image displayed in the Preview Area again, click the Reprint
button.

• To make a copy of another image using the same settings, click the Copy 
button. When a confirmation message appears, click the Yes button and 
repeat the procedure described above.

• To make a copy using different settings, click the Clear button to clear 
the copied image from the preview area. Repeat the procedure 
described above.

6

Note
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Using Capture Image

Use the Capture Image feature to scan an image other than a photographic print. You can 
also edit, enhance, save, and print the scanned image.

Click the Capture Image button in the main IS Scan Plus screen. This 
displays the Capture Image screen.

1
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Using Capture Image

Select the most appropriate icon in the Scanning Mode box of the Capture 
Image screen according to your scanning purpose.

Standard setting for scanning a color image.

Standard setting for scanning a monochrome image.

Suitable for scanning a photographic print such as a 
snapshot.

Suitable for scanning an image that consists mostly of text.

Used for customizing the settings for special scanning jobs.

   Using the Customized Scanning Mode

Select the paper size in the Paper Size box.

Insert the image you wish to scan in the scanning holder, and then load it in 
the auto sheet feeder of the printer.

Click the Prescan button.

The remaining steps are similar to those described for Scanning an Image 
using IS Scan.

 Scanning an Image

2
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4
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Using Capture Photo

Use the Capture Photo feature to scan a photographic print such as a snapshot. You can 
also edit, enhance, save, and print the scanned image.

Click the Capture Photo button in the main IS Scan Plus screen. The 
Capture Photo screen displays:

By default, a Selection Box displays in the Preview Area. To delete the 
Selection Box, point to any location in the Preview Area and right-click your 
mouse.

Specify these settings:

• Select Color or Black & White in the Photo Type box.
• Select Regular or Panorama in the Photo Size box.

1

2
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Using Capture Photo

Insert the image you wish to scan into the scanning holder, and then load it 
in the auto sheet feeder of the printer.

Click the Prescan button.

The remaining steps are similar to those described for Scanning an Image.

 Scanning an Image

3

4
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Editing a Scanned Image

You can edit or enhance a scanned image acquired using the Capture Photo or Capture 
Image feature. The editing features you can use vary according to the settings you used for 
scanning and whether you used the Capture Photo or Capture Image feature for scanning.

You can edit or enhance the image displayed in the Preview Area.

Click the Edit button in the main IS Scan Plus screen. The Edit screen 
displays:

You can select these editing options. For details on each feature, use the 
online Help for IS Scan Plus.

Contrast / Brightness
Adjusts the brightness and contrast of an image.

1

2



427Using the Scanner With Windows

Editing a Scanned Image

Image Compensation
Softens edges in the image by reducing the contrast between pixels, or 
sharpens hazy or blurred images. You can also smooth the appearance of 
the image and invert the image.

Edges
Enhances the edges in an image by increasing the contrast of the pixels 
between areas of different colors. 

Lines
Emphasizes selected edges and de-emphasizes all other edges of an 
image.

Pixelize
Squares off all the pixels in an image to lower resolution and makes the 
pixels appear larger to create a mosaic tile effect.

Posterize
Reduces the number of colors in an image.

Low Relief
Applies special options to create a three-dimensional effect in the image.

Background
Allows you to add a background to a monochrome image.

Crop Photo
Crops a scanned photograph in the Preview Area.

Frame
Allows you to add a frame border around the image.
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Editing a Scanned Image

• Depending on the settings you use for scanning, some editing features 
are not available. For details, see the online Help for IS Scan Plus.

• You cannot use Crop Photo and Frame in the Capture Image screen. 
You can select Background when a monochrome image is captured.

Edit or enhance the image as required.

Click the Apply button to apply the effect to the image in the Preview Area.

To undo the settings, click one of the undo buttons:

Undo All
Click once to undo all editing effects and restore the original in the Preview 
Area.

Undo Previous
Click once to undo the previous editing effect; click repeatedly to undo each 
previous editing effect one by one.

Note

3
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Printing a Scanned Image

You can print a scanned image acquired using the Capture Image or Capture Photo feature. 
Remove the scanner cartridge, and install the BJ cartridge according to your print job.

Click the Print button on the IS Scan Plus screen. If you are using Capture Image, the Print 
dialog box appears: 
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Printing a Scanned Image

If you are using Capture Photo, the Photo Print Options dialog box appears.

Click Print Setting to change the printer settings or click Print to print the image.

 Opening the Printer Properties Dialog Box
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Saving a Scanned Image

IS Scan Plus allows you to save a scanned image to a file under a new name. You can use 
the saved image for pasting into another document or for attaching to your e-mail or a home 
page on the Internet.

You can save the image displayed in the Preview Area.

Click the Save button. This displays the Save As dialog box.

Select the folder in which you wish to save the image.

Enter a File name.

1

2
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Saving a Scanned Image

Click the down-arrow for “Save as type” and select a format for the file.

You can select one of the following file formats.

• Bitmap.BMP
• JPEG.JPG
• TIFF.TIF

Click the Save button.

4
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Using the Scanner With Macintosh

Scanning Images With Application Software

Using the Main IS Scan Dialog Box

Scanning an Image

Scanning Images With IS Scan

Changing the Scanning Mode

Customizing the Scanning Settings

Copying a Scanned Image to the Clipboard

Adjusting an Image

Modifying an Image

Applying Special Effects to an Image

Other IS Scan Functions

Using the Copy Utility
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Scanning Images With Application Software

This section explains how to start IS Scan from a TWAIN image editing application software 
so that you can scan images. 

�  Selecting a TWAIN-compatible Device
Before you scan images with application software, you must first select a TWAIN-
compatible device using the S450 driver. The basic procedure is described below (steps 
may vary based on your application software).

Start the application software and then select New... from the File menu. 
Then, open the menu you use to scan images. Install the scanner cartridge 
in the printer.

To open the dialog box for selecting a TWAIN-compatible input device, you 
normally select Import and then select TWAIN Select... from the File menu. 
The “Select a source” dialog box is displayed.

Click the IS Scan S450 icon and 
then click the OK button.

S450 is now selected as the input 
device. Once you have performed 
these steps, the setting remains in 
effect until you change to another 
input device.

1
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Using the Main IS Scan Dialog Box

Menu button
Selects the IS Scan functions. Click this button to change the settings for a scanned 
image or to edit a scanned image.

Image Control 
Panel

Brightness and 
Contrast

Preview Area

Menu Button

Scan Button

Save  Button

Halt Button

Help Button

Information Box
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Using the Main IS Scan Dialog Box

Scan, Prescan, or Clear button
Click this button to start scanning. This button switches to Prescan or Clear, 
depending on the setting or situation.

Transfer or Save button
Click this button to transfer a scanned image to an application. When using IS Scan 
only without an application software, this button says Save.

Halt button
Click this button to cancel scanning.

Information box
Displays the settings related to image scanning. To perform scanning using other 
settings, click the Menu button and then select Settings.

Help button
Click this button to display helpful explanations about the IS Scan functions.

Brightness and Contrast 
Click this button to adjust the degree of brightness of an image.

Image Control Panel
Displays the size of the image to be scanned. For units, you can select inches, mm, 
or pixels. 

Preview area
Displays a scanned image.
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Scanning an Image

Click the Menu button and then select Settings. The Settings dialog box 
displays:

Make the necessary settings for the image to be scanned.

• Click on Paper Size to select a size that approximates the image to be 
scanned.

• Click on Scanning Mode to select the item that best approximates the 
image to be scanned.

 Changing the Scanning Mode

• Place a check mark in the Prescan check box. 
Prescan performs a quick scan so you can check the image. You can 
disable this function.

1
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Scanning an Image

Click the OK button and then close the Settings dialog box.

Place the object to be scanned in the printer and then click the Prescan 
button. You see the image displayed in the Preview Area.

If you only want to scan part of the object, drag the mouse within the 
Preview Area to select the part to be scanned. The Selection Box indicates 
the area that will be scanned.

3

4
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Scanning an Image

• To create a Selection Box, position the cursor over one corner of the 
area to be selected, press and hold down the mouse button, and then 
drag the mouse diagonally to the opposite corner of the area you want to 
select. Release the mouse button.

• If you position the cursor over a point within the selected area, you can
move the area by dragging. If you position the cursor over one of the 
lines indicating the selected area, you can change the size of the 
selected area by dragging that line in or out.

• The minimum size of the selected area is 1" × 1" (25.4 mm by 25.4 mm).

• The size of the selected range is displayed in the Image Control Panel. 

Place the image to be scanned in the printer and click the Scan button. 
Remember, only the range indicated by the Selection Box is scanned.

Note

6
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Scanning an Image

If the image displayed in the Preview Area is not what you expect, click the 
Clear button and start over.

If you like the image, click the Transfer button. The scanned image is 
transferred to the application software. Edit the image data as required 
prior to printing or saving it.

• Some application programs do not display the main IS Scan dialog box, 
but display their own scanning screen. In this case, refer to the 
documentation supplied with the scanning software.

• Do not close an application program that started IS Scan while 
IS Scan is still running. This may cause the system to lock up.

7

Note
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Scanning Images With IS Scan

You can use IS Scan as a stand-alone program to scan and edit images.

�  Starting IS Scan

Turn on the printer and install the scanner cartridge.

Double-click the IS Scan S450 folder.

Double-click the IS Scan S450 icon.

1

2

IS Scan S450 Folder

3
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Scanning Images With IS Scan

IS Scan starts and the main dialog box displays.

The contents of the main dialog box and the method you use to scan 
images are basically the same as when using TWAIN application software.
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Scanning Images With IS Scan

�  Saving Scanned Images

Click the Save button.1
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Scanning Images With IS Scan

Make the necessary settings.

• Select the location to which you want to save your image.

• Enter a name for the image data in Name.

• Click the drop-down box in Format to select PICT or TIFF.

Click the Save button. The image data is saved into a file.

2
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Changing the Scanning Mode

You can select a scanning mode according to your scanning purpose. Optimum settings, 
such as image type and resolution, are pre-assigned based on the contents of a scanning 
job. When you wish to customize the settings for special scanning jobs, click the Custom 
button.

�  Selecting a Default Scanning Mode
Select a setting that best approximates the image to be scanned. 

Scanning 
Mode

Use
Image Type
Resolution

Edge Emphasis
Color Matching

Prescan 
Mode*

DTP 
(Color)

Standard setting used when a 
color draft is to be scanned

Color
180 dpi

Off
On (Execute)

Grayscale

Photo Recommended when scanning 
a photograph

Color
360 dpi

Off
On (Execute)

Color

DTP 
(B&W)

Standard setting used when a 
black & white draft is to be 
scanned

Grayscale
180 dpi

Off
Off

Grayscale

* By default, Prescan is disabled. Once enabled, Black & White is the default Prescan 
  Mode. You can select a Prescan Mode of Color, Grayscale, or Black & White.
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Changing the Scanning Mode

Text Recommended when scanning 
a document consisting entirely 
of text, such as a document 
created with a typewriter or 
word processor

Black & 
White
180 dpi

On (Execute)
Off

Black & 
White

FAX Scans by converting a 
monochrome image into the 
data suitable for facsimile 
transmission

Black & 
White 
(Text 
Enhanced)
200 dpi

Off
Off

Black & 
White

OCR Scans by converting a 
monochrome image into the 
data suitable for OCR input

Black & 
White 
(Text 
Enhanced)
360 dpi

Off
Off

Black & 
White

Custom Selected when a specific range 
of settings are to be made

Customizing the 
Scanning Settings

––––– ––––– –––––

* By default, Prescan is disabled. Once enabled, Black & White is the default Prescan 
  Mode. You can select a Prescan Mode of Color, Grayscale, or Black & White.

Scanning 
Mode

Use
Image Type
Resolution

Edge Emphasis
Color Matching

Prescan 
Mode*
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Changing the Scanning Mode

• The Settings dialog box displays when you select Settings after you click 
the Menu button in the main dialog box.

• When you select FAX or OCR, the document is scanned and processed 
as a grayscale image and converted to monochrome binary image data. 
This process eliminates unnecessary image background and increases 
the quality of the scanned text and line art. When you select Text, the 
document is scanned and processed as a monochrome image.

Note
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Customizing the Scanning Settings

When you select Custom for Scanning Mode in the Settings dialog box, you can specify the 
scanning settings.

Click the Menu button in the main dialog box and then select Settings.

Click the drop-down box in Scanning Mode and then select Custom.

Make the appropriate settings for the image to be scanned.

Image Type
Select a mode according to the image to be scanned. You can select Color, 
Grayscale, Black & White, or Black & White (Text Enhanced).

1

2
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Customizing the Scanning Settings

Resolution
Select a resolution according to the image to be scanned. The higher the 
resolution, the finer the image you can get, although the amount of data will 
be large. In general, 90 dpi is sufficient for home pages, while 180 dpi is 
good for output to a printer. Settings are 90, 180, 200, 300, 360.

Threshold
This function is valid only when Image Type is set to Black & White. The 
lightness/darkness of monochrome images can be adjusted by moving the 
slide bar. If the slide bar is moved to the left, the scanned image will be 
lighter, while if the slide bar is moved to the right, the image will be darker.

Prescan
Place a check mark in the Prescan check box to perform the prescan. The 
scanning mode can be set to Black & White, Grayscale, or Color.

Color Matching
This function is effective only when Image Type is set to Color. When this 
function is enabled, the colors are adjusted according to the monitor when 
the image is scanned. The monitor itself is set with the system feature of 
ColorSync® in the Apple menu control panel.

Edge Emphasis
This function is valid only when Image Type is set to Black & White. If this 
function is selected, only the edge of the image is emphasized when the 
image is scanned. This is disabled for prescan.

Click the OK button. The main dialog box displays.

Place the image to be scanned in the printer, then click the Prescan button 
or Scan button to start scanning.

4
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Copying a Scanned Image to the Clipboard

If you copy a scanned image to the clipboard, you can use the image easily with other 
application software. This is particularly useful when you want to paste an image into 
documents created with application software that is not TWAIN-compatible.

�  Copying an Image

Click the Menu button in the main dialog box. Select Edit and then select 
Copy.

The image data is copied to the clipboard.

To use an image copied to the clipboard, start your application software 
and then select Paste from the Edit menu.

1

Note
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Adjusting an Image

If you are not satisfied with a scanned image, you can perform fine adjustment using a 
range of functions. Image data can be processed so that the brightness of the image 
changes or so that the image appears sharper or softer.

�  Adjusting the Brightness and Contrast

Click the Brightness and Contrast button in the main dialog box. The 
Brightness and Contrast dialog box displays.

1
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Adjusting an Image

Move each slide bar to the right or left to adjust the image.

Brightness
Moving the Brightness slide bar to the left makes the entire image darker, 
while moving it to the right makes the image brighter.

Contrast
Moving the slide bar to the left reduces the contrast of the entire image, 
while moving it to the right increases the contrast.

After making the adjustment, click the Apply button to change brightness 
and contrast of the image displayed within the preview area.

Once you are satisfied with the adjustment, click the OK button.

2
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Modifying an Image

You can modify a scanned image so that it looks sharper or softer. Also, a Despeckle 
function allows you to remove speckling and make a scanned image appear cleaner. A 
function for inverting colors to produce a negative film is also available.

Click the Menu button in the main dialog box, select Image, and then select 
the desired function from the submenu.

Sharpen Sharpens an image to make it clearer.

Soften Softens the edges of an image.

Despeckle Removes speckling from an image, making any such
areas less noticeable.

Invert Inverts the colors of an image to produce a negative 
of the original.

You can check the effect of the adjustment in the Preview Area.

1
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Applying Special Effects to an Image

Special effects such as edge emphasis, line emphasis, pixelization, posterization, and low 
relief can be applied to a scanned image, creating an image with a feeling different from that 
of the original.

Click the Menu button in the main dialog box, select Enhance, and then 
select the desired function from the submenu.

Edges... Emphasizes the edges of a photograph or line drawing.

Lines... Emphasizes only lines in a specific direction.

Pixelize... Applies a mosaic effect to an image.

Posterize... Reduces the number of colors and simplifies the image.

Low Relief... Creates a low relief version of the image.

When you select one of these functions, the corresponding dialog box 
displays.

1
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Applying Special Effects to an Image

Select a desired function from the list.

The following is an example of the screen displayed when you select 
Edges. The operation is the same when any other function is selected. You 
can check the approximate result of the selection in the Preview Area.

For details of each function, refer to the explanation displayed when you 
click the Help button.

2
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Applying Special Effects to an Image

Once you are satisfied with the adjustment, click the OK button.

To cancel an adjustment you have made, click the Menu button and then 
select Undo. Then, select either of the following:

Last Only the function applied immediately before is cancelled. If you 
perform editing two or more times, only the function that you 
selected most recently is cancelled.

All All the applied functions are cleared and the original image is 
restored.

3

Note
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Other IS Scan Functions

�  White Level Calibration
To achieve the correct color balance for an object to be scanned, an operation called White 
Level Calibration is required. When an image is scanned for the first time, or when the 
temperature of the scanner cartridge rises to a certain level, a message displays prompting 
you to place the white calibration sheet in the printer.

Place the white calibration sheet in the printer and then click the OK button. The calibration 
sheet is scanned and the calibration is performed.

You can also initiate this operation whenever necessary. 

Click the Menu button in the main dialog box and then select Settings.

Click the White Level button.

When the message appears, place the white calibration sheet in the printer.

 Using the White Calibration Sheet

Click the OK button.

When the white calibration sheet is ejected, white leveling is complete.

1
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Other IS Scan Functions

�  Using the Online Help
Clicking the Help button on the main dialog box displays helpful explanations of the 
functions of IS Scan. You can also display the Help by clicking the Menu button, then 
Help, and Help again.
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Using the Copy Utility

Use this utility to scan an object and then print the result immediately. Although the scanned 
image cannot be edited or saved, the process from scanning to printing is completed 
quickly and easily.

�  Installing the Copy Utility
To use the Copy Utility, you must first copy the folder including the necessary files to any 
location.

Load the S450 Canon Creative CD-ROM into the CD-ROM driver on your 
Macintosh.

Double-click on the Copy Utility folder.

1
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Using the Copy Utility

Drag the Copy Utility for S450 folder and copy it to any location.

Now you can start the Copy Utility at any time.

To use the Copy Utility, the printer driver and IS Scan scanner driver must 
also be installed.

�  Starting the Copy Utility

Turn on the printer and install the scanner cartridge.

Click the Copy Utility for S450 folder.

3

Note
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Using the Copy Utility

Click the Copy Utility icon.

The Copy Utility starts and the main dialog box displays:

3
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Using the Copy Utility

�  Copying the Image

Click the Color or Black & White button according to the image to be 
scanned.

Select the paper size you are using in Paper Size.

Select the number of copies to be output in Copies.

Select the type of paper you are using:  Plain Paper, High Resolution 
Paper, or Transparency.

Set Brightness, as necessary. Move the slide bar to the right and left to set 
the brightness.

Place the image to be copied in the printer, then click the Copy button.

Scanning starts.

When the message appears, remove the scanner cartridge and replace it 
with a BJ cartridge according to the printing settings.

Place a blank sheet of paper in the printer and click the OK button.

Printing starts.

1
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Using the Copy Utility

• To print the same image again, click the Reprint button.

• To copy another document with the same settings, click the Copy button 
and follow the instructions on the screen.

• To perform copying with different settings, click the Reset button and 
follow the instructions on the screen.

�  Ending the Copy Utility
To close the Copy utility, click the close box or the Quit button.

Note

Close box
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Scanner Problems

Scanning Result Is Unsatisfactory

Scanner Cannot Be Used With a TWAIN-Compatible Application Program

Other Scanner Problems
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Scanning Result Is Unsatisfactory

Quality of Scanned Image Is Uneven

White Portion Becomes Grayish

Parts of an Image Missing or Not Aligned Properly

Image Contains Unexpected Colors, or Is Too Light or Too Dark
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Scanning Result Is Unsatisfactory

�  Scanned Image Blurred or Distorted

Check 1 ARE YOU USING A CLEAR IMAGE FOR SCANNING?

Blurry images are not suited for scanning. For best scanning results, 
always use a clear, sharp image. (The scanned image cannot be better 
than the original image.)

Check 2 IS THE SCANNING HOLDER UNSTAINED AND UNDAMAGED?

The scanning holder is bound to get dirty. Clean the scanning holder using 
a soft cloth that is dipped in a weak, neutral detergent solution, and then 
wipe its wet surface off with a dry, soft cloth.

If the scanning holder is scratched or damaged, replace it.

You can purchase a scanning holder for A4/LTR-size images. Visit the 
Canon Web site to find out about accessories and supplies 
(www.ccsi.canon.com).

Check 3 ARE YOU SCANNING THICK PAPER?

The image being scanned must be thinner than 0.01 inch (0.25 mm). The 
thickness including the scanning holder must be thinner than 0.02 inch 
(0.45 mm).

Note
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Scanning Result Is Unsatisfactory

�  Quality of Scanned Image Is Uneven
The scanned image is coarse and/or blurry.

Check IS THE RESOLUTION SETTING HIGH ENOUGH?

Resolution determines the precision of the scanned image.

The greater the number of dots used to draw an image, the higher the 
precision and the quality of the scanned image becomes. For a better 
quality image, select a greater number.

The scanning speed becomes slower and the file size of the scanned 
image becomes larger when you use a higher resolution.

 Changing the Scanning Mode

 Changing the Scanning Mode

Windows

Macintosh



468Scanner Problems

Scanning Result Is Unsatisfactory

�  White Portion Becomes Grayish
Check 1 DID YOU PERFORM WHITE LEVEL CALIBRATION?

Use White Level Calibration to maintain the correct color balance of 
scanned images.

 Using the White Calibration Sheet

Check 2 DID YOU ADJUST THE BRIGHTNESS AND CONTRAST?

Depending on the image you scan, a white portion is not recognized as 
white because the scanner detects and scans even the small differences of 
the density between white and other colors.

Adjust the brightness and contrast.

• When you are using IS Scan Plus, use the online Help.

• When you are using a TWAIN-compatible graphics application program, 
see the User’s Manual for the application program.

Note
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Scanning Result Is Unsatisfactory

Check 3 DID YOU SCAN A MONOCHROME IMAGE USING THE COLOR OR 
GRAYSCALE SETTING?

If the Scanning Mode is set to Color or Grayscale, the scanner detects and 
scans even the grades of the density, and white may not be recognized as 
white.

When you scan a monochrome image, always set Black & White in the 
Scanning Mode so the scanner can scan using only two values between 
white and black.

For details on how to set Black & White in the Scanning Mode, use the 
online Help.

 Changing the Scanning Mode

 Changing the Scanning Mode

Windows

Macintosh
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Scanning Result Is Unsatisfactory

�  Parts of an Image Missing or Not Aligned Properly
Check 1 DID YOU PLACE AN IMAGE WITHIN THE PROPER SCANNING AREA?

Check that the image you wish to scan is placed in the proper scanning 
area.

Check 2 DID YOU SPECIFY THE SCANNING AREA CORRECTLY?

If the Paper Size setting is smaller than the size of the image you scan, 
parts of the image will be missing.

If you place the image outside the scanning area, parts of the image may 
not be aligned properly. Always check that the image is set within the 
proper scanning area.
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Scanning Result Is Unsatisfactory

�  Image Contains Unexpected Colors, or Is Too Light or Too Dark
The appearance of the scanned image is not what you expected, or the image is too light or 
too dark.

Check 1 IS THE NUMBER OF DISPLAY COLORS SET TO HIGH COLOR OR TRUE 
COLOR?

Check the number of display colors as follows.

From the Start menu, select Settings, and then select Control Panel.

Double-click the Display icon, then click the Settings tab.

Check that Colors is set to High Color or True Color in the Colors box.

Check the Color Depth setting as follows.

From the Apple menu, select Control Panels.

Select Monitors & Sound.

Check that Thousands or Millions are set for Color Depth.

Windows

1

2

3

Macintosh
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Scanning Result Is Unsatisfactory

Check 2 IS COLOR MATCHING ENABLED?

The colors displayed on your display may not match the actual scanned 
colors.

Color Matching attains the best match between the colors displayed on 
your display and the actual colors in the scanned image.

You can enable Color Matching when the Scanning Mode is set for Color.

Check that Color Matching is enabled.

Click the Custom Setting button.

Make sure that Color Matching is enabled in the Custom Setting dialog box.

Select Settings from the Menu screen.

Make sure that Color Matching is enabled.

Windows
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2

Macintosh
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Scanner Cannot Be Used With a TWAIN-Compatible 
Application Program

Cannot Launch IS Scan From Within the TWAIN-Compatible Graphics 
Application Program

Cannot Transfer to TWAIN-Compatible Graphics Application Program
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Scanner Cannot Be Used With a TWAIN-Compatible Application Program

�  Cannot Launch IS Scan From Within the TWAIN-Compatible Graphics 
Application Program

Check DOES THE TWAIN-COMPATIBLE GRAPHICS APPLICATION PROGRAM 
YOU ARE USING SUPPORT THE LATEST 32-BIT TWAIN 
SPECIFICATIONS OR TWAIN SOURCE MANAGER (VERSION 1.5 OR 
LATER)?

When IS Scan is used as a TWAIN interface, you must use the latest 32-bit 
TWAIN-compatible graphics application program. See the User’s Manual 
for your application program.

When IS Scan is used as a TWAIN interface, you must use the graphics 
application program that supports the TWAIN Source Manager (Version 1.5 
or later). See the User’s Manual for your application program.

Windows

Macintosh
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Scanner Cannot Be Used With a TWAIN-Compatible Application Program

�  Cannot Transfer to TWAIN-Compatible Graphics Application Program
Check DOES THE TWAIN-COMPATIBLE GRAPHICS APPLICATION PROGRAM 

YOU ARE USING SUPPORT THE FILE FORMAT TYPE AND RESOLUTION OF 
THE IMAGE DATA?

Some TWAIN-compatible graphics application programs support specific 
file format types and resolution settings only. For example, the resolution 
settings of some OCR (optical character reader) application programs are 
limited to 300 or 400 dpi.

Check the file format types and resolution settings of the TWAIN-
compatible graphics application program first, and then scan and transfer 
the image again.
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Other Scanner Problems

Cannot Install Scanner Driver

Does Not Launch With Default Settings   

Improper Colors Displayed in the Dialog Box

Scanning Too Slow

Communication Error Occurs

Error Message Appears

Windows
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Other Scanner Problems

�  Cannot Install Scanner Driver

Check 1 DID YOU FOLLOW THE SCANNER DRIVER INSTALLATION  
INSTRUCTIONS?

 Installing the IS Scan Software

If an error occurred during installation and you had to shut down the 
installation procedure, you may not be able to install the scanner driver 
because Windows is no longer stable. Restart Windows and then reinstall 
the scanner software.

Check 2 ARE ANY OTHER APPLICATION PROGRAMS RUNNING?

The scanner driver installation program may not execute successfully if it is 
run with other applications running in the background.

Before you run the installation program again, shut down all other 
application programs.

Check 3 DID YOU SPECIFY THE CORRECT CD-ROM DRIVE FOR 
INSTALLATION?  

If the S450 splash screen did not come up automatically when you loaded 
the CD-ROM, double-click the My Computer icon, then double-click the 
CD-ROM icon on the Windows desktop.

 Installing the IS Scan Software

The drive name (E: for example) varies according to how your system is 
set up.

Windows

Windows

Note
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Other Scanner Problems

Check 4 IS THERE A PROBLEM WITH THE CD-ROM?  

The Canon Creative CD-ROM may be damaged. On the Windows desktop, 
double-click the My Computer icon then double-click the CD-ROM icon. If 
Windows cannot read the CD-ROM, call the Canon Customer Care Center 
for help. 

 Getting Help From Canon

�  Does Not Launch With Default Settings  

Check DID YOU LAUNCH IS SCAN FROM A TWAIN-COMPATIBLE GRAPHICS 
APPLICATION PROGRAM?

This problem occurs when IS Scan is launched from a TWAIN-compatible 
graphics application program.

Depending on the TWAIN-compatible graphics application program, 
Previous Settings selected in the Standard Value box under the Custom 
Settings dialog box may be cleared, and standard settings characteristic of 
the TWAIN-compatible program you are using may be used when 
launching IS Scan.

To use the settings selected in the Custom Settings dialog box when 
launching IS Scan, follow these steps:

Select Save Settings File from the Settings menu.

The next time you launch IS Scan, select Open Settings File from the 
Settings menu.

Windows

Windows
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Other Scanner Problems

�  Improper Colors Displayed in the Dialog Box
Check IS THE NUMBER OF DISPLAY COLORS SET TO HIGH COLOR OR TRUE 

COLOR?

This problem occurs when IS Scan is launched from a TWAIN-compatible 
application program.

If the problem is not solved, change the number of display colors of your 
computer.

From the Start menu, select Settings, and then select Control Panel.

Double-click the Display icon, then click the Settings tab.

Check that the Colors setting is High Color or True Color in the Colors box.

Or, you may be able to solve the problem by minimizing the IS Scan 
window and then return to the original size.

Check the Color Depth setting.

From the Apple menu, select Control Panels.

Select Monitors & Sound.

Check that Thousands or Millions are set for Color Depth.

Windows
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Other Scanner Problems

�  Scanning Too Slow
Scanning is requiring an unusually long time.

Check ARE YOU USING A HIGHER RESOLUTION THAN REQUIRED?

In order to scan an image, your computer must be able to receive a large 
amount of data. Therefore, the scanning speed varies according to the 
performance of the computer.

To shorten the time required for scanning:

• Use the appropriate resolution setting. Make sure that the resolution is 
not set higher than you require.

• Use the prescanning capability.



481Scanner Problems

Other Scanner Problems

�  Communication Error Occurs

Check 1 DID YOU LAUNCH IS SCAN OR IS SCAN PLUS IMMEDIATELY AFTER IT 
WAS CLOSED?

Do not attempt to launch IS Scan or IS Scan Plus again immediately after it 
is closed. Wait for a few seconds and then launch again.

Check 2 IS THE PRINTER PLUGGED IN AND READY?

Check that the printer is plugged in and ready.

Check 3 ARE YOU USING THE USB INTERFACE RUNNING UNDER 
WINDOWS 98?

When using the USB interface running under Windows 98, a 
communication error may occur if the Hardware acceleration setting is Full. 
To solve the problem, follow these steps:

Double-click the System icon in the Control Panel for Windows.

When the System Properties window is displayed, click the Performance 
tab.

Click the Graphics button.

If Hardware acceleration is set to Full in the Advanced Graphics Settings 
dialog box, set to None.

Windows
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Other Scanner Problems

�  Error Message Appears

Check REFER TO THE ONLINE HELP.

From the main IS Scan screen, select Contents from the Help menu, or 
press F1.

Open the online Help. 

Windows

Macintosh
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